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Chapter 5
Drafting and Editing Techniques
This chapter concentrates on how to fit elements to each other and to special points of the worksheet, and how to modify placed
elements by moving or transforming them.

The following concepts are covered here: Selection, Grouping, Drawing Order, Numeric Coordinate Input, Mouse
Constraints, Drafting Modifiers, Special Snap Points, Intelligent Cursor Feedback, Moving Elements, Changing
Element Sizes, Solid Operations, 3D Texture Modification, Drag & Drop and Editing Text.

Selection
Many ArchiCAD menus and dialog boxes operate on selected
elements, so you will need to carefully control currently
selected elements. ArchiCAD provides several powerful
methods for selecting elements in your Project.

- Editing commands operate on selected elements, if any.
If nothing is selected, the editing command will not take
effect.

- The contents of the 3D Window are defined by selection;
if there is none, all of the elements appear in it.

- For calculations, explicit selection is prioritized over
filtering criteria, but the actual result depends on whether
the selection corresponds to the type and criteria defined
for the listing command. See Chapter 10: Project Data
Calculation for details.

- Selection made in any worksheet window has no effect
on the selection made in any other window.

Note that selection can only operate on active layers.
Systematic layering can help to exclude unwanted elements
from selections and unintended editing actions. See Layers in
Chapter 3: Project Organization and Navigation.

Selection Methods
There are two selection methods in ArchiCAD: explicit
selection and area-based selection. Explicit selection is always
prioritized over area-based selection.

Explicit selection can be achieved in several ways, the most
common of which is the Arrow tool. Area-based selection, on
the other hand, is always performed with the Marquee tool.
Both these tools are located in the top part of the Toolbox.

Explicit selection displays selection dots on elements. These
represent the points of the element by which you can move
or resize them.

For area selection, you define a polygonal or rectangular
shape with the Marquee tool. Operations will be performed
on this area or the elements inside this area. In this case, no
selection dots appear on the elements.
The results of the editing operations performed on selections
obtained through the two methods are different. See the
sections dedicated to the different operations later.

You can also combine the two methods by first defining a
Marquee area and the explicitly selecting elements inside this
area, for example with the Select All command (see later).
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Explicit Selection
The location of the hotspots resulting from explicit selection
depends on the type and the geometry of the element.

In the case of GDL Object type elements, the number of
selection dots depends on the number of hotspots defined in
the object.

There are several ways for explicitly selecting elements:
- Click an element with the Arrow tool active - this will

deselect all other currently selected elements;
- Shift-click an element with any tool active (if several types

of element overlap, the one drawn with the active tool will
be preferred) - this will add the elements to those already
selected;

- Click an element with the right mouse button (Windows)
or with the Ctrl key down (MacOS) with any tool active -
this will deselect all other currently selected elements and
pop up an appropriate contextual menu;

- Draw a polygonal or rectangular selection area with the
Arrow tool active - this will select all the elements inside
the area and deselect all other currently selected elements,

unless you keep the Shift key pressed, in which case
enclosed elements will be added to the selection or
already selected ones will be subtracted from it;

- Choose the Select All command from the File menu to
select entire classes of elements based created with the
active tool (or all elements if the Arrow tool is active)
either in the entire window or inside a previously defined
Marquee area;

- Choose the Find & Select command to select and deselect
elements based on a wide variety of criteria;

- Use the Selections floating palette to recall previously
memorized, frequently accessed sets of selections that are
stored with the Project.

Single elements have small solid selection dots, while grouped
elements displaying larger circles and elements that belong to
a Hotlinked Module are shown with hollow squares.

The default color of the selection dots can be set in Options/
Preferences/Miscellaneous.

Locked elements’ selection dots appear in grey.



11

Chapter 5: Drafting and Editing Techniques

Graphisoft ArchiCAD User Guide

Elements can behave as locked in three cases:
- The element is placed on a locked Layer;

- The element has been explicitly locked with the Edit/
Lock command;

- In a shared Project (Teamwork), the element is outside
your own workspace.

In all cases, locked elements can be selected, but they cannot
be edited.
If you select a locked element and try to edit it, a yellow box
appears containing the reason you cannot edit it.

You can open the settings dialog boxes of these elements, but
you cannot edit their parameters. The OK button that would
validate  such changes will appear in grey.

Selection Using the Arrow Tool
You can select elements with the Arrow tool  in the Floor
Plan worksheet, the 3D Window, Section/Elevation windows,
Detail Drawings and the 2D Symbol window of GDL Objects.

In certain situations, you can stretch or move elements with the
Arrow tool without using an additional menu command.
Therefore, the Arrow tool is often your best choice when
editing elements. Note that pressing the right arrow key toggles
between the tool you were last using and the Arrow tool. This
shortcut allows you to quickly access the Arrow tool for an
editing action, and then return to the tool you were using.

Selection Criteria
With the Arrow tool active, move the cursor to a corner or
edge of any element and click. Hotspots will appear on the
element indicating that it has been selected.
In the 3D Window, you can also select any element by
clicking anywhere on its visible surfaces, without finding any
of its nodes with the cursor. This method is best used in

Hidden Line or Shading mode. It also works in Wireframe
mode, but in this case you have no visual clue as to which
surface is visible.

Note: If all of the selection dots of an element would be
outside the current 3D view, the element cannot be
selected. This means that in a zoomed view with a Wall or
a Slab leaving no empty background in the image, you can
draw selection rectangles or deselect elements by clicking
the surface of this element, without the risk of accidentally
moving it.

You can add elements to the selection by shift-clicking them.
Shift-clicking a selected element will remove it from the
selection.

When several elements overlap, successive clicking with the
Checkmark cursor will cycle through the selection markers
of the available elements. The Info Box gives you visual
feedback about the last selected element.
You can also click and drag to draw a selection polygon or
rectangle around those items you want to select (see Selection
Area Options below).

The Info Box offers two options.

- With the first method, any element that has at least one of
its nodes, edges or curves in the selection polygon or
rectangle will become selected.
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- With the second method, only elements that are entirely
inside the selection polygon or rectangle will become
selected.

In the 3D Window, press the mouse button anywhere but on
a node or edge, and move the mouse while keeping it
pressed. You will draw a selection rectangle just like on the
Floor Plan. All elements that have a node within this rectangle
will be selected.

Note: In previous versions of ArchiCAD, polygon edges
and curves were not available for this type of multiple
selection, a node had to be included in the area. This
affected polygon type elements and circular elements. For
the latter, you had to include the centerpoint of the curve
to select it. If you wish to revert to this selection method,
you can do so in Options/Preferences/Miscellaneous
by checking the Use ArchiCAD 7.0 Arrow Selection
Area Options box.

Selection Area Shape Options
Also in the Info Box, you can choose among three selection
area shapes for the Arrow tool.

The options are: polygonal, rectangular and rotated
rectangular. Note that the polygon that you define on the
screen can only include straight segments, so the pet palette
does not appear. Double-clicking while drawing the polygon
automatically closes it if it already has at least two segments
defined manually.

Deselecting Elements
To deselect one or more elements that are part of the current
selection, click or draw a selection rectangle around the
elements you want to deselect with the Arrow tool while
pressing the Shift key.
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Click with any tool (including the Arrow) on an empty part of
the worksheet to deselect all the selected elements at once.

Selection using the Marquee Tool
The Marquee tool  is used to define areas for editing and
visualization purposes. The capabilities of the Marquee tool
complement those of the Arrow tool, and are particularly
useful in selecting and moving groups of ArchiCAD elements.

Marquee selection is useful if:
- You wish to define a smaller area in which to select all of

the elements of a given type;
- You want to visualize a particular part of the design in 3D;

- You need to move or resize a number of elements of
different types at the same time.

The Marquee tool is available in the Floor Plan worksheet,
the 3D Window, Section/Elevation windows, Drawing Details
and the 2D Symbol window of GDL Objects. It is also the only
available Tool in some Windows from which you can only
copy elements, for instance Model Pictures Windows or the
GDL Object's 3D view.

To use the Marquee tool for selection and editing, you must
first define a rectangular or polygonal selection area. All
construction aids are available, including numeric input and
drafting modifiers.

If you inadvertently start to draw the selection area at an
unintended point, either finish and start again, or click the
Cancel button and start anew.

- If you click a node or an edge inside the selection area, the
cursor will assume the Checkmark or Mercedes shape. If
you then move the cursor, the selection area will be
moved with all the nodes or edges included in it. See
details in the Changing Element Sizes and Moving
Elements sections later.

- If you click inside the selection area without touching a
node or an edge, the cursor will assume the Trident 
shape. In this case, moving the cursor will only move the
selection area, leaving all enclosed elements unchanged.

To cancel a drawn Marquee area, click with the right mouse
button (Windows) or with the Ctrl key pressed (MacOS), and
choose the Remove Marquee command in the appearing
context menu.
Marquee selection does not display selection dots on the
included elements; the whole selected area is marked by a
dashed line.

Marquee Area Definition Options
The Marquee tool has two definition methods available in the
Info Box.

- With the thin dashed line contour representing the Single
Floor method, you can select elements on the current
Story.

- With the thick dashed line contour representing the All
Floors method, you can select elements on all the Stories
of the Project.
Note: These controls are dimmed when not viewing the
Floor Plan worksheet.

You can also choose one of three shape options (or Geometry
Methods) when viewing the Floor Plan, a Section/Elevation
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Window, a Detail Drawing or a GDL Object 2D Symbol
window, while in 3D Window, four options are available.

 

- The Polygonal method defines a selection area consisting
of any number of segments. Completing a segment
automatically begins the next one. You can close the
Marquee by double-clicking the last endpoint, by clicking
OK in the Control Box or by drawing the last endpoint
on top of the first one and clicking once when the
Hammer cursor appears. At least two endpoints have to
be defined manually, since the area must have a minimum
of three sides. Only straight segments are possible. When
the selection area is completed, it will appear as a dashed
contour.

- The Rectangle method defines a selection rectangle that is
orthogonally aligned with the grid. After the first click, a
rubberband line rectangle will follow the cursor, allowing
you to see the selection area. After the second click at the
diagonally opposed corner, the selection rectangle will
appear.

- The Rotated Rectangle method define a selection
rectangle at any angle. You first draw one side of the
rectangle with two clicks, and then, with a third click, you
define the length of the perpendicular sides.

- The first three methods available in the 3D Window are
extensions of the Polygonal, Rectangle and Rotated
Rectangle methods. First the basis of the marquee area is
defined with the same steps as on the Floor Plan, and then
you define the height of the selected space. The
coordinate axes are continuously present on screen to
help you.
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- The fourth option allows you to draw a 2D marquee in
order to copy elements from the 3D Window in the form
of pictures.

Selection Criteria
Selection by a Marquee area has different criteria depending
on what you intend to do with selected elements and which
window you are working in.
In the Floor Plan Window:

- If you wish to Cut, Copy, Clear, Drag, Mirror, Rotate or
Duplicate elements, they must have at least one node
inside the Marquee area in order to be selected. The edit
operations will act on the whole element.

- If you wish to Stretch/Shrink elements, the Marquee area
should include only those nodes of the linear, polygonal
and circular elements that you wish to move, otherwise
the whole element will be displaced. See details and
example later.

- If you opt to view elements in 3D, any part of an element
that falls inside the Marquee area will be included (or
excluded) in the 3D view, even if there is no selection
node or hotspot on this part of the element. See Show
Elements in 3D in the 3D Image Setup section, Chapter 3.

- For individual selection restricted to a specific area by
using the Select All... or Find & Select... commands,
elements that have at least one node inside the marquee
area will be selected.

In Section/Elevation Windows:
- If you wish to Cut or Copy elements, they must have at

least one node inside the Marquee area in order to be
selected. The edit operations will act on the whole
element, but in case of construction elements, only a copy
exploded into 2D drawing elements will be actually
copied.

- If you wish to move or Stretch/Shrink elements, the
marquee can be used the same way as on the Floor Plan,
but will only affect 2D drafting elements. You can only
Drag and Elevate elements that have at least one node
inside the Marquee area.

- For individual selection, the marquee can be used the
same way as on the Floor Plan.

In the 3D Window:

- For individual selection, the extended 3D marquee can be
used the same way as in the Floor Plan. This is the only
function of the 3D marquee.

- If you take a snapshot from the 3D drawing, you will get a
picture cropped by the 2D marquee.

Note: To fine-tune the position of the Marquee in 3D,
move it by its nodes with the Arrow tool. (On the Floor
Plan, moving a Marquee requires using the Marquee
tool.)

Deselection

Deselection occurs when you either begin a new selection
rectangle or double-click on the worksheet outside the
marquee area with the Marquee tool selected. You can also
right-click (Windows) or Ctrl-click (MacOS) anywhere to pop
up a context menu and choose the first command which is
then Remove Marquee.
If you choose another tool, the marquee area will be
preserved in order to save the recent selection area for further
use. When you remove the box, all the elements touched by it
will be deselected.
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Special Marquee Techniques
You can use the Marquee tool to copy an area of the 3D
Window, a Section/Elevation Window or a Model Picture
Window. This allows you, for instance, to insert elevations
onto the same page as the Floor Plan for fast feedback.
1) Generate the view you need.

2) Use the Marquee tool to select the area you wish to move
(make sure that the 2D Marquee option is active).

3) Choose Edit/Copy.

4) Move to the Floor Plan and choose Edit/Paste.
5) Position the image on your Floor Plan using the Trident

cursor.
6) Click outside the selection rectangle to complete the

operation.
- Elevations are pasted to the Floor Plan as full-size 2D

elements.

- Parts of Model Pictures are pasted as screenshots (Figures).
- Parts of the 3D Window are pasted to the Floor Plan either

as 2D elements (full size or scaled), or as unified pictures
(Figures), according to the choice you made when
copying them.

You can also use the Marquee tool to view only specific parts
of the 3D model by drawing a marquee area around the
details you wish to either include or exclude from the 3D
image. This technique can be applied to either the current
story or to all stories, depending on the construction method
chosen.
In the case of trimmed 3D views, resulting from either a
Marquee area or a 3D Cutaway, some elements will be only
partially visible. If selected, selection dots of the whole
element will be displayed and all the nodes and edges can be
found with the cursor.

If edited, a temporary ghosted image of the whole element
will be visible.

Note: New elements placed or existing elements moved
out of the boundaries of a Marquee-based model view will
disappear from the 3D Window. Use the Undo command
to restore existing elements, or switch to the Floor Plan to
move them into the proper place.
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Selection Commands and Palette
A couple of Edit menu commands and the Selections palette
available from the Window menu's Floating Palettes
hierarchical menu help you make selections based on certain
criteria, manage selections and collectively edit the settings of
selected elements of dissimilar type.

Selecting All Elements
Choosing the Select All … command in the Edit menu will
select all eligible elements in the currently active worksheet
window. Eligibility depends on the tool chosen in the
Toolbox and whether there is a marquee area defined.

- When a selection tool (Arrow, Marquee) is active and
there is no marquee area defined, every element will be
selected.

- When any of the other tools is active and there is no
marquee area defined, the name of the Select All
command changes to include the name of the given tool,
and every element created with that tool will be selected.

- When a marquee area is defined, the "in Marquee" words
are added to the Select All command or to the Select All
(Element type) command. Every element inside the
marquee area will be selected, or every element created by
the active tool inside the marquee area will be selected.

Selection Based on Multiple Criteria
Choosing the Find and Select command in the Edit menu
opens an expandable floating palette in which you can
choose among a large number of criteria for selecting
elements placed on the visible layers of the currently active
window. The number of available criteria depends on the
selected element type.

The Find and Select palette can remain open as long as you
wish on top of all windows. It can be accessed from any of
the worksheet windows. To close the palette, click its close
box in the top right corner.

Start by selecting the type of element to look for with the pop-
up controls at the top. You can select elements belonging to a
specific type, to all types, to all 3D or all 2D types.

To add a search criterion, click the More Choices button. A
new search field appears, with a pop-up menu listing both the
generic criteria available for all element types and the settings
specific to the selected type. In the illustration below, the two
types of criteria for the Wall tool are shown.
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For some criteria, additional options are available. For
example, as seen below, you can choose to select elements
whose elevation is smaller, larger or equal to a certain value.

To refine your search, add as many criteria as are available for
the given element type by repeatedly clicking More Choices;
the dialog box will expand accordingly. You can also change a
criterion at any time or remove any criterion in the list.
Clicking the Fewer Choices button will remove the bottom
criterion.

When you have made your criterion choices, clicking the + sign
at the bottom of the palette will select the corresponding
elements. You can then define another set of criteria without
leaving the palette and either click the + button again to add the
elements that correspond to the new criteria to those already
selected, or click the - button to subtract from the current
selection those elements that correspond to the new criteria.

You can use the two buttons above the + sign to pick up the
settings of existing elements. This will help you search for
similar elements.

- If you switch on the first button and then Alt-click
elements any time later, their settings will be loaded in the
Find and Select dialog box. Switch the button off if you
do not currently need this feature.

- If any elements are selected, the second button becomes
active. Click the button to load the settings of the last
selected element in the Find and Select dialog box.

The small arrow in the top right corner allows you to save
frequently used search criteria and retrieve them.

  

Saving and Recalling Selections
If you need to make the same selection frequently, you can
store it for later use by using the Selections palette.
Selections are saved with the Project, and cannot be used for
another Project.
The Selections palette can be accessed from the Window
menu's Floating Palettes hierarchical menu.
You can save any selection made on the Floor Plan, in the 3D
Window, in a Section/Elevation window or a Detail drawing,
delete a selection or sort saved selections by name or by
window of origin in the pop-up menu on the top right of the
dialog box.
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Next to the name of the Selection, you can see a small icon on
the right indicating the original Window of the Selection. At the
bottom of the dialog box, the number of elements that make up
the selection is shown with their type and availability.

- To activate a stored Selection and add its elements to those
currently selected in the worksheet window, choose its
name and click the + button or double-click its name.
Note: If you want to work on the elements of the stored
Selection only, be sure to deselect everything before, for
example by clicking in empty space with the Arrow tool
active.

- To remove the elements of the stored Selection from those
currently selected in the worksheet window, choose its
name and click the – button.

- To keep only those elements selected that are part of both
the current worksheet selection and a stored Selection,
choose its name and click the x button.

The operation is always performed on the currently active
window, if applicable.

Editing the Selection Set
The Edit Selection Set command from the Edit menu opens
a dialog box which makes it possible to edit specific attributes
for a collection of dissimilar element types simultaneously
without affecting any other settings of these elements. The
Edit Selection Set command is not available in 3D.

Every element in ArchiCAD shares two basic attributes with all
others: a Layer assignment and one or several Pen Colors. If
you explicitly change either or both of these attributes in this
dialog box, all the selected elements will take on the new
values. Layer assignments will always be modified, but Pen
Colors behave differently in one special case (see below).

- There is an additional checkbox for Windows and Doors.
Even if they are not explicitly selected, you can optionally
modify their Pen Color if the parent Wall is included in the
selection set.

- Another checkbox can be used to modify the Pen Color
and Layer setting of Labels that are not explicitly selected if
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the elements they are linked to are included in the
selection set.

- The Pen Colors of Object type elements can only be
changed if the element is not set to be displayed with its
own Symbol Pens (defined in the 2D symbol of the GDL
Object). Even then, when editing the object, the standard
Pen Color radio button will be preset to the edited Pen
Color.

- All components of compound elements, such as Walls,
Dimension chains or markers made up of lines,
arrowheads and text are modified together.

The bottom of the dialog box shows the type of selected
elements and whether they are currently editable (that is, not
locked).

Grouping Elements
Groups can be created by selecting elements of similar or
dissimilar type and choosing the Tools/Group command.
Grouped elements can then be selected and modified
together. Groups can also be grouped into higher level
groups.
The following operations can be performed simultaneously
on all the elements constituting the group:

- selection;

- some of the Edit menu functions (e.g., Drag, Rotate,
Mirror, Multiply);

- attribute (e.g., Layer) assignment.
You can even create elements in groups by activating the
Autogroup command in the Tools menu. If this option is on,
chained polygonal and rectangular elements will
automatically be created as a group.

The following element types cannot be grouped: any of the
Dimension types, Zones, Labels, Section/Elevation lines,
Cameras. Doors and Windows can only be grouped as part of
the Wall they are placed into.

Elements belonging to other Stories and whose outline appears
on the current Story cannot be part of a group on this Story.

Grouped elements are distinguished from ungrouped ones by
their larger, empty selection dots. Elements belonging to
different groups, if selected simultaneously, will display
selection dots of different colors.

Grouping and ungrouping are not available in the 3D
Window, you can only Suspend Groups.

Disabling Groups
To make all elements constituting a group independent again,
choose Tools/Ungroup.

You may, however, need to perform only a single operation
on a particular element or element type of the group. In this
case, suppressing the group assignment altogether is rather
burdensome, since you will have to select all the elements
one by one again to recreate the group.
The solution is to temporarily suspend groups by enabling the
Suspend Groups switch in the Control Box. If this toggle
command is ON, elements that have been assigned to a group
can be selected and modified separately. If it is OFF, groups
are activated once again. You can also access this function by
choosing Tools/Suspend Groups.
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- If the Suspend Groups switch is OFF and you choose to
ungroup a selection consisting of two or more lower level
groups, it will first be divided into the groups it comprises.
You may need to repeat the Tools/Ungroup command
several times before an element can be selected and edited
individually.

- If the Suspend Groups switch is ON, choosing Tools/
Ungroup will detach any selected elements from their
groups and break down all groups into single independent
elements, no matter how complex the nested grouping is.

When choosing Tools/Suspend Groups, ALL groups are
temporarily rendered inactive, which means that single
elements can at once be selected and edited individually,
even if they are part of a complex group hierarchy.

Groups and Layers
Grouping elements does not change their attribute assignment,
which means that each element remains on its own Layer.

If some elements of a Group are in an invisible Layer:
- Elements on the hidden Layer will be invisible.

- When editing the group (by drag, rotate, mirror, multiply)
invisible elements will also change their position.

- When modifying the Attributes or parameters of the
elements, the Attributes of the invisible elements will not
be changed.

If some elements of a Group are in a locked Layer:
- Elements on the locked Layer will be visible on the Floor

Plan, but they will cause the entire group to be locked.
The group will not be affected by drag, rotate, mirror and
multiply.

- When selecting the group, all of its elements will be selected,
but with grey dots. Use the Suspend Groups command to
edit those grouped items that are not in a locked layer.

Note for TeamWork users: Elements of a group may be
reserved by different signed in team members, but groups

still remain active. Attributes and parameters of reserved
elements can only be modified by first suspending the
groups.

Drawing Order of Elements
When drawing a Project with ArchiCAD, overlapping elements
will be drawn according to a specified stacking order. By
default, elements are stacked in an order typically used in
architectural drawings.

Default Stacking Order
By default, stacking order is determined by element classes,
of which there are six. Regardless of the sequence in which
elements are placed, those in the first class will be placed in
the foreground, second class in the level behind it, and so on.

The element classes are in descending order of class:
1) Annotation (Text, Labels, all Dimension types, Zone Stamps)
2) 2D artwork (Lines, Circles, Splines, Hotspots)

3) Library Parts (Objects, Lamps, Stairs)
4) 3D structures (Walls, Beams, Slabs, Doors, Windows,

Columns, Roofs, Meshes)

5) 2D polygons (Fills, Zone Polygons)
6) Figures
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Overlapping within the same class depends on the order in
which you place the elements. For instance, if you have walls
that cross each other, the last one placed will always overlap the
others. If you change an attribute of a previously placed wall, it
will become “more recent” and will overlap all the others.

Custom Stacking Order
ArchiCAD’s default stacking order is appropriate in most
cases, but you may wish to place elements in a different
overlapping position. For instance, for a Fill to overlap a 2D
element or an Object, a set of commands in the Tools menu's
Display Order hierarchical menu lets you override the
default stacking order element by element.

On newly placed elements, the commands work as follows:
- Bring Forward: On this command, selected element(s)

will overlap all the unchanged elements of their own and
any lower classes, but will still stay below the elements of
higher classes.

- Bring to Front: On this command, selected element(s)
will overlap all other elements.

- Send Backward: On this command, selected element(s)
will be overlapped by (sent behind) all the unchanged
elements of their own and higher classes, but will overlap
the elements of lower classes.

- Send to Back: On this command, selected element(s) will
become overlapped by all other elements.

- Reset Default Order: This command restores the default
overlapping order described previously.

Mechanism of the Stacking Order

Both the default stacking order and the customization
commands are based on two ordering mechanisms: classes
and stack levels.

ArchiCAD places elements in 14 stack levels. Each level can
contain any of the element types. The final stacking order you
see on screen and on printouts is based on stack level and

element class. All elements on a level will overlap elements
on lower stack levels, regardless of class.

New elements are always placed into the preferred stack level
of their own class. Stack level preference is as follows:

1-4) Void by default
5) Annotation

6) 2D Artwork
7) Library Parts

8) 3D Structures
9) 2D Polygons

10) Figures
11-14) Void by default

By default, the upper and lower 4 stack levels are empty. You
can bring or send elements of any type into these stack levels
with the Tools menu commands detailed previously.

For example, bringing a Fill forward from level 9 to level 8,
which is the default level of structures, means that the Fill will
overlap all the unchanged fills remaining on level 9, but will
still be overlapped by all the unchanged structures on level 8.

If you bring it forward again, it will overlap all the remaining
structures. However, it will still stay below all of the
unchanged Library Parts on level 7. This way, you can move it
forward until it overlaps the higher levels.
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Of course you can bring other elements forward as well,
which will again overlap the changed Fill.

The Bring to Front and Send to Back commands move the
selected elements until they overlap (or are overlapped by) all
of the existing elements. This is not necessarily the 1st or the
14th level, which means that in most cases it will still be
possible to place other elements above or below them.
Text or Dimensions brought up to the top stack level cannot
be overlapped. For example, if you want a Fill to overlap
them, you will have to send the Text one level backwards.
If you attempt to move elements forward that are already
placed on the top level, or to move elements backward from
the bottom of the stack, you will be alerted.

When moving several elements placed at different stack levels
forward or backward, each element will only move one level.
When bringing to front or sending to back elements of
different types, they will overlap (or be overlapped by) all
existing elements, and will retain their stacking order in
relation to each other.

Zones and Fills are compound elements consisting of
components of two different classes (Zone Polygons and Zone
Stamps, Fills and their area texts). These two components
always keep their order according to their classes, for instance
area texts always overlap their fills. Although you can change
their overlapping order separately, Fills and Zone Fills can never
overlap their own area texts and zone stamps and vice versa,
forcing the other component to move with them if necessary.

Note: The stacking order of Fills and Zones can be set in a
pop-up menu in the Display Options dialog box, but this
setting is effective only on elements within the same stack

level. For example, if Fills are set to overlap Zones but a
particular zone is in a higher level than a particular fill, it
will overlap that fill.

Display Order and Outputs
The stacking order will be preserved on printer or raster
plotter output, as well as on PlotMaker drawings.

In DXF/DWG output, all elements will be transparent,
meaning that hidden or partially overlapped elements will be
entirely visible. To see a preview of this, set Construction
Fills and Polygon Fills in the Display Options dialog box
to Vectorial, and set all Fills to Transparent in Preferences/
Miscellaneous.

Drawing Constraints and Snap
Points
ArchiCAD provides a number of aids for the placement of
new elements and the modification of the geometry and
location of existing ones.
The most important of these are:

- Using the Construction or Snap Grid;
- Constraining the movements of the cursor (mouse) to a

given direction;
- Snapping with the cursor to the points of existing elements.

These features are independent of one another, so occasional
conflicts between them may occur. The order of priority is the
following:

1) Explicit coordinate input (including locking a coordinate's
value);

2) Grid snap;
3) Mouse constraints;

4) Cursor snap.
The setup of the coordinate system and the grids are covered
in Chapter 3: Project Organization and Navigation.
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Entering Numeric Coordinates
You can enter numeric coordinates directly from the keyboard,
or use a combination of the mouse and the keyboard. This
technique may be useful when you are entering a list of
coordinate pairs, or when you need more precision than the
mouse permits.
To enter numeric coordinates, type the name of the coordinate
(x, y, a, z or r) immediately followed by the value you intend to
assign to it, for example x3 or y-4. The + prefix is optional for
positive values. You can type coordinate values in any order.

The selected value is highlighted. At this point, you have
several options:

- To enter other coordinate values, type the name of
another coordinate, then enter a value.

- To complete the element you are drawing, press Enter or
Return.

- To cancel the entire operation, click the Cancel button in
the Control Box.

- Return to graphic input by typing the name of the edited
coordinate again and moving the cursor away, or by
mouse-clicking anywhere in the worksheet.

You can also preview numerically entered coordinates prior
to completing an element by typing a coordinate name again.
If you type the same coordinate name, be careful not to move
the mouse, or you will return to graphic input.
You can also perform additions or subtractions from the
current value by typing a + or – sign after the value. For
example, typing x3+ will add 3 to the x value shown in the
Coordinate Box. Two dashes are required for subtraction of
whole feet because the first dash is interpreted as an
indication that inches are to follow.

Notes: Coordinates can be copied and pasted using the
clipboard. The Cut, Copy and Paste menu items are
inactive during numeric input, so you must use the
standard shortcuts.

If you work in inches and feet, notice that when 3 is
entered, ArchiCAD assumes you mean three feet. Typing
3’6, 3’6", or 3-6 will enter three feet, six inches.

To illustrate the difference between absolute and relative values,
let us start a line at x2, y2 (the grid is one foot by one foot).

Now type x+3, y-3 (absolute values) for the second point of
the line.

Note what happens when you type the same values as relative
values (x3+, y3-) from the original starting point.
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The Coordinate Box also displays the Elevation (z
coordinate) value of elements. This topic is covered in the
Elevation section later in this chapter.

Coordinate Constraints
You can constrain the movement of the cursor by pressing
Option (Macintosh) or Alt (Windows) and either x, y, a, or r
on the keyboard. The appropriate coordinate in one of the
coordinate fields will become framed, indicating its
constrained status.
Having defined a direction with the cursor constraint, you can
even find outside reference points with the cursor.

By constraining x you get a vertical ruler. By constraining y
you will get a horizontal one.

Locking a (having defined it numerically or drawing in a
sample direction) will provide a slanted ruler. With r locked,
you draw radial lines of a length determined numerically or
graphically.

You can release the coordinate constraint by clicking in the
small frame around the locked coordinate field.
Angle of cursor’s movement constrained:

Radial distance of cursor from Edit Origin constrained:

Horizontal location of cursor constrained:

If you need to construct angled elements that are horizontally
or vertically aligned with an existing element, you can
combine coordinate constraints and numeric input as follows:

1) Start drawing the element.
2) Place the cursor over the desired point of an element for

alignment.

3) Lock the x or y coordinate.

4) Type a and enter the desired angle.

5) Type a again to preview the change.

6) Press Enter or Return to confirm the action.

Mouse Constraints
ArchiCAD's Mouse Constraints are like having a computerized
T-square and triangle available while drafting in the Floor
Plan. The angle pairs they define can be used to lock the
cursor at a particular drawing angle.
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The mechanism can only be engaged while drawing or
editing an element, as indicated by the thick rubberband line
shown in the Floor Plan or the ghosted element contour
shown in the 3D Window. It temporarily locks the cursor’s
polar angle value in the Coordinate Box using one of the
four angle pairs defined in the Options/Preferences/Mouse
Constraints & Methods dialog box.

The four angle pairs are:

- The Horizontal-vertical angle pair used for normal X-Y
orientations.

- The Horizontal-vertical to Skewed Grid angle pair used
for X-Y orientations relative to an oblique grid.

- The Fixed Angle pair typically used for Projects that
consistently use a specific angle in their layout. An
example would be a structure that is oriented at a fixed
angle relative to an adjacent roadway. To define this angle,
enter its numeric value in the editable field. The value will
be measured relative to the normal grid, unless you check
the Relative to Skewed Grid box.

- The Custom angle pair works like the Fixed angle pair,
except that it can be redefined without interrupting a
drawing procedure by clicking the Parallel or Perpendicular
relative construction icon and a reference edge or by
drawing a reference vector. The Custom angle is always
defined in relation with the “normal” horizontal axis.

All four angle pairs are defined by a primary angle, a
secondary angle and both of their reverse angles.

- The primary angle of each pair is entered into the Mouse
Constraints dialog field.

- The secondary angle automatically lies in the transverse
position (rotated exactly 90°) from it.

When editing the endpoints of linear elements or the nodes of
polygonal ones, the angles of the edited edges can also be
used for constraint.

Using Mouse Constraints
Constraining the drawing angle helps you precisely align or
connect new elements by maintaining a consistent drawing
angle. To use the Angle Pair mechanism for drawing a new
element:
1) Make sure that Grid Snap is disabled.

2) Click to start drawing a linear element or the first segment
of a polygon in the generally intended direction. The
rubberband line (or ghost contour) appears. If you have
enabled relative coordinate display by clicking the delta
icon next to the x and y fields of the Coordinate Box, you
will also see that the Edit Origin (0, 0) has been relocated
to this starting point.
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3) Move the cursor away from this starting point and press
the Shift key to constrain the direction in which you can
define the endpoint of the linear element or the next node
of the polygon. ArchiCAD will then search for the closest
constraint angle using the Edit Origin as its center,
depending on which angle pairs are enabled.

4) You can then move the cursor around to choose whether
to use the primary angle, the secondary angle or their
reverse angle. You will see that the polar angle value field
(a) is locked in the Coordinate Box and a box is displayed
around the a icon as a visual feedback. Only the values of
the primary, secondary and reverse angles of the enabled
angle pairs can appear here.

   

5) When you have chosen one of the possible directions,
start drawing the element. Since the angle remains locked,
you can move the cursor anywhere on the screen and
snap to any element without losing the orientation of the
line you draw. The cursor, even if remote from the drawn
line, projects its position onto the line.

   

Note: You can change the projection mode of the cursor
while you are drawing from the default perpendicular
mode to vertical or horizontal snap with the Remote Snap
Variants in the Control Box (see also next section).

The vector showing the direction of the element remains
unchanged.

   

6) When you are satisfied with the position of the endpoint
or node, click to place it.

Remote Snap Variants
Remote Snap Variants are available as a set of icons in the
Control Box. They control the way the current position of the
cursor is projected on the rubberband line constrained to a
predefined direction.
Remote Snap is available when you start drawing a vector and
hold down the Shift key. The vector is locked at a predefined
angle; by default the cursor is projected perpendicularly to
the constrained angle.
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At any time during input, you can switch to vertical or
horizontal cursor snap. This will cause the cursor to be
projected vertically or horizontally, while the vector is still
locked at the same angle.
On completing the vector, Remote Snap automatically
switches back to the default perpendicular direction.

Note: Pressing the Q key toggles between variants during
input.

Relative Construction Constraints
In addition to the angle pairs defined in Options/
Preferences/Mouse Constraints, you can also use special
constraints allowing you to draw elements at a specific angle
or distance from existing ones.
The relative construction methods constrain the cursor’s
movement to a constant angle. They can be accessed from the
first button of the Control Box. By default, the Perpendicular
icon is visible. Click the small arrow at the bottom to flush out
the other relative construction methods.

Perpendicular and Parallel Constraint
The first two methods, Perpendicular and Parallel, function
identically. They help geometric input with any tool, differing
only in the geometric modifications they produce.
1) Make sure that Grid Snap is inactive.

2) Choose the Perpendicular or Parallel icon and click it to
make it active (pressed).

3) Select a line or an element edge as a reference by clicking it,
or draw a temporary reference line using the cursor.

4) Draw the new element.

The new element you draw will be perpendicular or parallel
to the reference line (depending on the method selected).

Note: You can also select the Perpendicular or Parallel
method after you have started drawing an element. In this
case, the drawing operation is frozen until you have either
drawn or selected a reference line or edge.

You can draw repetitive perpendiculars or parallels by
combining the relative construction method with the Mouse
Constraints mechanism. When you define the reference line
for drawing the single perpendicular or parallel element, its
angle is automatically stored in the Options/Preferences/
Mouse Constraints & Methods dialog box as the Custom
angle. You can then draw multiple parallel or perpendicular
lines until the Custom angle is redefined either numerically or
by activating the Perpendicular or Parallel method again.

Note: You can also use the P single-key shortcut to enable
perpendicular or parallel constraint. Pressing P once
enables the last-used constraint type, while pressing it
again switches to the other one.
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Angle Bisector Constraint
Using the Angle Bisector relative construction method, you
can draw elements bisecting the angle closed by any two
other elements or temporary reference vectors.

You can either start drawing the new element before
activating the Angle Bisector method and defining the
reference vectors, or the other way round. Before using Angle
Bisector constraint, make sure that Grid Snap is disabled.

Click the Angle Bisector icon , then define the reference
vectors by either clicking on two existing element edges or
lines, or drawing two temporary lines. The mouse is
constrained to the bisecting angle between the two reference
lines. Before you actually draw the element, the cursor is
already constrained, and you can see small black dot move
along the line that would be drawn at that angle.

 

As for any other constraint, you can use remote cursor snap to
define the other endpoint of the drawn line.

 

Note: You can also use the H single-key shortcut to enable
angle bisector constraint.

Offset and Repetitive Offset
The Offset and Repetitive Offset  methods help you create
polylines with a given offset to a drawn polygon. These
methods have no effect on elements defined by a single click.

Either relative construction method can be activated from the
Control Box.

To draw an offset polygonal element:

1) Choose or activate the Offset  method. (The active
tool must support polygon shapes.)

2) Draw an open or closed polyline. You can even use the
Magic Wand to trace an existing element’s contour to
define the polyline.

3) The base polyline can be completed by a double-click.
When it is completed, a rubberband outline will appear,
starting from the endpoint of the polyline and running
perpendicular to its last entered segment.

4) Click once to place the element.

When using the Repetitive Offset  method, the same
steps can be used, except that the process is not completed
when placing the element with a click. You can continue
placing offset copies until you choose to terminate input.

- With a double-click, you terminate input by drawing a last
offset element.
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- When hitting the Cancel button in the Control Box, you
terminate input by omitting the offset element you are just
drawing.

Note: You can also use the O single-key shortcut to enable
the drawing of offsets. Pressing O once enables the last-
used type, while pressing it again switches to the other
one.

Special Snap Points
The Special Snap Point method helps you find special snap
points on an edge in order to place the intelligent cursor
exactly on a geometrically defined point. Activating the
method will place temporary nodes at the division points
based on the current Special Snap Point settings.

 

The temporary nodes behave as hotspots, meaning that the
cursor will change to a Checkmark when held above them.
Special points only appear temporarily and will disappear
after 4 or 5 seconds. You can start drawing new elements from
these points or use them for editing other elements in relation
to them.
Special Snap Point Settings are located in the middle part of
the Control Box.

There are four options available in the pop-up menu:
- Half: Divides an edge into two equal parts.

- Division: Divides an edge into the set number of
segments (Range: 3-20).

- Percentage: Divides an edge according to the set
percentage. (0% is always the closest element endpoint or
intersection point to the location of the pointer.)

- Distance: Divides an edge into two parts according to the
set distance. The distance is always measured from the
nearest element endpoint or intersection point to the
location of the pointer.

With the three icons next to the name of the chosen option,
you can choose whether to use the whole edge (Wall, Beam,
Line, Arc, Spline or polygon edge) or only a part of it between
two intersection points.

- When the first icon is active , Special Snap Points
are disabled.

- Activating the second icon  will generate special
points on the whole element edge.

- If you choose the third icon , special points will
only appear between two intersection points on the part of
the edge where you place your cursor.



31

Chapter 5: Drafting and Editing Techniques

Graphisoft ArchiCAD User Guide

Note: Special Snap Points are available for straight line
segments, circular arcs, ellipses and splines.

In addition, you can display Special Snap Points on a
temporary vector used while drawing elements. The type of
point chosen in the Special Point Settings area of the Control
Box will be in effect.
The method can be activated from the relative construction
icons in the Control Box.

Note: You can also use the D single-key shortcut to enable
special point constraint.

In the following example, you will draw a Wall that starts at
one fourth of the gap between two endpoints of two other
Walls.
1) Start by choosing the Percent option in Special Point

Settings and type 25 in the field below.

2) Make sure that Grid Snap is inactive, activate the Wall tool,
then choose and activate the Special Point Snap method in
the Control Box.

3) Start drawing the reference vector from the endpoint of
one of the Walls.

4) A dashed line is drawn indicating the reference vector,
with a small black dot showing the location of the special
snap point. As you move closer to the endpoint of the
other Wall, the small black dot moves along the vector.
Click the endpoint of the other Wall to terminate the
definition of the reference vector.

5) The Edit Origin is relocated to the place of the generated
special snap point. You can start drawing the new Wall.

Aligning Elements to a Surface in 3D
The Align to Surface  relative construction method is
only active when working in the 3D Window. It enables you
to fit elements onto non-horizontal planes when working in
3D views.

This method automatically identifies the intersection of a
selected plane and the working plane of the cursor. The
working plane is often horizontal. However, in special cases,
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for example when moving a hole in a roof plane, the cursor’s
working plane is angled. It is also possible to align to curved
surfaces, for example when fitting an object to a curved wall.
The limitation here is that if the cursor is moving in an angled
plane, it is not possible to fit to a curved surface, only the
tangential plane of the surface.
Using the constraint when creating new elements:

1) To use the modifier, first activate the 3D Window.
2) Adjust your User Origin if necessary.

3) Choose and activate the Align to Surface method in the
Control Box.

4) Click on any surface in the 3D view you want to align your
new element to.

5) A black dot will appear on the selected plane at the height
of the current User Origin. The dot will follow the cursor
constrained to the intersection line of your reference plane
and the User Origin plane.

6) Click where you want to start drawing your new element.
The element will be constrained to the intersection line.
Finish drawing the element in the usual way.

Note: Pressing the Alt-A key combination deactivates the
constraint.

Using the constraint when editing existing elements:

1) Activate the 3D Window.
2) Adjust the User Origin if necessary.

3) Select the element you wish to edit.
4) Choose the Edit command you wish to execute, e.g.,

stretch an edge of a slab to the intersection of a roof and
the User Origin.

5) Click a reference point or edge to start editing.

6) Select the Align to Surface modifier icon in the Control
box and activate the constraint as described above.

7) Choose your reference plane.
8) Finish editing the element.
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The Intelligent Cursor
ArchiCAD's intelligent cursor provides continuous feedback
on the situation of the new element and its relation to other
elements that are already present in the design.
For the sake of creating proper intersections or defining
closed spaces, you need to take care that elements correctly
connect at each other's eligible hotspots or edges.

The following sections describe:
- The range of cursor snap, that is, the on-screen range

inside which the cursor detects the nodes and edges of
elements;

- The various shapes of the intelligent cursor in different
locations and situations in the project.

Cursor Snap Range
To help locate existing construction elements on the screen,
the cursor gravitates toward edges and nodes. The attraction
of the cursor by elements is defined in pixels in the bottom
section of the Options/Preferences/Mouse Constraints &
Methods dialog box.

Cursor Snap Range can be set between 1 and 9 pixels. 3-4 pixels
is a comfortable setting, but at small zoom levels you may hit
elements that you did not wish to snap to. If you have good
pointing skills, use 1 pixel and you will not be forced to zoom in.
Cursor Snap Range will also help you to automatically snap to
special points including the section points of existing lines or

edges, perpendicular projections from the Edit Origin to
existing lines or edges, and tangential points of the
rubberband line along existing arcs, splines and curved edges.
The cursor’s shape informs you about the type of special
point ArchiCAD has found.

Cursor Shapes
The ArchiCAD cursor takes on the following shapes when
drafting or editing elements:

- Crosshair - in an empty area on the Worksheet;

- Heavy Checkmark  - at a wall node on its reference
line or a beam node at its reference axis;

       

- Light Checkmark  - at any other hotspot of any
element;

- Heavy Mercedes  - on the reference line of a wall or
the reference axis of a beam;

      

- Light Mercedes  - at any other edge of any element;
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- Intersection  - at an intersection of edges.

      

When you click to start drawing an element whose definition
requires more than a single spot, the cursor's shape changes
to a black pencil. It then changes its shape again depending
on whether it encounters other elements.

The possibilities are as follows:

- White pencil  - in an empty space on the Worksheet;
- Striped pencil with black top  - at a wall's reference

line or a beam's reference axis;

      

- Striped pencil  - at any other edge;
- Filled pencil  - at a node on a wall's reference line or

on a beam's reference axis;

      

- Filled pencil with white top  - at any other node or
hotspot;

- Pencil point with intersection  - at an intersection of
edges;

      

- Pencil point with perpendicular sign  - at a
perpendicular edge

- Pencil point with tangent sign  - at a tangential edge.
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When using the Arrow tool, the following shapes are available:
Arrow  - empty area on the Worksheet;

Arrow with Heavy Checkmark  - snapping to nodes on
reference lines of Walls and reference axes of Beams;

Arrow with Light Checkmark  - snapping to Hotspots
and nodes other than the ones on reference lines of Walls and
reference axes of Beams;

Arrow with Heavy Mercedes  - snapping to reference
lines of Walls and reference axes of Beams;

Arrow with Light Mercedes  - snapping to edges other
than reference lines of Walls and reference axes of Beams;

Arrow with Intersection  - snapping to an intersection of
edges;
Arrow with Perpendicular sign  - snapping
perpendicularly to an edge or arc while dragging an element;
Arrow with Tangent sign  - snapping tangentially to an
arc while dragging an element.
There are also a number of cursor shapes that only appear in
special situations:
Cloud  - empty space over the horizon in perspective views;

Magic Wand  - use for tracing the contours of existing
elements for creating new elements with the active tool. It has
three different shapes for identifying edges  , nodes  and
empty space  (including surfaces) .
Scissors -  trimming elements (hold down the Ctrl/Cmd key
while clicking on an element). The Black Scissors  appear
on top of element edges, while the White Scissors 
indicate empty space;

Eyeball  - defines the direction of Roof’s slope, the side
that remains selected when splitting elements, the depth of
Limited Sections and the orientation of Doors/Windows;

Double Eyeball  - locates position of edge-placed Door/
Window;

Hammer  - places Dimension chains, Angular
Dimensions, the Elevation Dimension array and Fill areas;

Trident  - moves Marquee area or the Clipboard contents
after pasting.

Moving Elements
You can move elements individually or collectively by
dragging, rotating or mirroring them along a horizontal plane
(or, in 3D, along a defined reference plane) and through
vertical displacement, that is, by changing their elevation
values.

To move elements, you can:
- Select them and choose the corresponding menu

command from the Edit menu (with any tool active in the
Toolbox);

- Click an item with the right mouse button (Windows) or
Ctrl-click it (MacOS) and choose the appropriate command
from the appearing context menu;

- With the Arrow tool active, start displacing the selected
elements and then choose the desired shortcut in the
appearing pet palette.

 

See also the Creating Exact Duplicates of Elements section in
Chapter 4: Element Creation, for the description of the way to
move (drag, rotate, mirror, multiply) copies of selected
elements.
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Dragging
When dragging elements (either with the Drag command
from the Edit menu or the context menu or by using the
Arrow tool and the pet palette), you define a drag vector by
drawing a temporary line in the direction of the intended
move. The length of the temporary line represents the
distance by which you wish to move the selected items.

The drag vector is drawn anywhere on the screen. If using the
Drag command, you start at a characteristic point of the
selected elements. However, it is possible to connect two
entirely independent reference points as well. With the Arrow
tool, dragging must start from an element node or edge.

All selected elements are moved to a new location. Single
elements appear as a grayed image as you move them.
Selections containing multiple elements appear as a grayed
bounding box as you move them.
To move an element, click on a node or edge of a selected
element. When you move the Arrow Cursor, the element will
be dragged by the vector the cursor has defined.

This function will also work when several elements have been
simultaneously selected. All of the selected elements will be
dragged along the same vector.

- If you want to drag a Door or a Window within the Wall
that contains it without moving the Wall itself, select the
opening individually. You cannot drag an opening entirely
out of its host Wall even if you define an outside endpoint
for the drag vector.

- When dragging a Curved Wall, the rubberband outline of
the opening always moves along the wall, no matter
where you place the cursor. In any other respect, the
process is the same as for openings in straight walls.

- Dimension chains can be dragged to a new location, but
associative Dimension chains can only be dragged along
the direction of their witness lines. You can move the
cursor anywhere when dragging, but only the
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perpendicular component of the movement will be
applied to the chain.

        

- You cannot drag a Radial Dimension away from the
element it dimensions; you can only move it to another
location along the element’s curve.
Note: In 3D, dragging can also change the elevation of the
selected elements. To constrain the movement of the
elements to the horizontal plane, activate the horizontal-
vertical angle pair in Options/Preferences/Mouse
Constraints and keep the Shift key pressed while
dragging the elements.
If you define a territory on the Floor Plan to be visualized
in 3D and you drag an element outside this space in 3D,
the element will disappear from the 3D Window.

Rotation
You can rotate selected elements in the Floor Plan or in the
3D Window, and drawing elements only in Section/
Elevation windows and Detail Drawings. Even in the 3D
Window, rotation is always performed across a horizontal
plane. The methods are similar to those described for
dragging (Edit menu or context menu command, pet palette).

When rotating elements, you need to click three times:
1) Define the center of rotation of the selected elements.

 

2) Define the starting point of the rotation angle, then
3) Move the cursor and click to define the desired radius and

endpoint.

 

Note: When using the Arrow tool and the pet palette, the
center of rotation must be on or along the selected
elements.

You can use rotation to change the orientation of a Dimension
Chain after it is completed. Rotated Dimension Chains will
remain associated to the same nodes, so you will see the
length and the values change along with the witness lines.

 

After a rotation, all the reference points will automatically be
redimensioned and projected along the new direction, with
the original hierarchy maintained. Dimension lines will always
be kept right side up; if you rotate them upside down, the
numbers will move to the opposite side.

Rotating Doors and Windows works differently from other
elements. Selected openings will rotate by 180 degrees
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around their centers. Any number of openings can be rotated
at the same time.

 

Note: Rotated text blocks, labels, dimensions and fill
polygon area labels are always readable from the bottom
and the right side of the drawing.

Mirroring
Mirroring creates a mirror image of selected elements on the
Floor Plan or in the 3D Window.
When mirroring selected elements, you define the mirroring
axis with two clicks, as if you were drawing a Line.

     

- Any number of Doors and Windows can be mirrored at a
time. Text, Line arrowheads and Dimensions will not be
mirrored, only their bounding box will be mirrored.

- Mirrored Text blocks, Labels, Dimensions and Fill
polygon area labels are always readable from the bottom
and the right side of the drawing.

- Zone stamps cannot be mirrored.

When mirroring a Door or Window, clicking outside the wall
that contains the selected opening will mirror it at its central
axis. The opening direction will change laterally, while the
opening remains facing the same side of the wall as shown in
the figure below.

   

If you click on the reference line of the host Wall, the opening
will be mirrored to the line that is perpendicular to the Wall at
this point. The mirroring does not occur if the opening would
fall entirely beyond the end of the wall. However, if the
opening would fall partly off the wall, you will be prompted
to choose whether or not you wish to keep the opening.
Dimension chains can be moved to the opposite side of a
Wall by mirroring. The same rules apply for mirroring as for
rotating.  The value positions are always automatically
recalculated by ArchiCAD so that you can read them from the
bottom or from the right.

Vertical Displacement
Elevating elements can be performed numerically in both the
Floor Plan and Section/Elevation Windows, and graphically in
the 3D Window only.
Choosing the Elevate command from the Edit menu allows
you to move selected elements vertically along the Z axis.
This command is well-suited to changing the elevations of large
numbers of similar elements (i.e., walls, landscaping objects,
floor tiles, and lighting fixtures). It is the best way to preserve
the vertical relationships between objects while moving them.
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Type in the dialog box the value by which you wish to raise
or lower all selected elements and click OK.

In the Floor Plan and Section/Elevation windows, clicking
the Elevate icon in the pet palette will also open the dialog
box.

In the 3D Window, you can also click an element node
(Arrow tool active) and choose the Elevate icon from the
appearing pet palette, and then graphically move the selected
elements up and down.

Modifying Element Sizes
Different element types have different characteristic
dimensions: length, width, height, thickness, opening angle,
etc. Some of these are easiest to modify numerically, by
selecting the given element, opening its settings dialog box
and adjusting the relevant values.

Some dimensions, however, cannot be modified numerically
(for example, the length of linear elements or edges), while
some others need to be fitted exactly to other elements, which

may make numeric adjustment a tedious calculation task. You
may also need to change the overall dimensions of several
elements at the same time while keeping their relative
proportions.
In these scenarios, you can modify element sizes by splitting,
stretching and trimming operations. Element nodes and edges
can be edited to add to the shape of elements.

Most of the operations can be performed in two ways, by
either choosing the appropriate Edit menu command, or by
using the pet palette's shortcuts. In some cases, only the pet
palette is available. The sections below offer details on:

- Horizontal Stretch

- Stretching with the Marquee tool
- Vertical Stretch

- Proportional Resizing
- Splitting

- Adjusting (extending and trimming)
- Adding and editing nodes

- Editing edges

Horizontal Stretch
You can horizontally stretch most types of selected elements
in both the Floor Plan worksheet and the 3D Window. Only
drawing (2D) elements can be stretched in the Section/
Elevation and Detail Drawing windows.
Some general considerations:

- You cannot horizontally stretch Columns, Hotspots,
Cameras and Detail Markers.

- GDL Object type elements may be programmed to only
allow specific sizes or include smart editing hotspots to
edit their shape graphically.

- The Stretch command cannot be used on polygonal
elements, but you can stretch their edges or displace any
of their nodes graphically.
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Stretching Walls, Beams and Lines
To stretch/shrink elements with the menu command:
1) Select an element.

2) Choose the Stretch command from the Edit menu.
3) Click an endpoint of the selected element and move it.

4) Click again to either define the new endpoint as an
extension (or reduction) of the previous length or define
an entire different new location. The element is stretched
or shrunk and, if needed, rotated according to the new
endpoint. The other endpoint will remain at its original
position.

Note: Multiple selected Walls, Lines and Arcs with
overlapping endpoints can all be stretched at the same time.

When using the Arrow tool and the pet palette:

1) Select an element.
2) Click one of the element's endpoints. The pet palette

appears. Choose the appropriate icon as shown below.

 

3) Click to define the new endpoint as with the menu
command.

Stretching Doors and Windows
When stretching Doors & Windows, you can use reference
points outside the host wall. The endpoint of the stretch
vector will be projected perpendicularly or orthogonally to
the wall (according to the current Cursor Snap Variant in the
Control Box) to define the new opening edge. This allows
you to position a Door or Window with respect to an element
within a room, or in another room, as shown below.

     

- Doors and Windows can only be stretched inside their
host Walls.

- If a Wall is shrunk so that both ends of an opening in it are
overtaken, the opening becomes deleted. As long as only
one end is affected, the opening will keep its integrity.
Note: Stretch will always affect the overall size of Doors
and Windows, which can be different from their nominal
size.

Stretching Objects
Objects and Lamps can be stretched by their hotspots,
provided that they have been appropriately defined, that is,
on the nodes and edges of their 2D Symbol. Other hotspots
cannot be used for stretching/shrinking.

To check this, select the Object to display its hotspots.
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You can either use the Stretch command or the pet palette's
appropriate icon to stretch/shrink the Object by a node or an
edge.

 

Note that you stretch the A and B parameters of the symbol,
and not of its bounding box. Using parametric 2D scripts, you
can easily create objects whose symbol size will not match the
A and B parameters. If you make such a symbol, make sure
that you define hotspots at the corner of an A*B sized
rectangle. These will enable you to stretch that symbol.

Depending on their programming, GDL Objects can have
smart editing hotspots in 3D. If you select such an object in
3D view, click a 3D hotspot and choose the horizontal or
vertical stretch icon in the pet palette (whichever is
appropriate), you will get a both a visual feedback of the

available stretching range and the name and value of the
parameter you are modifying.

For Doors, this feature can be used to graphically define the
opening angle of the Door in the 3D view. The appropriate
hotspot is located on the doorknob.

Stretching Text Blocks
You can reshape text blocks by any of its nodes. The text
block will rubberband as you move that node and the text in
the block will automatically rearrange itself according to the
new outline.



42

Chapter 5: Drafting and Editing Techniques

Graphisoft ArchiCAD User Guide

 

You may also decide to change the size of the text inside the
text block.

Select the text block and stretch it with either the Stretch
menu command or the pet palette. Move the cursor along the
text block’s diagonal, and press the Shift key to constrain it to
the diagonal.

With Shift still pressed, click to define the new size. The font
size will grow or shrink proportionally.

Stretching Curves
You can modify the circumference or radius of Curved Walls,
Arcs and Circles with either the Stretch command or the pet
palette icon. The possibilities are:

- Change the element's arc length by dragging its node
along the curve.

- Transform an Arc into a full Circle or the other way around.

Note: Curved Walls will be transformed into two half-
circular elements.

- Increase or decrease the element's radius by dragging its
perimeter.

Stretching and Reshaping Polygons
For polygons, you cannot use the Stretch command, only the
pet palette.

- If you click a node of a selected polygon, the two
neighboring edges will follow the stretching movement
and the shape of the polygon will change accordingly.
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- If you click an edge of a selected polygon, you can apply
an offset on that whole side of the polygon. This will
stretch the neighboring edges.

You can also apply this feature in the case of chained
elements. Selected elements will be treated temporarily as a
polygon, and all polygon reshaping pet palette options will
be available. In the example below, the Wall on the right
needs to be moved a bit further away while keeping its
connection to the two horizontal Walls. Select all three Walls,
click the central node on the edge of the Wall on the right and
choose the appropriate icon from the pet palette. Click when
you are satisfied with the new distance.

 

Stretching with the Marquee Tool
Stretching with a Marquee area defined in the worksheet
yields different results from explicit selection and stretching
when polygonal elements are included. This feature is not
available in the 3D Window.
When the Marquee area is drawn, you need to define a stretch
vector. You can either:

- Define the stretch vector by clicking on a node inside the
Marquee area and an external point (in this case, you will
not even need to choose the Stretch command, or

- Choose the Stretch command, and then define the stretch
vector by clicking any two different points.

When the stretching is performed, the shape of all linear
elements that have one of their endpoints inside the marquee
area will be stretched, and polygonal elements that have
nodes inside the marquee area will be modified accordingly.

  

- If all the nodes of a polygon are inside the Marquee area,
stretching will have the same effect as dragging.

- If none of the nodes of an element fall inside the Marquee
area, stretching has no effect on it.

- Columns, Objects and Lamps cannot be stretched with
the Marquee. If any of their hotspots fall inside the
Marquee area, they will be dragged along when the
Marquee area is repositioned.

- Camera locations are unaffected by Marquee area
stretching.

- When stretching Arcs or curved Walls with the Marquee,
their central angle (i.e. the arc/chord ratio) will remain
unchanged.
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Vertical Stretch
In the 3D Window only, you can modify the height of
selected elements graphically with the pet palette. The
Stretch command has no effect on vertical stretching.

Click a node of a selected element and choose the vertical
stretch icon in the pet palette. A ghost contour of the elements
follows the cursor. Click to set the new height of the element.

Resizing Elements
Choosing the Resize command from the Edit menu allows
you to enlarge or reduce selected elements either through
numeric input or graphically. This feature is only available in
the Floor Plan and, for drawing elements only, in Section/
Elevation windows and Detail Drawings.
The dialog box opened by this command offers further
options for resizing the thickness of Walls/Columns, GDL
Objects, text elements, arrowheads and markers
1) Select (with either selection method) the elements you

wish to transform and choose Resize.

2) In the appearing dialog box, enter the options you need
and click OK.

3) Click in the worksheet to define which point or edge of
the elements should remain in its original location. The
transformation will be executed.

 

If you choose to perform the operation graphically, you will
draw a transformation vector to define both the resizing ratio
and the location of the resized elements.

Note: Resizing does not affect grouped elements. To
Resize grouped elements, ungroup them or choose
Suspend Groups.
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Changing Polygons by Offset
For polygons only, there is a graphic offset option available in
the pet palette.
Select the polygon, and click any of its nodes. Choose the
offset option in the pet palette.

A ghost contour of the proportionally increased or reduced
polygon follows the movements of the cursor. Click when you
are satisfied with the new polygon size.

Splitting Elements
You can split selected Walls, Lines, Slabs, Roofs and Fill
polygons along a line segment, arc or polygon edge.

1) Select the elements you wish to split.
2) Choose the Split command from the Edit menu.

3) Draw a temporary splitting line or arc segment, or click on
an existing Line, Arc, Wall or polygon edge with the
Mercedes cursor.

4) Click on either side of the splitting line/arc/edge with the
Eyeball cursor.

5) Elements on the clicked side will remain selected, while
elements on the other side will be deselected. The selected
group of elements can be edited in the usual ways.

If the selected element is intersected by an element in several
locations, choosing the Split command will divide the
selected element at every intersection point.

  

  

Splitting is also available in the 3D Window. You can split the
selected element with a vertical plane into two segments. This
feature works the same way as on the Floor Plan. The
splitting line is drawn in the plane of the User Origin.

Note: When no elements are selected, the Split command
will let you split a wall at the clicked location along any of
its sides or reference lines.

Extending or Trimming Elements
You can adjust (extend or trim) the endpoints of selected
Walls, Beams, Arcs and Lines to a Line, Arc segment or
polygon edge.
1) Select the elements you wish to adjust.

2) Choose the Adjust command from the Edit menu.
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3) Draw a line segment, or click an existing line, wall,
polygon edge or arc/circle with the Mercedes cursor. The
endpoints of the selected walls and lines will be adjusted
(lengthened or shortened) to meet the drawn or clicked
line or curve. Only those elements will be affected that
intersect (or would intersect) with the chosen line/arc/
edge.

The Adjust command is available in the Floor Plan and 3D
Window and for drawing elements only in Section/
Elevation and Detail Drawing windows. In 3D view, you
can adjust the selected Wall or Beam to a vertical plane.
You can also adjust two selected Lines, straight Walls or
circular or elliptic Arcs to each other by having them meet at
their endpoints’ nearest point.

Select the two elements (they have to belong to the same
element type), and choose the Tools/Line Extras/Intersect
command.

  

This hierarchical menu contains two additional options
available for Lines only.

- Fillet joins two straight Line endpoints by drawing an Arc.
- Chamfer joins two straight Line endpoints by drawing a

Line segment.
On choosing either command, a dialog box will appear,
prompting you to set the radius for the filleting or chamfering.

Notes: The Fillet, Chamfer and Intersect commands are
not effective on grouped elements.
Lines are stretched or trimmed by the commands
depending on whether or not they intersect; if they do not,
a new length is determined in order to make an
intersection or to meet the fillet or chamfer.

Three ways of connecting the same two Lines.

You can also trim an element by simply removing the part that
extends beyond its intersection point with another element, or
even cut out a part of the element between two intersection
points. Trimmable elements are Walls, Beams, Lines,
Circles, Arcs and Splines.
Press the Ctrl (Windows) or Cmd (MacOS) key. The Scissors
cursor appears, which is white in neutral areas. If it
encounters an eligible element, it turns black, showing you
which part of the element can be cut. Click this element. The
clicked part of the item between the two nearest intersection
points will be deleted. Only displayed intersection points are
considered; intersection points outside of the current view are
not taken into account.
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If there is no selection, ALL intersections of the clicked
element will be taken into account. If there is a selection, only
intersections between the clicked and the selected element
will be considered.
In the 3D Window, you can also click on a Wall or Beam
surface for trimming.

Splitting and Adjusting Shortcut
A simple shortcut lets you adjust short elements and split long
ones by the same edge.

1) Select all the elements that you wish to split or adjust. The
active tool must be one of those that created the selected
elements.

2) Press the Ctrl (Windows) or Cmd (MacOS) key and click
the edge you wish to use for splitting/adjusting.

3) The operation is immediately performed. All the obtained
elements will remain selected.

Note: If another tool was active, hotspots will be
generated. If the Arrow tool is active, nothing happens.

Adding Element Nodes
With the pet palette, you can add new nodes to elements. In
the case of linear or curved elements, this will result in the
creation of additional elements, while for polygon type
elements, the number of edges will be increased accordingly.

Since you need to click an edge of the selected element, this
feature cannot be used in the 3D Window.

1) Click the edge of a selected element. When the pet palette
appears, choose the appropriate option.

2) Click to define the location of the new node.

 

When working on a polygon, double-clicking at the chosen
starting location will insert a new node without moving it.

Note: You cannot add a new node to a curved element or
segment.

Editing Element Nodes
With the appropriate pet palette icon, you can pick up a
polygon type element node and reposition it. The connected
edges will follow.
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- You can eliminate a node by merging it into one of its
neighbors.

 

- If you merge a node to a remote node (that is, not a
neighboring one), the smaller part of the polygon will be
deleted.

 

- If repositioning a node eliminates one of the connecting
edges, the other node of that edge will also be deleted,
together with the corresponding part of its own other
connecting edge.

 

- If you reposition a node so that the polygon edges
intersect each other (but no connecting edge is
eliminated), the polygon will be split.

 

- When repositioning a bent edge’s endpoint, the arc
segment will be stretched in a way that its central angle
(the arc-chord ratio) remains the same.

With the appropriate pet palette icon, you can also replace a
polygon node by a tangential arc whose radius can be set in
the Fillet/Chamfer Radius dialog box (see above).

 

- You can only fillet corners one by one, but once you have
set the radius, you can perform further filleting actions by
just clicking at any vertex and validating the radius in the
dialog box.
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- If filleting the arc with the current radius would extend any
of the neighboring vertices, the radius will be limited
automatically so that the filleting arc contains the closer
neighboring vertex.

- Filleting at intersections of bent polygon segments works
the same way.

Editing Element Edges
With the pet palette, you can bend a straight segment by
dragging one of its points. The resulting arc will cross the two
endpoints of the clicked edge and the point that has been
dragged.

 

Note: If the bent segment of a polygon intersects any of
the other polygon edges, ArchiCAD will regularize the
polygon’s shape, which may result in cutting the polygon
into several parts.

Adding and Subtracting Polygon Shapes
You can use the pet palette to add to its shape or subtract new
polygons from it.
To add a new polygon to the existing one:

1) Select the polygon and click it either on an edge or a node.
From the pet palette, choose the icon with the + sign.

2) Draw the new polygon shape. It must intersect with the
selected one or at least they should have a common edge

3) Click to finish drawing the new shape which is
automatically added to the original one.

The process is the same for subtracting a shape from a
polygon, but you will choose the icon with the - sign.
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Note: Instead of defining a new polygon, you can also use
the Magic Wand tool to add or subtract the shape of
another existing polygon type (of the same or a different
element type).

        

Verify that the operation has been performed by deleting or
dragging away the other polygon.

Note: Starting a polygon hole by clicking inside the
selected element's boundary with its tool active is similar
to subtraction, but it lets you temporarily create a self-
intersecting shape. Subtraction always creates a valid
shape.

Solid Element Operations
In addition to the associative element connections and
intersections outlined in the relevant sections of Chapter 4:
Element creation, construction elements can perform solid
operations on each other.

Solid Element Operations allow you to create complex shapes
by Boolean operations including subtraction, addition and
intersection. The result is associative: if you modify the

location or the attributes of the elements that participate in the
operation, the linked elements will be updated accordingly.

Solid Element Operations distinguish two roles:
- A Target is an element whose geometry will be modified

by the solid operation;
- An Operator is an element that affects the geometry of

the element it is linked to.

The operation does not modify or delete the Operator
element. You can hide the layers of the Operator elements
after the operation has been performed without resetting the
modified shape. You can also set the Operator's layer to be
shown as Wireframe, which allows you to still see the
Operator element's contour and adjust it as necessary.
In the illustration below, a Target Wall's shape was modified
by subtracting from it a Roof type Operator shape. On the left,
both elements are shown; in the middle, the Roof's layer has
been hidden; on the right, the Roof's layer has been set to
Wireframe.

  

An Operator can work on multiple Targets and a Target can
be affected by multiple Operators. Each element can be at the
same time a Target and an Operator at the same time, which
permits nested Solid Element Operations.

The operation remains in effect as long as the involved
elements are present. If you wish to keep the obtained shape
permanently, save it as a GDL Object from the 3D Window.
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Operation Types
Five types of operations can be performed. The illustration
below shows the effect of each, with the starting Wall shape
shown on the left. The Target element is shown in Wireframe
mode.

- Subtraction cuts out the shape of the Operator from
Target.

- Subtraction with upward extrusion cuts out both the
shape of the Operator from the Target and its vertical
projection from the bottom of the Operator shape to the
top of the Target.

- Subtraction with downward extrusion cuts out both
the shape of the Operator from the Target and its vertical
projection from the top of the Operator shape to the
bottom of the Target.

- Intersection keeps only the common part of the Target
and the Operator.

- Addition adds the shape of the Target to the shape of the
Operator.

Element Display and Calculation
The solid operation affects the model shape, that is, the 3D
view and the generated Section/Elevation model and Detail
Drawing view. Below is the Section view of the elements
shown above. The Targets are shown in Wireframe on the left
and their layers are hidden on the right.

            

The Floor Plan view of both Target and Operator elements is
unaffected. Putting the Operator element on a Wireframe
layer does not affect its display. If the Operators' layer is
hidden, then they will not appear in the Floor Plan, but you
will not be able to edit them until you make the layer visible
again.

Note: If you select only the Target on the Floor Plan and
display the selection in 3D view, the modified shape will
be shown, but without displaying the Operator, even if it is
on a visible or a Wireframe layer.

If you perform a Solid Operation on a Section/Elevation
view, you need to rebuild the window's contents to see the
results.

All listing commands will be performed on the modified
shapes.
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Performing a Solid Operation
Solid Operations can be performed on elements in either the
Floor Plan or the 3D Window by choosing the Solid Element
Operations... command from the Edit menu. It will open a
floating palette, Edit Targets and Operators, that can remain
visible on top of your worksheet as long as you need it. The
palette can be closed by clicking in its close box at top right.

The top section of the palette is the New Operation panel. It
contains tools for the creation of a new shape.

First, you need to select the element(s) that you wish to
modify.  Then click the Get Target Elements button. The
text field below the button will show the number of stored
elements.

Note: If you then select another element and click the Get
Target Elements button again, it will replace the stored
selection; it cannot be added.

Clicking the red button  next to the number of stored
elements selects the elements in the current window. Note
that, if you selected the Target elements in the 3D Window,
they may not all belong to the same Story. In this case, a
warning will inform you about this.

Then, select the elements that you wish to use as Operators.
You do not need to perform this selection in the same
window as you did for the Targets, and even in Floor Plan
view, you can select the Target on one story and the Operator
on another one.
When you have made your choice, click the Get Operator
Elements button. For these, too, you can check the number
of stored elements and select them  for verification.

If you want to discard either the stored Targets or Operators,
click in empty space to cancel any possible selection and click
the Get Target Elements or Get Operator Elements
button, then start to redefine them.
When both the Target and the Operator are identified,
choose an operation from the pop-up menu. The five
choices are illustrated in the introductory section.

The two radio buttons below define whether the new surfaces
of the Target resulting from the Solid Operation should take
on the colors (contour Pen Color and surface Material) of the
Operator element, or keep their own attributes.

When you have made and checked all your settings, click the
Execute button to perform the selected Solid Operation
between the stored Target and Operator elements.
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Solid Operation Maintenance
The bottom panel of the Edit Targets and Operators dialog
box is called Maintain Operations. Its controls allow you to
verify and cancel Solid Operations.

With the two buttons on top, you can make sure that when
you select an element prior to moving or transforming it, all
the elements that are linked to it through a Solid Operation
are also selected. Alternately, you can group these elements.
You can also use these buttons to modify the targets and
operators associated to an element. For example, select all
operators, change the selection, and repeat the operation with
the new selection.

The three buttons in the bottom section allow you to cancel
Solid Operations. They only work if there are elements
selected in the Project.

- Clicking the All Targets button will cancel operations of
the selected Operator element on all its Targets.

- Clicking the All Operators button will undo all
modifications on the selected Target element by any other
element.

- Clicking the All Other Selected Elements cancels all
operations between the selected elements, whether they
are Operators or Targets. On the other hand, no change
occurs concerning the operations that link any of these
elements to other, unselected Operators or Targets.

Restrictions and Remarks
Roofs participating in Solid Operations will behave as any
other elements, unlike when trimming elements to Roofs. See
Roofs in Chapter 4: Element Creation.

Bypass automatic intersections: Solid Operations do not
affect the results of automatic intersections, for example those
created with Walls and Columns, if they are included in the
same Layer intersection group. Before performing a Solid
Operation on such elements, change the Layer intersection
number of one of them. See Layers in Chapter 3: Project
Organization and Navigation.
Beams: If you intend to apply an operation between Beams,
the Operator must have at least the same 3D Intersection
Priority number as the Target. If the Target’s priority number
is higher, the operation will appear to have no effect. See
Beams in Chapter 4: Element Creation.
Nested operations: If the desired shape can be only be
obtained through a number of nested operations, pay
attention to the order in which you apply them. For example,
an Operator element may affect a Target that is also an
Operator affecting another Target, and so on.

3D Texture Alignment
The orientation and origin of construction element textures
can be fine-tuned in 3D views with the commands of the
Align 3D Texture hierarchical menu located in the Edit
menu.

This command is only available in the 3D Window on
selected construction elements whose Material attribute
includes a Texture assignment. Vectorial 3D Hatching has to
be enabled in 3D Window Settings.
The first command, Set Origin, allows you to define the
origin of the Texture applied on the surface of a construction
element.
1) Select one or several elements.
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2) Enter a 3D location. You can snap to element hotspots or
use numeric input.

The texture origin will affect all of the elements' surfaces. You
cannot, for example, use a different origin for the inside and
outside surfaces of a wall.

 

With the second command, Set Direction, you can change
the orientation of the Texture applied on the surface of a
construction element.
1) Select one or several elements.

2) Click on a surface of a selfCúed element. You must click a
main surface, which means that clicking a Wall, Slab or
Roof edge will cancel the action.

3) In the dialog box that opens, you can choose to either
define the texture's angle graphically or numerically.

         

Note: If you draw the Texture's vector manually, you can
snap to element hotspots.

The defined angle will be applied on the elements, relative to
the default orientation of the Texture measured
counterclockwise.

To return to the default Texture settings, select the element,
open its settings dialog box and go to the Model panel. The
Custom Texture information text is active. Click the Reset
Origin button to discard the customization.

You can also select several elements and choose the Reset
command in the Align 3D Texture hierarchical menu. To
remove all customization of the elements of the 3D Window,
do not select any of them and choose Reset All.

Note: Changing an element's Material assignment will not
discard the customization, even if you choose a Material
that does not have a Texture assigned to it.

Drag & Drop
The Drag & Drop technique is familiar to both MacOS and
Windows users as a shortcut for opening files or for copying
and pasting elements of different types into Windows of the
same application or between applications.
Since ArchiCAD has many different Window types, the smart
implementation of Drag & Drop allows you to copy elements
from Windows by pasting data in the receiving Window.

You can also drag & drop GDL Objects (Library Parts) from
GDL Object Web Plug-in enabled web pages directly into
ArchiCAD Projects, the Object Settings dialog box or the
Active Libraries list of the Library Manager dialog box.
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Note: The Drag & Drop feature can be disabled or enabled
by the corresponding checkbox in the Options/
Preferences/Miscellaneous dialog box.

Data Transfer between Different
Window Types
Data can only be dropped into a Window on the condition
that the receiving Window can accommodate the dragged
data type.

Dragging and Dropping Text
The following possibilities exist when transferring text:

- from any ArchiCAD Text Window or from a Text Window
of any other Drag & Drop-capable application to any other
ArchiCAD Text Window;

- from any Text Window to any 2D Window (Floor Plan,
Section, Library Part 2D Symbol) with the default parameters;

- moving or copying text within the same Text Window;
- creating text type clipping files in the MacOS Finder or the

Windows Desktop;
- pasting clipping files into a text type Window;

- dropping text from a text type Window into the Trash
(MacOS) or the Recycle Bin (Windows) to delete the text;

- dropping plain text files into a text type Window (with
some restrictions).

Dragging and Dropping Pictures
The following possibilities exist when transferring picture type
data:

- dragging a whole picture or a selected part of it from the
3D Window, a Model Picture window or the Project
Preview window;

- dropping a picture file into a GDL Object Preview
Window;

- dropping a picture file into the Floor Plan to paste it as a
Figure;

- creating picture type clipping files in the MacOS Finder;
- pasting clipping files into the GDL Object Preview

Window.

Dragging and Dropping GDL Object Files
You can drag and drop GDL Object files from the MacOS
Finder or the Windows Desktop directly into ArchiCAD
Projects, the Object Settings dialog box or the Active Libraries
list of the Library Manager.
Dropping an Object into the Floor Plan activates the
corresponding tool in the Toolbox and the newly placed
element becomes the default element for the given Object
type.

- It is possible to place several GDL Objects at the same time
using Drag & Drop.

- Windows and Doors can only be dropped into a Wall.

Dragging and Dropping Floor Plan Elements
If there is a selection on the Floor Plan defined either with a
marquee area or through individual selection with the Arrow,
pressing the mouse button and dragging the cursor out of the
ArchiCAD Floor Plan Window will initiate a Drag & Drop
operation.
The following can be copied:

- Floor Plan elements (in module format);
- Selected elements on the Floor Plan in picture format (for

example, into the Project Preview Window);

- The 2D and/or the 3D script of the selected elements in
text format.

3D GDL script is only generated if the drop is made into the
3D Script window. The 2D script of the selected element can
be dropped into any other text type window.
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Editing Text
ArchiCAD Projects can include text in different locations:

- Text blocks placed with the Text tool;
- Labels;

- Dimensions;
- Zone Stamps;

- Parameters of GDL Objects;
- Text type windows.

ArchiCAD offers a number of tools for editing, searching and
replacing text in these different locations.

Editing Text within Text Blocks
The quickest way to edit text is to activate the Text tool,
choose the Select All Texts command on the Edit menu, and
click in the text block that you want to edit. This way, you do
not need to find a hotspot of the text block to select it.

To change the contents of a specific text block, select it first.
1) With the Text tool active, clicking in a selected text block

will open the text for editing in a gray frame. Rotated text
blocks will become horizontal while you edit them.

2) You can cut, copy, paste and clear text while working in
the frame.

3) When you are finished with this block, click in another
text block to continue editing.

4) When you are through editing text, click anywhere on the
Worksheet (except in the text block) or click the OK
button in the Control Box.
Note: If you hit Enter or click the Cancel button, the
editing process will be canceled but the text block will
remain selected.

While editing Text within text blocks, all screen functions are
available.

Search and Replace
The Search and Replace Text... command from the Tools/
Tools External Commands menu can search texts in all
eligible element types. It works on the Floor Plan and in the
Sections/Elevations Windows. The dialog box it opens has
two modes: Novice and Expert. By default, the Novice
mode is displayed.

Clicking the Filters button opens a further dialog box in
which you can set Element, Layer and Story filters.

When you have made your choices here, click OK to return to
the main dialog box.
If you click Replace All, all found texts will be automatically
replaced.
If you click Start Search, a Window will appear listing all
found texts.
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The texts are fully editable.
Individual and multiple selections are both possible.

The buttons in this dialog box perform sophisticated
operations on selected texts and elements associated to them.

- Click the Replace button to replace text in the selected
lines.

- With the Zoom buttons you can zoom to the element of
the first selected text.

- Click Apply Changes to apply to the plan the changes
made in the list.

- By clicking New Search, the list will disappear and you
can start a new search.

In the Search and Replace dialog box's Expert mode, you
can define a case sensitive search and choose among a
number of options for limiting the search to more or less
specific matches.

Spell Checker
The Spell Checker command from the Tools menu Tools
External Commands allows you to check the spelling of your
ArchiCAD project. The available features are similar to those
used by Microsoft Word.
Spell checking works on Text blocks, Zones, Labels, custom
text entered into Dimension labels, as well as on Door,
Window, Object and Lamp parameters.

Software Requirements
Spell Checker uses Microsoft Word's Spelling Check, which
means that you need to have Microsoft Word installed on your
computer together with the dictionary of the language you are
using.
In addition, on the MacOS only, several freeware and shareware
applications are available that take advantage of the Word
Services suite. For more information, see the
www.wordservices.org website.

Warning: Spell Checker relies on Microsoft technology.
ArchiCAD can only locate Word's Spell Checker if its
pointer is correctly written in the Windows Registry. If you
have properly installed Microsoft Office, SpellChecker will
work without any problem. If you have manually modified
the location of Microsoft Word, ArchiCAD will not be able
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to use its spellchecking features. Moreover, the Spelling
commands must be installed with Word.

Note: On the MacOS, it is possible to drag install Microsoft
Office. In this case, the registry file needed for the Spell
Checker is not automatically created. This means that, if
you have not used your copy of MS Word before using
ArchiCAD's Spell Checker, you will need to start Word
(which will create this registry file) and then quit Word.

Using Spell Checker
Choosing the Spell Checker/Open Spell Checker
command opens the Spell Checker dialog box. Initializing
Word or the Word Services application may take a few
seconds.

Note for MacOS users: Before launching Spell Checker,
choose either the MS Spelling Checker or the Word
Services option in the hierarchical menu. By default, the
last chosen application will be used.

Spell Checker then starts looking for spelling errors in your
project according to the last settings made in the command's
Preferences (see below).
When a possible spelling error is found, you can look at the
listed suggestions and select one in the list. This suggestion
will appear in the Change To: field. You validate the change
by clicking the Replace button. You can also change all
occurrences of the same mistake by clicking Replace All.
Note that Spell Checker can only replace errors that are in
editable items.

The other buttons on the top right allow you to:
- Ignore a single occurrence of the word

- Ignore All the occurrences of the same word
- Add the found word to your custom dictionary

- Check the spelling of the Change To field, if you've
entered text there manually.

The top left of the dialog box tells you in which element type
and on which story the problematic text was found.

Below this field, four zooming controls are provided, allowing
you to locate the element in which the misspelled word was
found.

Clicking the Stop button at bottom right stops the spell
checking process.

In this case, the Preferences... button becomes active,
allowing you to change the options for the Spell Checker
command. If you return to the main Spell Checker dialog
box, click Start to restart spell checking.
You can click the Close button at any moment, or when the
program informs you that there are no more spelling errors
found.
Replacing spelling errors is carried out immediately when you
click the Replace button (provided that the given item is
editable), but choosing Undo Spell Checking will cancel all
changes in one step.
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When you've finished spell checking, you can choose the list
of errors in a text file with the two other commands of the
Spell Checker hierarchical menu.

- Choosing Save Spelling Errors will only save those
errors that were found in editable items.

- Choosing Save All Spelling Errors will save in the text
files all errors, including those that were found in non-
editable items. You can then open and print this text file
and make the given items editable by unlocking elements
or layers, carry out the changes manually (or by choosing
Check Spelling again), and then restore the original state
of the elements. You can also use this file as a basis for a
custom dictionary.

Spell Checker Preferences
When spell checking is suspended, the Preferences... button
is active. Clicking it opens a dialog box with two tab pages.
The first tab page allows you to choose options for searching
on stories and layers and in element types.

With the Languages and dictionaries tab, you can build
customized dictionaries.

On top of the dialog box, the Language pop-up menu allows
you to choose one of the standard dictionaries installed for
Microsoft Word.
By default, the last used language (or the factory-defined
default localized one) will appear in the pop-up menu. If you
need to use other languages, click the Search… button to list
all installed dictionaries.

Note for MacOS users: This feature is only available for
the MS Spelling Check, but not for the Word Service
applications. In most of these, you need to manually select
a language before starting Spell Checker.

In the Custom dictionaries section, you can add and remove
existing dictionary files and create new ones. Although you
can have more than one custom dictionary specified and Spell
Checker will search in all of them, you have to designate
which one the new words will be added to.

Note for MacOS users: Custom dictionaries used with the
MS Spelling Check are automatically converted by Word
Services applications and vice versa.
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Editing Text Windows
When working in a text type Window, most of the Edit menu
commands change in order to provide you with basic word
processing features.

The Text Style command opens a dialog box determining
how your text will look both on screen and for printing.

In the Tabs field, you can define the number of character
spaces ArchiCAD uses when you press the Tab key.
The Font and Size Settings allow you to choose among the
available fonts in your system. Changing the font type and/or
size affects the whole text Window.

Notes: You can define different fonts and sizes for the
different text Windows. In a new document, the text
Windows will, by default, have the format defined when
ArchiCAD was last used. You can return to the original
defaults by pressing the Alt key and choosing New and
Reset.

Choosing the Find & Replace command opens the Text
Window Find dialog box which offers the searching options
used in most word processing applications:

- Find all occurrences of a word, phrase or series of
characters in a Window or in the selected text.

- Find and replace words exactly as typed.
- Searching and replacing backwards.

The Find Selection command searches for the selected string
in the text according to the direction set in the Text Window
Find dialog box, while the Find Again and Replace Again
commands repeat the last find or replace operation in the
direction set in the Text Window Find dialog box.
The Go To command allows you to go to the desired line by
simply entering a number in the edit box. This feature is
especially useful when editing or checking GDL scripts.
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Chapter 6
Project and Program Customization
In your everyday use of ArchiCAD, you will want to tailor the program to your specific needs, define standard options for all
projects in your office, or else use special settings for different projects. ArchiCAD provides a large amount of freedom in
customizing various aspects of the program and of the workplace. This chapter presents those options of the program that can be
changed by the user, such as custom symbol line types, shortcut keys, library usage, and the precision of decimal display.

Starting or Opening a Project
When first launching ArchiCAD from your system’s
application menu or by double-clicking the program icon (but
not an existing project), it will display its startup dialog box,
prompting you to decide what you would like to do.

Note: This dialog box can be disabled by checking the
appropriate box bottom left, and enabled again in
Options/Preferences/Dialog Boxes and Palettes.

You have three basic options:
- Start a new Project;

- Open an existing Project;
- Sign in to a shared Team Project. For details, see the

Teamwork section in Chapter 9: Collaboration and
Connectivity.

Creating a New Project
If you enable the Create a New Project radio button in the
startup dialog box, you can again choose from three options
displayed in the bottom area.

- If you choose latest settings, you will continue working
with all the project and workplace specific options that
were in effect when you last quit ArchiCAD. This can be
the perfect solution for you, if you always work with the
same standard definitions. However, if you last opened
and worked on a project that was created by another
person, you may find that quite a few of your preferred
settings are off. If you do not wish to return to the default
settings (see below), open a project that you are familiar
with, then close it and start a new project with those latest
settings.

- Choosing a Template is the ideal solution if you have
developed a number of standard template files with
predefined options. A template is a read-only file; when
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starting a new project based on a template, you are in fact
opening a copy of this template file as "Untitled." The
template file can even contain some construction or
drawing elements. Template files are identified by the
".tpl" file extension.

- If you choose default settings, this means that all the
customization made for the last used project will be
discarded. With a few exceptions such as the customized
shortcut keys, active Add-On choices, the list of recent files
and the position and size of the main ArchiCAD window
(on Windows only), all the settings will reflect those you
had when starting the program for the very first time. By
default, ArchiCAD will also look for and, if available, load
a library called ArchiCAD Library from the program’s root
folder. This solution is especially recommended in the
learning phase of the program or when having to work on
a computer you are not familiar with.

Note: If you have closed a Project and chosen New from
ArchiCAD’s File menu, a smaller variant of the startup
dialog box appears, listing only the three options for
creating a new project.

Opening a Project
The options for opening a Project are detailed in Chapter 11:
Menu command reference. Still, a few points may be
important to stress:

- If you open a Project that you created on that particular
computer, none of the previously set options will be lost,
and you can continue working on it as if you had not
interrupted your design, even if you have worked on
different Projects in the meantime. Workplace-specific
changes, however, will be in effect. These are mainly your
choices made in the Options/Preferences dialog box, as
well as window and palette positions, printer and plotter
options and active Add-Ons.

- If you open a Project that was created on another
computer, make sure that you get an Archive format file,
otherwise it may be missing references, especially library
items such as the Objects, Doors, Windows, Lamps placed
in the project, or the background images and textures used
by the 3D Window options.
Note: This is not needed in an office that uses the same
Libraries on all computers.

Shared Projects
When signing in to a Team Project, you need to know that
most of the Project’s settings can only be changed by the
Team Leader. Those options that you can customize will be
preserved, and you can reuse them when next signing in. See
Teamwork in Chapter 9 for more details.

ArchiCAD Attributes
ArchiCAD elements refer to a common set of attributes that
define their appearance and behavior in the different views.
Attributes include:

- Pen Colors for the contours and the hatching of elements;

- Line Types for the contours of elements;
- Fill Patterns and Composites for the hatching of

elements;

- Materials for the color and general look and feel of the
elements of the model;
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- Zone Categories for the classification of the spatial units
defined in the Project;

- Layers and their combinations for defining various views
of the Project by showing different types or sets of
elements.

- Mark-Up Styles for adding redlines and comments to the
design.

The default attribute set delivered with ArchiCAD is available
at all times when you choose to use the default settings. The
changes you make to the default set are stored with each
saved Project, even if it is moved to another computer.
You can customize the basic attribute set with a number of
commands in the Options menu. In addition, the Attribute
Manager command, also in the Options menu, allows you to
import and export attributes from other projects or special
attribute files.

Note: The use of Layers is described in detail in Chapter
3: Project Organization and Navigation. The creation and
handling of Zone Categories can be found in the Zones
section of Chapter 4: Element Creation. Mark-Up Styles
are covered in the Mark-Up section of Chapter 9:
Collaboration and Connectivity.

Pens & Colors
You can assign one or several pens to each ArchiCAD
construction element in its own tool settings dialog box,
depending on the element type. Pens are simulated drawing
instruments which have a specific color and line weight.

You can define or change the colors or line weights in the
Pens & Colors dialog box, opened from the Options menu.
There are 255 pens represented in the tablet. Their serial
numbers are indicated by their position in the tablet. The top
row contains pens 1 to 20 from left to right, the row below,
pens 21 to 40, and so on.

There is a default color assignment for each pen, but you can
edit any color for a specific pen by double-clicking its color
box or the Edit Color button. The Edit Color system dialog
box appears, in which you can select there your color
graphically or numerically by mixing the color components.

When you click OK, the new color appears in the box for the
given pen.
After the colors have been redefined, the ArchiCAD
construction elements immediately change to the new colors
on the Floor Plan. The 3D Window and Section/Elevation
windows require that you rebuild the view.

You can use Shift- and Control-click to select continuous or
discrete ranges of pens, and change their width and color in a
single step in the Edit Selected Colors dialog box.
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Different mappings are used to translate ArchiCAD’s 255 pens
into output on the selected output device. See Chapter 13:
Printing and Plotting.

ArchiCAD offers user-defined Pen Weights associated with
each of the 255 Pen Colors. Pen Weights are measured in
points or millimeters, depending on the current drawing units
set in the pop-up menu next to the Pen Weight edit field. This
makes it possible to create Floor Plans with a wide range of
thick and thin Pen Weights for first class graphic presentations
or easily readable working drawings.

- Pen Weights are displayed when you choose True Weight
in Display Options (see later). If Line Weight is set to
hairlines, all lines are one pixel wide.

- Pen Weights are accurately printed on high-resolution laser
printers.

- Separate Pen Colors or Pen Weights can be assigned to
line arrowheads, various dimensioning components and
vectored fill pattern strokes through the corresponding
Tool and attribute dialog boxes.

- Pen Weights are saved when you export ArchiCAD
Projects to PlotMaker.
Note: A Pen Weight of 0.00 always produces the thinnest
weight possible (i.e., one pixel on the screen or a hairline
on a laser printer).

Line Types
You can assign line types to each ArchiCAD construction
element in its own Tool Settings dialog box, depending on the
element type.
You can modify the standard line types (solid, dotted, dashed,
etc.) and define customized line types in the Line Types
dialog box, opened from the Options menu/Line Types
command.

You can create new line types by clicking the New button. In
the resulting dialog box, you can choose between creating
dashed or symbolic lines. You can also simply duplicate the
currently selected line type and then modify this copy.

After editing the name of the new line to be created, make
sure that Dashed is selected as the line type and press the OK
button. You will then be presented with a dialog box made up
of two basic parts. In the lower part of the box, right under
Edit selected type, you will be able to graphically edit the
first component of the line you wish to create. The black and
white flags represent sections of the dashed line. New
sections can be added or deleted as needed by moving the
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little pyramid shaped marker below the numerical input
boxes.

Each black flag represents the end of a dash in the line, the
length of which can be edited either by dragging the flag in a
horizontal direction, or by editing its value in the Dash edit
fields. The little white flags represent the gap between each
dash section, and can be edited similarly. The values in the
numerical input boxes are given in the respective measurement
standards defined under the Working Units... section in
Preferences (Options menu). If for example, your drawing
units are given in meters, you will be given a scale in
millimeters. Likewise, if you choose feet and inches as your
drawing unit, you will be able to define these values in inches.

Symbolic lines are created by first drawing the stencil on the
Floor Plan, using Lines, Arcs and Hotspots. Once you have
finished drawing the line type stencil, select all of its
components using the Arrow Tool and choose Copy from
the Edit menu. Now select Line types... from the Options
menu, and click on the New button. Select Symbol as your

line type from the dialog box, and edit the name you wish to
give to this new line.

Press the lower button under the graphic editing section
labeled Paste line components. The previously captured
line component will appear in the graphic editing Window.
You may edit the scale of both line component and the gap
between each component, by either dragging the little flags in
the window or editing the numeric values underneath. The
line component will be scaled as a whole. Modifications in
size are reflected in real time by the change of the values in
the numerical editing boxes.

Notes: Only Arcs, Lines and Hotspots may be used in the
definition of symbolic lines. If the selection of components
copied from the Floor Plan includes splines, fills, text or
other elements, these will not be pasted into the Line
Types dialog box. The bounding box of pasted graphics
will be centered on the centerline of the Symbol line. If the
Project Origin was located within the bounding box of the
copied elements, it will be used for alignment.
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Regular Copy-Paste operations do not function in this dialog
box.

If you wish to change a symbolic line after the original
components have been deleted from the Floor Plan, you must
first choose the line to be edited within the Line types...
dialog box, and press the Copy line components button. By
pasting these components on the Floor Plan, they become
editable once more. See above for details on how to define
this newly revised group of elements into a line type.
If you wish to delete a line type from the list of those
available, select the line type to be deleted within the Line
Types... dialog box, and press the Clear button.

Note: Line elements whose type has been deleted will be
named Undefined and displayed as Solid Lines. The basic
line types (Solid, Dashed, Dotted and Dense Dotted) cannot
be deleted.

The appearance of the lines on the screen, printer or plotter
depends on the following options:

- With the Scale with plan radio button selected, the line
elements are placed on the Worksheet at the given scale
and interpreted like other construction elements. If the
scale of the Worksheet is changed, the lines will grow or
shrink proportionally.

- With the Scale-independent radio button selected, the
line elements have the same size as seen in the dialog box
regardless of the actual scale.

In all dialog boxes where line types are listed (e.g. Line
Types, Line Settings and Outline of Remote Elements)
the line types are displayed at the scale in which they were
originally defined.

Note: Avoid editing a scaled line type if the drawing scale
of the Project is different than that of the line type, as it
will be distorted in the editing field.

Fill Types
Fills are geometric patterns that you can assign to construction
elements and 2D Fill polygons in their own tool settings
dialog boxes. Each fill has two faces: bitmapped and vectorial.
In a Project, all construction fills and all polygon fills are
displayed either as bitmapped or vectorial patterns. You can
set these options in Display Options (Options menu).

Selecting the Fill Types… command displays a dialog box
that enables you to edit bitmapped patterns and vectorial
hatches. Both of these fill types can be displayed on screen
and printed, but only vectorial hatches can be plotted.

At the top of the dialog box, you can choose a Fill to edit from
the pop-up list of available Fill Types.

To create a custom fill pattern, click the New button. In the
following dialog box, you can either create symbol fills or



67

Chapter 6: Project and Program Customization

Graphisoft ArchiCAD User Guide

simply duplicate the current fill type and then modify this
copy to meet your needs.

To get rid of redundant fill types, select the one you want to
remove and click the Clear button.

Note: The basic fill patterns (Solid Fill, Empty Fill) cannot
be deleted.

If you want to change the name of an existing pattern, select
the desired fill type, click the Rename button and type in the
new name.
The smaller pattern window allows you to monitor and edit
the bitmap pixel by pixel. The new pattern remains
associated to the selected name and vector fill. Bitmapped
patterns are displayed much faster than vectorial patterns.
They can be printed, but cannot be scaled, zoomed, or
rotated.

To edit bitmapped patterns, select a pattern from the list, then
click with the arrow in the bitmap pattern window to turn
pixels on or off. An example of the modified pattern will be
shown in the pattern list.
Vectorial patterns are made up of individual line segments
as opposed to bitmapped fill patterns. They are displayed
more slowly in ArchiCAD, but can be plotted, scaled, rotated
and zoomed.

The large sample window in the left section of the dialog box
displays the vectorial pattern of the selected fill type. The
displayed sample shows the pattern as it would look on the
Floor Plan at the current zoom level.

You can stretch, shrink, and rotate the vectorial hatch by
typing values into the three edit boxes on the right of the
dialog box. In addition, you can select the desired zoom level
of the sample window by either choosing a standard scale
with the Zoom buttons or entering a nonstandard scale in the
text input window.

Note: The internal geometry of vectorial patterns cannot
be edited in ArchiCAD.

Fills and Project Scale
In this dialog box you can set the display of fill patterns.

- When the Scale with Plan mode is active, fill patterns will
remain proportional to your drawing at whatever scale you
set.

- In Scale Independent mode, fill patterns remain at a
constant size and will not keep their proportions relative
to other drawing elements when you change the scale of
the document.
Note: The selected scaling option applies to the currently
selected Fill Type only. It is not a universal setting.

For example, use Scale-Independent for the simple diagonal
hatching used traditionally for brick walls. The spacing of the
lines will be the same regardless of the scale.
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Use Scale with Plan for a rectangular floor tile pattern created
for a given tile size, like 12" by 12." The vectorial pattern will
accurately show the real number of tiles at any scale. When
combined with the Link To Fill Origin option available for
the Fill Tool, you can accurately simulate floor tiling.

To change the vectorial pattern of a specific fill type:
1) Select the fill you want to modify in the list.

2) Click the Clear button.
3) Select another fill from the list which has the desired

vectorial pattern.
4) Click the New button. This will cause the selected pattern

to take the place of the one which was cleared. All
elements which used the cleared pattern will now contain
the new one.

5) Set the scaling, orientation and spacing as desired.
6) Click OK when you are finished.

Symbolic fills are created by first drawing the stencil on the
Floor Plan, using Lines, Arcs and Hotspots. After finishing the
fill type stencil, select all of its components and chose Copy
from the Edit menu. Select Fill Types… from the Options
menu, and click on the New button. Select Symbol Fill as
your fill type from the dialog box and edit the name you wish
to give to this new fill.
Press the Paste button above the sample window. The
previously captured fill component will appear in the sample
window. You may edit the horizontal and vertical stroke, scale
and motif size as well as the rotation angle by editing the
numeric values.

Notes: Only Arcs, Lines and Hotspots may be used in the
definition of Symbol Fills. If the selection of components
copied from the Floor Plan includes splines, fills text or
other elements, these will not be pasted into the line types
dialog box.

Regular Copy-Paste operations do not function in this dialog
box.
If you wish to change a symbol fill after the original
components have been deleted from the Floor Plan, you must
first choose the symbol to be edited within the Fill Types…
dialog box, and press the Copy button. By pasting the symbol
fill on the Floor Plan, it becomes editable once more. See the
above for details on how to define this newly revised group of
elements into a symbol fill.
Click the checkboxes of those elements for which you would
like the fill pattern to be available.

Note: Only vectorial fills are used in 3D Vectorial Hatches
(see Materials later in this chapter).

The setting chosen in Display Options/Construction Fills
and Polygon Fills will decide whether bitmapped patterns or
vectorial hatches are displayed.
The printed output also depends on the Display Options
setting, while the plotted output and the drawing exported to
DXF/DWG always use vectorial hatches.
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Composite Structures
Walls, Slabs and Roofs can have composite structures.
Columns have separate fills for their Cores and their Veneers.

You can select a Composite Structure from the pop-up on the
top. Clicking on a composite structure’s symbol in the tablet
will display the skin names of its components in the editing
box on the left side of the dialog box and produce a graphic
representation of the current composite structure.
Three buttons allow you to duplicate, rename and delete
composites.
On the left side of the dialog box, select a skin by clicking
either its name in the list or its corresponding graphic
representation. You can edit the skins individually by using
the controls below the list.
You can modify the thickness, fill pattern, fill orientation and
pen colors of any structural skin.

Independent pen colors can be used for the outline, fill and
fill background of each skin.
To draw the line between two skins, ArchiCAD checks for and
uses the skin with the heavier outline pen color. In the case of
equal pen weights, the pen color of the skin lower in the list
will be prioritized.

The orientation of the vectorial fills of walls can be set to
follow the angle of the wall.
All composite structures include structural, load-bearing skins
called Core, which play an important role when connecting
Walls and Columns. By default, the structural skin is the
thickest one, but you can change this setting with the
corresponding checkboxes. You can choose more than one
skin as part of the core, but they must be located next to each
other.

Note: Fill patterns enabled for walls in the Fill Types
dialog box are available for composite wall skins as well.
Important: When drawing a trapezoid Wall with a
composite fill, you will notice that only the innermost Core
skins’ thickness follows the thickness of the Wall along its
length.

Materials
Choosing the Materials… command displays the Materials
dialog box which allows you to determine the characteristics
of the materials used for the construction elements.
The Tool Settings dialog boxes for each 3D tool allow you to
select materials for ArchiCAD construction elements. Shaded
images in the 3D Window will use material colors only, but
when your plans are rendered using the PhotoRender
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Projection command (Image menu), all the characteristics of
the materials are used in the rendering process.

Note: If you use the OpenGL Rendering Engine, textures
will also appear in Shading.

The Materials dialog box contains controls for every aspect
of ArchiCAD surface materials.

The pop-up menu at the top of the dialog box displays the
current material set available in the Project.
Use the three buttons under the pop-up menu to duplicate,
rename and delete Materials.

Note: If you need a new material, duplicate one which
looks like the one you want and edit as needed.

In the Preview panel, you can edit the characteristics of
surface materials using the color and material type functions
described below. By selecting a color and a basic category,
even a non-experienced user can create attractive new
materials quickly.

Define a color for a material by double-clicking the Color
box. This opens the Edit Color subdialog box where you can
select your color graphically or numerically by mixing the HSL
(Hue-Saturation-Luminosity) or RGB (Red-Green-Blue)
components.

Select a material type from the Type pop-up menu where
several characteristic surface options can be found, then fine-
tune it using the different controls.

You can check the new material in the Preview window. This
will demonstrate the new visual attributes with the currently
set sunlight characteristics in the sample box on the left side
of the dialog box.
If you get a peculiar result, make sure that the sunlight color is
set to white.

Note: The Auto Preview function is not available if the
Apply Data file is not properly installed or has been
removed from the ArchiCAD Folder.

Most of the Reflection attributes of materials are set as a
percentage of their theoretical limit. You can edit the values
both numerically and with a sliding switch.
The Ambient control sets the percentage of ambient light the
material is able to reflect. This determines how much a
material is subject to brightening effects (as opposed to
shades or highlights caused by directional light).

The Diffuse control describes the surface quality of the
material. Uneven or rough surfaces tend to reflect incident,
directional light in a non-directional, diffuse way. Diffuse
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reflection carries the color of the material rather than the color
of light.

The Specular setting is the opposite of Diffuse. It is a
directional reflection carrying the color of the incident light
rather than that of the material. An extremely smooth and
saturated hard surface will produce strong specular reflections
(set at close to 100%), while a soft and light material will
produce hardly any (set at close to 0%).

Specular Color is theoretically identical to the color of
directional light, but the program lets you define it
independently. Double-click the sample color here to display
the Edit Color subdialog box, in which you can establish
your definitions. This color, mixed with the Material color and
the color of the light will determine the color of the surface
where directional light is reflected.
Shininess is the ability of a curved surface to reflect
directional light from a point-like source (sun, flashlight, spots,
etc.), in a more or less focused fashion. The more focused the
reflection, the more shiny the surface appears. Highlights are
confined to a small area if this control is set close to 100, while
a low value results in a wider highlight area.

The Transparency and Emission attributes control how
light penetrates a specified material and their fluorescence.

Transmittance indicates the percentage of light that can
penetrate the material. Glass is at the top of the scale and
opaque materials are at the bottom.

Attenuation controls how fast transmittance diminishes as
the object’s surface becomes less perpendicular to the
viewing direction. Any number in a continuous range from
zero to 100 can be set.
Emission color is set by double-clicking the Color box. In
the appearing Edit Color subdialog box, you can select your
color graphically or numerically by mixing the HSL (Hue-
Saturation-Lightness) or RGB (Red-Green-Blue) components.

Attenuation dictates how sharply the intensity of emitted
light decreases as the viewpoint is moved further and further
from the object.
On the 3D Hatching panel, you can choose a fill pattern for
the material that will be displayed in the 3D Window when
choosing Analytic Shading or Analytic Hidden Lines and
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switching on 3D Hatching in 3D Window Settings. You can
choose among Fill patterns available for the Fill tool.

Note: 3D Hatching does not affect PhotoRenderings, so its
effect cannot be seen in the sample box.

On the Texture panel, you can associate a Texture to any
standard or custom Material.

The name of the selected Texture appears in this area, and it
is also displayed with the Material’s name in the Material pop-
up palettes.

A sample of the Texture is shown above the Texture’s name,
and it is also applied in the Auto Preview area, provided that
the Apply Data file has been correctly installed.

- Clicking Clear in this area will dissociate the Texture from
the Material.

- Clicking the Edit Texture button will access the Texture
Settings dialog box where you can choose a Texture from
your active Libraries.
Note: For good results, you need textures prepared for
seamless tiling. These are images that can be placed in a
matrix with no apparent line at connecting edges.

The Texture Settings dialog box contains a number of
options for editing textures.

The name of the currently active texture file is displayed in
the title of the dialog box. The size in pixels of the image is
also shown.
In the left part of the dialog box, a sample box displays the
texture as it would look in a simple square. With the pop-up
menu below the sample box, you can choose a ratio for
repeating the same texture at the given dimensions.

In the middle section of the dialog box, a number of controls
allow you to define the size, angle, origin and proportions of
the texture as it appears on the elements that share the
material the texture is associated to.



73

Chapter 6: Project and Program Customization

Graphisoft ArchiCAD User Guide

- The first two edit fields define the vertical/horizontal size
of the texture as applied to 3D surfaces. For example, if
the image shows two bricks, set its size to match the
physical size of the bricks.

- Checking the Keep Original Proportions checkbox
below these fields will ensure that you see the proportions
of the original texture file on all elements.

- The next edit field allows you to define an angle at which
the texture is applied to elements.

- Using radio buttons, you can choose the way the texture
sequence is arranged by rotating and mirroring
operations.

- Activating the Random Origin checkbox will choose a
random starting point from which the texture is applied.
This option is useful if there are several identical elements
in the model that should differ in appearance.

At the right side of the dialog box, options are provided for
Alpha Channel control.
In 32-bit color images, the Alpha Channel is an extra channel
in addition to RGB components that can be edited in painting
applications like Adobe Photoshop. ArchiCAD allows you to
take advantage of the information placed in the Alpha
Channel in several ways, e.g., for masking elements in
PhotoRenderings.

Surface: If the alpha value is white, then you get the color of
the texture, while if it is black, then the material’s original
color will be valid in the given pixel of the given surface. If
the value is a shade of gray, then the two colors will be mixed
and the result will appear in the PhotoRendering.

Ambient: The same as above, but applied to the Ambient
color instead of the Surface color.

Specular: Controls to what extent the Specular effect is taken
into account. If the alpha value is white, the Specular effect is
entirely taken into account at the given pixel. If the alpha
value is black, the Specular effect is entirely disregarded at the
given pixel. Here again, intermediate values are allowed.

Diffuse: Controls the effect of diffuse light the same way as
above.
Bump Mapping: Controls the surface normal at the given
pixel, allowing for a convex effect on the surface. White
values represent bumps, while black values represent holes.

Transparency: If the value is white, then the color of the
texture is visible; if it is black, the texture will be perfectly
transparent at the given pixel. Intermediate values are
allowed.
At the bottom of the dialog box, a set of Search buttons are
available for browsing through texture files of the active
libraries.
You can use all image formats handled by the QuickTime
system extension. Formats that can include an Alpha Channel
are: Photoshop 3.0 and later, PICT, TIFF, PNG, Truevision,
TGA and the generic QuickTime image.

Note: Only files residing in the Active Library Set are
available for selection. If you save your Project as an
Archive, all associated Textures can be saved with the Plan
by checking in the Linked Textures checkbox. If a linked
texture is missing from the Active Library, its name will
appear in the Missing Library Items list.

Managing Attributes
The Attribute Manager command (Options menu) allows
you to copy (append, overwrite) attributes (Layers, Layer
Combinations, Pens & Colors, Line Types, Fill Types,
Composite Structures, Materials, Zone Categories and Cities)
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between two opened files. It can also duplicate or delete
attributes in either of the two files.

On choosing the Attribute Manager... command, the
following dialog box appears (since it has to list all the
attributes of the project, displaying the dialog box might take
some time):

On the left, the attributes of the currently opened ArchiCAD
file are shown.
On the right another file's attributes are shown. Here you can
either open a second ArchiCAD file (Project, Archive or
Module) or create a new one in a special format that belongs
to Attribute Manager.

The buttons between the two parts of the dialog box allow
you to copy attributes in either direction, delete, append or
overwrite them.

- Appending an attribute will add it to the list of the other
file under a new index.

- Overwriting an attribute will replace it with another
attribute from the other file that has the same index
number.

On top of the dialog box, the attribute types' icons represent
tab pages that display one type of attribute at a time. The last
tab shows all types of attributes in a single list.
At the bottom of the dialog box a number of buttons allow
you to perform different operations on the files:

- The Purge Unused button deletes all attributes of the
selected type that are not used by any element of the
Project.
Note: This only checks attributes that can actually be set
by the user. Unused attributes referred to in GDL Scripts of
Library Parts are considered unused and will be purged.

- The Revert button restores the attributes to their previous
state. (The Cancel button has the same effect, but also
closes the dialog box.)

- The Apply button applies the changes you have made
without closing the dialog box.

In addition, you can sort the list of attributes according to
various criteria. For example, you can display pens by line
width or cities by latitude.

In the row below the list, it is possible to partly edit the
attribute that is selected in the list.

- Layers: You can modify the visibility and locking state as
well as the name of the selected layer.
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- Layer Combinations: You can rename the selected layer
combination.

- Pens & Colors: You can modify the color, the RGB
components and the line width of the selected pen.

- Line Types: You can modify the name and the scale factor
of the selected type.

- Fills and Composite Structures: You can modify the
name of the selected item as well as its availability for
different element types.

- Materials: You can modify the color, name and texture
assignment of the selected material.

- Zone Categories: You can modify the code, color, name
and zone stamp assignment of the selected item.

- Cities: You can modify the name, latitude and longitude
values and time zone settings of the selected location.

- All: You can display all the attribute types of the current
project and sort them by types, numbers and names, or
edit the attribute that is selected in the list.

Display Options
The display of construction and drawing elements on screen
and, in some cases, on printouts can be customized for each
Project and stored along with it. These display settings can be
set in a dialog box opened with the Display Options
command from the Options menu.

The specific options available for each element type are detailed
in the introductory paragraphs of the sections dedicated to the
corresponding elements in Chapter 4: Element Creation.
The views predefined in the Navigator View Sets will store the
Display Settings that were in effect at the moment of the
creation of the view. If such a view is activated, the stored
Display Options will be applied to all open windows.

See also Chapter 13: Printing and Plotting.
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Preferences
The Preferences command in the Options menu combines
settings that are specific to the Project you are working on
with some general options that affect your entire working
environment. The descriptions below will always point out
which settings are saved with the project and which are
preserved on your computer.
The Preferences dialog box contains a pop-up menu at top
left listing each preference category (which you can also
access directly from the Preferences hierarchical menu.)
Clicking the Next and Previous buttons allows you to go
from one screen to the other.

Working Units & Levels
On the first screen of the Preferences dialog box you can
choose the unit system that will be used for your Project. This
is also where you define additional reference levels to
facilitate the input of elements at the right elevation value.

The settings you make here are specific to the Project you are
working on and are saved with it; if another user opens the
Project on his or her own computer, the same settings will be
applied.
Note that if you change the Working Units (for example from
metric to imperial), some of the other default values such as
grid spacing or default element sizes may need adjusting for
meaningful, round values.

In this dialog, you can define:
- The Length Unit system used in the Coordinate Box,

Control Box and dialog boxes.
- The number of decimals or fractions to be displayed.

- The angle unit system used in the Coordinate Box.
- The angle accuracy and number of decimals to be displayed.

Note: Surveyor’s Unit angles are measured from the North
direction (set in the Image/3D Projection Settings/
More Sun dialog box). Every other angle is measured
counterclockwise from the horizon),

- The desired decimal display of text height and rotation
angle values in dialog boxes.
Note: Text is measured in mm if the Length Unit is metric
and in points if it is feet and inches.

- Reference Level definitions (see also Elevation in Chapter
3: Project Organization and Elevation).

Note: Actual elevation values are always calculated from
Project Zero.

Dimensions
The next screen provides a mechanism for customizing and
storing different Dimensioning Standards. This is useful for
working on several Projects with differing levels of accuracy
(construction details versus site plans) or Projects being built
in countries other than those in which they are designed.
The settings you make here are specific to the Project you are
working on and are saved with it; if another user opens the
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Project on his or her own computer, the same settings will be
applied.

See Dimensions in Chapter 4: Element Creation for a detailed
description of this screen.

Calculation Units
The next screen allows you to set the units to use in Quantity
Calculations.

The settings you make here are specific to the Project you are
working on and are saved with it; if another user opens the
Project on his or her own computer, the same settings will be
applied.

These settings will affect Text format lists only: when using a
Graphic Template, the number formats defined in the
Template will override them.

See also the ArchiCAD Calculation Guide in the More
Information section of Chapter 10: Project Data Calculation
in ArchiCAD Help.

Mouse Constraints and Methods
On the next screen, you can define options that affect the
movements of the mouse.

The settings you make here are part of your working
environment customization, and will be preserved when you
close the current project and open or create another one
(except when using New and Reset and discarding all
customization).

The upper part of this dialog box provides control over the
angle pairs used for Mouse Constraint with the Shift key, and
you can set the range inside which the cursor is attracted by
element nodes and edges in the Cursor Snap Range section.

These features are described in detail in Chapter 5: Drafting
and Editing Techniques.

The Line Drawing options affect all on-screen vector
drawing operations, such as drawing walls or dragging an
element. Two drawing methods are provided to suit
individual drawing preferences.
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With the Standard (or Mac-like) drawing method:

- Click and drag the element you want to move.

- Release the button.
For multistep operations such as drawing arcs, the first vector
is entered by dragging, then the following steps are entered in
CAD-like mode as described below. If you press x, y, r, or a
in the middle of a Standard drawing operation, or if you
release the mouse button on the tool window or in the
menubar, CAD-like control will temporarily be in effect.

With the CAD-like drawing method:

- Click at the starting point.

- Move to the endpoint and click again.

Construction Elements
On the next screen, you can define options for the behavior
of different types of construction elements.

The settings you make here are specific to the Project you are
working on and are saved with it; if another user opens the

Project on his or her own computer, the same settings will be
applied.

The upper part of the dialog box allows you to define the
Line Type used for displaying construction elements on
stories other than the one they were created on. These
settings will be applied to those element types that can be
displayed on other stories than their home story (Slabs, Roofs,
Meshes, Objects). The display of Stairs is special: see the
relevant section in Chapter 4: Element Creation.

Note: This setting has no effect on the display of Ghost
Story elements.

At the bottom of the screen, you can set the general
preferences for 3D Intersection Priorities.

When Beams cross Walls or Columns, the element of lower
priority will be cut in 3D, i.e., the intersection part will be
removed. The element of higher priority will remain intact.
This applies to volume calculations as well.
The sliding control on the left defines the relationship
between Walls and Beams, and the one on the right has the
same role for Columns and Beams.

- Wall and Column priority numbers are always even and
can only be defined as a general setting.

- Beam priority numbers are always odd and can be defined
individually for every Beam in the element’s Settings
dialog box.

See also Beams in Chapter 4: Element Creation.

You can also determine how changes in Door and Window
height parameters will take effect. Recommended choices are:

- The Door/Window header height radio button with
brick/stone structures where the sill height is the dominant
value.

- The Door/Window sill height radio button with framed
structures where typically all openings are placed by their
header.
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Zones
The next screen contains controls for defining the behavior of
Related Constructions when creating Zone Lists.
The settings you make here are specific to the Project you are
working on and are saved with it; if another user opens the
Project on his or her own computer, the same settings will be
applied.

All the options of this dialog box are described in detail in the
Zones section of Chapter 4: Element Creation.

Imaging and Calculation
This dialog box provides options for rebuilding the 3D
Window, monitoring rendering progress, creating reports,
dealing with error alerts and setting the appearance of the
Calculate menu.

The settings you make here are part of your working
environment customization and will be preserved when you
close the current project and open or create another one
(except when using New and Reset and discarding all
customization).

With Auto-rebuild on, the 3D display of your plan is updated
after each modification to the floor plan as soon as you
activate the 3D Window.

With Auto-rebuild off, the 3D model does not show the
modifications until you choose the Rebuild command
(Display menu). Switching this option off can be useful if
you want to keep an already existing 3D image in the window
for a longer period, and you want to avoid accidentally
rebuilding it.

Note: If you edit elements in an outdated 3D view, deleted
elements will be visible but cannot be selected. Moved
elements can be selected, but their selection dots are
displayed at the real location and you cannot edit them.
Modified elements can be selected and edited, but this will
trigger the rebuilding of the view.

Checking the 3D Settings changes bring 3D Window to
front box means that any change you make to the 3D
Projection Settings and 3D Window Settings dialog boxes in
the Image menu will automatically activate the 3D Window
and rebuild its content.
Checking the Keep zoomed detail on Rebuild box will
preserve the last zoom made in the 3D Window even if you
choose Display/Rebuild. If you uncheck it, the 3D Window
will recreate the 3D view at the original zoom level.

If the Show Progress Window checkbox is on, the progress of
3D and list processing is indicated by a special timer. This will
help you evaluate whether to cancel lengthy 3D redraws or
calculations, change some settings (for example by selecting a
smaller area, setting more specific filters or less precise
imaging options or, reducing the 3D Window's size)
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Note: The movement of the indicator is not proportional
with the elapsed time, but with the amount of data
processed.

The state of the Interrupt with Error Messages checkbox
decides whether any possible error messages will appear on
the screen before the imaging or calculation process is
completed or at the end of the process only, in the Report
Window.

If you check the 3D Progress Sounds checkbox, ArchiCAD
will beep when the different phases of 3D processing are
complete.

With the Write Report checkbox and the sliding switch, you
can enable or disable the creation of a report about the 3D
conversion and list calculation processes and the amount of
detail it should contain. The report is more than just a list of
alerts. It can be used to keep track of, and then compare
imaging time of different images. New information is always
added to the end of the report. The Report is cleared when you
close the Project. If you wish to preserve it, save it as a text file.

The last two controls are applied to calculations only. See
Chapter 10: Project Data Calculation for their use.

Data Safety
The Data Safety dialog box contains a number of features to
minimize the risk of data loss and file corruption. This is
especially important if your power lines suffer from voltage
spikes or failures, or if your computer is prone to software
conflicts.
The settings you make here are part of your working
environment customization and will be preserved when you
close the current project and open or create another one

(except when using New and Reset and discarding all
customization).

The Autosave function controls a number of options
protecting you against losing work. If you are forced to restart
your computer for any reason, the next time you launch
ArchiCAD, a dialog box gives you the option of resuming the
interrupted work.

When Autosave is triggered, the Bulldozer cursor may
appear momentarily on the screen. Any changes made to the
Project since the last Autosave (or manual Save) are stored in
the ArchiCAD Temporary Folder. Even with large Projects,
Autosave should complete its very efficient cycle within a few
seconds.

Autosave is On by default. To turn it on manually, simply
open the Data Safety dialog box and click the Autosave On
radio button. Click the Autosave Off radio button if you’re
sure that you will not need Autosave.
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To configure the Autosave method, click either of the Save
every… radio buttons. The two options operate as follows:

- By selecting the interval-based method, you can enter a
value (measured in seconds) for the length of Autosave’s
wait cycle between saves.

- Selecting the action-based method and entering a value
triggers Autosave after you perform that number of
undoable actions in the Project.

There are three limitations to Autosave functions. The
following items must be manually saved:

- Opened Library Parts;
- Completed PhotoRendering Images;

- All types of Calculation Lists.
If ArchiCAD is restarted after a crash, it will detect the
Autosave data and prompt you to open it. This is the ONLY
way you can recover Autosaved data. If you choose not to
open it, the Autosave data will be deleted. If you do open it,
you will recover the full project content at the time of the last
Autosave, including half-completed PhotoRenderings.

The Undo Limit field allows you to set the number of
undoable steps. The default value is 20. See also the Undo
and Redo commands in Chapter 11: Menu command
reference.

As opposed to a manual save, you can still use Undo and
Redo after an Autosave.
Selecting the Backup Copy checkbox will always create a
backup copy of the previously saved version of your work, by
appending the “.bak” extension to its name. See also the
Teamwork section in Chapter 9: Collaboration and
Connectivity for creating backups of Shared Projects.

Activate the Permanent Integrity Checking checkbox to
continuously check the integrity of the data in your Project
(not just on opening and saving files). Should any of the data
in your file be corrupted, ArchiCAD will immediately try to
repair it and inform you of the result.

If Autosave is On, the Autosave Folder stores the autosaved
documents for resuming the interrupted work. You can set the
location of the Autosave folder by using the two radio
buttons:

- Use Default Location, or

- Choose Location and then Browse among folders on
your computer or across a network.

Changes to the settings of the Autosave folder will take effect
after the program is restarted.

2D Redraw Options
On the next screen, you define options for refreshing the
Floor Plan and the other 2D windows of the Project.

The settings you make here are part of your working
environment customization and will be preserved when you
close the current project and open or create another one
(except when using New and Reset and discarding all
customization).
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When you check the Save Navigator Preview data with
Project files checkbox, the saved Navigator previews will be
available when you reopen your project, allowing for faster
navigation.

With the Set model display in 2D navigation pop-up, you
can choose from three possible options for displaying project
elements during panning operations. You can show the
elements of structural elements only or the full model, or use
a complete, but simplified model (for example, hatches
become temporarily hidden). When the panning operation is
terminated, all elements are fully displayed again in all three
cases.

Checking the Optimize drawing method for high
performance display cards (i.e. OpenGL) allows you to
benefit from the speeding up of recent and powerful
OpenGL-based display cards. If you are using a less recent
model, it is recommended to uncheck this box.

The next controls are enabled or disabled by the state of this
checkbox.

With the Ignore hardware acceleration in 2D checkbox,
ArchiCAD will bypass the display card and use the system-
level software emulation of OpenGL, available both on
Windows and MacOS.
The OpenGL Settings include font smoothing, the display of
text with their outlines only, caching pictures for faster access
and pixel smoothing in Figures.
With a wide variety of OpenGL cards and driver software
available, you may experience screen refreshing errors or
slow display response. In this case, try some different settings.

Publisher
On the next screen, you can define options used by the
Publisher function, including the identification and the e-mail
address of the person who uploads the published files.

The settings you make here are part of your working
environment customization and will be preserved when you

close the current project and open or create another one
(except when using New and Reset and discarding all
customization).

See Publisher in Chapter 9: Collaboration and Connectivity
for a detailed description of this screen.

Web Options
On the next screen, you can define options related to the
Internet and HTML format.

The settings you make here are part of your working
environment customization and will be preserved when you
close the current project and open or create another one
(except when using New and Reset and discarding all
customization).

The Clear Recent URL List button deletes the list of web
pages visited through the Library Manager and Object
Settings dialog boxes.
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In the Default Web Page field, you can enter the address of
your favorite Web page.

The HTML Output Options section helps you choose a style
when saving data in HTML format, e.g., from a list type
Window.

At the bottom of the dialog box, you can choose a default
web browser in the pop-up menu.

Temporary & Cache Folders
On the next screen, you can relocate the Temporary & Cache
Folders to an additional large hard disk volume in order to
save space on the startup volume and allow for the expansion
of the Temporary & Cache Folders’ contents.

The settings you make here are part of your working
environment customization and will be preserved when you
close the current project and open or create another one (except
when using New and Reset and discarding all customization).

The Temporary Folder stores data required for the quick
operation of ArchiCAD.

The Cache Folder stores 3D projections, PhotoRendered
images and other project data. The cache data is used when
the program generates the image files automatically in the
background and stores them in the chosen Cache Folder.
ArchiCAD uses the Cache Folder for quick display and
updating of images on the screen.

- On the Macintosh, very large hard disks are recommended
for advanced imaging, because the Cache Folder can
expand to dozens of megabytes when rendering a very
complex Project with shadow casting.

- On Windows, ArchiCAD keeps this data in the virtual
memory. Set the limitation of the page file to the highest
possible value when rendering a very complex Project
with shadow casting.

When using remote network volumes, ArchiCAD’s operations
may be affected by the network performance capabilities.

Note: If your startup volume does not have the
recommended amount of free space when you launch
ArchiCAD, you will have the opportunity (through an alert
box) to select another volume during the startup process.

You can set which of your computer’s disk volumes will
house the Temporary & Cache Folders by using the
appropriate radio buttons. Using the Default Location is
recommended, but you can choose another volume with the
Browse buttons. Note that changes to the settings of the
Temporary or Cache Folder will take effect after the program
is restarted.

Dialog Boxes & Palettes
The next screen contains a number of options related to
dialog boxes and palettes.

The settings you make here are part of your working
environment customization and will be preserved when you
close the current project and open or create another one
(except when using New and Reset and discarding all
customization).



84

Chapter 6: Project and Program Customization

Graphisoft ArchiCAD User Guide

Enter a value in seconds in the Dialog Box Auto-Update
Delay edit field to update related values in dialog boxes.

If you have disabled the Startup Dialog Box when launching
ArchiCAD, you can enable it here with the Display Startup
Dialog Box checkbox.
If the Hide Locked Layers in Pop-up Palettes option is
checked, locked layers will not be shown in any of the layer
pop-up palettes. You can, of course, still see them by choosing
Options/Layers and changing their status if needed.

Checking the Show Preview Icons in Library Manager
box will enable the display of the preview images of Library
Parts in the Library Manager dialog box, helping you to
locate items by the way they look. Unchecking the box will
result in faster display of the lists.

With the Enable all information messages that can be
disabled checkbox, you can enable the appearance of alerts
and system messages that were disabled with a “do not show
this message again” type of switch.
The next section of the screen controls dialog box panels. By
default, to prevent crowding of dialogs when opening new
panels, previously opened panels will close automatically,
and the dialog box will move upwards on the screen. The
three checkboxes set options on and off.
With the Pet Palette Movement radio buttons, you can
choose whether to have the pet palette always follow your
movements when editing in the 2D or the 3D Window or to
force it to remember and jump back to a preferred position.

Miscellaneous
The last screen of the Preferences dialog box contains various
unrelated customization options.

The settings you make here are part of your working
environment customization and will be preserved when you
close the current project and open or create another one (except
when using New and Reset and discarding all customization).
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With the Fill Background Color pop-up menu, you can use
the drawing's own background color, make all fills
transparent, or use the elements’ own backgrounds chosen in
their own Tool Settings dialog boxes. This control overrides
the settings made for individual elements.

Using the Auto ID Increase checkbox, ID numbers will
automatically increase when creating a new element,
provided that a number is included in the ID field.

The Save in Multiplatform Format checkbox forces
ArchiCAD to always save the Project and its components in a
format that can be opened both in Windows and on MacOS-
based computers.

- On the Macintosh, checking this box will always append
standard file name extensions when saving files.

- By default, the Include Images in TIFF Format control
will be enabled in all Save type dialog boxes.

The Enable Drag-and-Drop checkbox controls the availability
of the Drag & Drop function.
If you check the Use ArchiCAD 7.0 Arrow Selection Area
Options box, linear elements, Circles and polygons can be
selected by including their outline in the selection rectangle.
If the Show Ghost Bounding Box of Objects and
Columns checkbox is active, the bounding box of Door,
Window, Object, Lamp and Column elements that you wish to
place will follow the cursor.

Checking the Show Element Copy Transformation
Commands in Edit Menu will add the Drag a Copy, Rotate a
Copy and Mirror a Copy commands to the menu. Otherwise,
these features can only be accessed by pressing the Ctrl key
while choosing the simple command.

The Favorite Parameters Exclusion button opens a dialog
box that controls which of the different element types'
parameters are NOT to be saved with Favorites. See Favorites
in Chapter 4: Element Creation.

The Selection Dots Default Color control allows you to
customize the color of the dots appearing on selected

individual elements. Just double-click the color box and
choose a different color from your system's picker or editor
dialog box. This setting is not effective on grouped elements
that use color-coded markers.

Workplace Customization
You can customize your working environment in many ways.
These settings are independent of the Project that you are
working on; they affect your own computer. Note that some
of this customization will be preserved even if you choose
New and Reset for starting a new project.

Window Positions
You can move or resize ArchiCAD's windows, floating
palettes, dialog boxes and the Toolbar. The last used positions
and sizes will be preserved when next opening ArchiCAD. If
you choose New and Reset, all of these settings will revert to
factory defaults, except the size of the main ArchiCAD
window (Windows only).

Floating Palette Shapes
Choosing Palette Shapes from Options/Customize opens a
dialog box in which you can set the visibility and shape of the
main floating palettes (Toolbox, Coordinate Box, Control
Box, Info Box) and, on Windows, the visibility of the Tool Tips.

See also Chapter 2: The ArchiCAD User Interface.
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Info Box Customization
Choosing Info Box from Options/Customize opens a
dialog box where you can set which items will appear in the
Info Box palette.

  

Choose a tool in the pop-up menu on top, and then define
the order of appearance of panels by dragging and dropping
them, and show or hide them by switching the appropriate
Eye icon.

The Panel Preview provides visual feedback of the
highlighted item.
With the two buttons at the bottom, you can reset the default
state for the selected tool or for all tools.

  

Tool Setting Dialog Box Customization
Choosing Settings Dialog Boxes from Options/Customize
opens a dialog box in which you can set which items will
appear in the settings dialog boxes of the different tools.
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You can choose the tools and the related panels from pop-up
lists and set them to be available and visible in the Tool
Settings dialogs.

   

With the two buttons at the bottom, you can reset the default state
for the selected tool or for all tools. You can also access the
Preferences/Dialog Boxes & Palettes screen and set some
additional options for dialog box management directly from here.

Toolbar Customization
Choosing Toolbar from Options/Customize opens a dialog
box in which you can set which items will appear in the
Toolbar (Windows only).

Select an item from the Available toolbar buttons and Add it
to or Remove it from the Current toolbar buttons list.

You can also Move the selected items up or down in the
Current toolbar buttons list, or Reset the default settings.

To show and hide the Toolbar, the Status Bar and the Toolbar
Tool Tips, right-click either bar or a blank space in the main
ArchiCAD application window.

Keyboard Shortcuts Customization
Choosing Keyboard Shortcuts from Options/Customize
opens a dialog box in which you can set which shortcut keys
will be assigned to menu commands and to most functions
accessible from palettes. Choose a menu name from the pop-
up, then select a command from the scrollable list of
commands.

 

You can create a shortcut to the selected item by defining a
character combination on the right side of the dialog box.

Confirm the defined shortcut by clicking the Assign button. If
you don’t need the selected shortcut any more, click Detach.
You can define whole Schemes of shortcuts by clicking the
Save as… button. This way, it is possible for different users
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working on the same machine to have their own favorite
shortcuts by choosing a Scheme Name in this dialog box.

Managing Add-Ons
Add-Ons are small pieces of software that add supply
additional functions to ArchiCAD. With the Add-On Manager
command of the Tools menu, you can:

- Load Add-Ons from any location. They will be loaded after
the next startup of ArchiCAD.

- Permanently remove Add-Ons while ArchiCAD is running.

- Control which Add-Ons should load automatically when
ArchiCAD is started.

- Show information about the loaded Add-Ons.
The Add-On Manager dialog box has a fixed panel – Available
Add-Ons – and two collapsible panels, Add-On Info and Edit
List of Available Add-Ons.

On the Available Add-Ons panel, you can load or unload
Add-Ons by switching the checkboxes on and off. If you see a

checkmark in front of the name of an Add-On without a box,
this means that the Add-On must always be loaded with
ArchiCAD.
The Type column refers to the type of the Add-On, which can
be Tool, GDL or Imaging.

- Tool type add-ons usually appear as menu commands.
- GDL type add-ons are not visible in the user interface.

They allow the performance of special internal operations
using the loaded Library's items.

- Imaging type add-ons add rendering or animation options
to Image menu items.

The icons in the Mode column show whether the Add-On
was loaded individually or as part of an Add-On folder set to
be available automatically at each startup.

The Add-On Info panel contains information on the interface
location and operation of the Add-On selected in the first
panel.

Some Add-Ons have built-in definitions for the menu
locations of their commands. You may wish to override these
definitions and set these commands to appear in the Extras
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menu. You can do so by clicking the Custom Settings button
and changing the Add-On command's location with the
appropriate radio button.

In the Edit List of Available Add-Ons panel, you can search
for more Add-Ons, remove items from the list and redefine
the location of the dedicated Add-On folder.

The Use designated add-ons folder checkbox will activate
the folder enabled by default (the Add-Ons folder in your
ArchiCAD folder) or another dedicated folder that you can
choose with the Change button by browsing your computer.
If you are using such a designated folder, the add-ons made
available from this folder cannot be removed from the list of
available add-ons. However, they can be unloaded manually

for the current ArchiCAD session. In this case, the rest of the
add-ons which are still loaded from this folder will appear as
individual add-ons in the Mode column.

If you load an Add-On that has the same name and ID as a
loaded one, it will replace the previous one.

- All settings of the Add-On Manager will be preserved
when you quit and restart the program, even if you choose
New and Reset.

- If you open a Project that refers to currently unloaded
Add-Ons, an alert will appear, listing the missing Add-Ons.

- Some of the Add-Ons cannot be loaded until you restart
the program, as they contain references to the project
database. If loading such Add-Ons with the Add-On
Manager, an alert will appear. If current modifications do
not concern these Add-Ons, you can ignore the alert or
choose to save the recent changes and reload the Project
with the required loaded Add-Ons.

Customization Summary
Project-specific settings saved with both ArchiCAD
Project files and in the local Preferences files:

- Publisher settings;

- Find & Select criteria;
- Magic Wand Settings;

- Floor Plan Scale;

- Display Options;

- Grid & Background;
- All attributes: Layers & Layer Combinations, Pens & Colors,

Line Types, Fill Types, Composites, Materials, Zone
Categories,

- Some of the Preferences screen settings: Working Units &
Levels, Dimensions, Calculation Units, Construction
Elements, Zones;

- 3D Projection Settings, including Cities;
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- 3D Window Settings;
- PhotoRendering Settings;

- Home View definition;
- Favorites.

Settings specific to your working environment, saved
only in the local Preferences files:

- Window, dialog box and palette shapes and positions;
- Status Bar and Toolbar settings;

- Recent File List;
- Plotter and Printer settings;

- Some of the Preferences screen settings: Mouse Constrains
& Methods, Imaging & Calculation, Data Safety, 2D
Redraw Options, Publisher. Web Options, Temporary &
Cache Folders, Dialog Boxes & Palettes, Miscellaneous;

- Menu Shortcut Key customization;

- Add-On Manager settings.
Note: On Windows and MacOS X there can be more than
one user at a computer and each user will have his or her
own preferences files. ArchiCAD always uses the current
user’s latest preferences.

In Teamwork, settings specific to the user, saved in the
user-specific Preferences files:

- default tool settings;
- zoom level;

- Publisher settings;
- Find & Select criteria;

- Magic Wand Settings;
- Floor Plan Scale;

- Display Options;

- Grid & Background;
- lock & visibility state of Layers;

- Layer Combinations;
- 3D Projection Settings (including Cities);

- 3D Window Settings;
- PhotoRendering Settings;

- Cities;
- Home Zoom definition;

- Favorites.

Transferring Settings between Projects
The Attribute Manager command from the Options menu
(described earlier in this chapter) allows you to transfer
between Projects all types of attributes (Layers & Layer
Combinations, Pens & Colors, Line Types, Fill Types,
Composites, Materials, Zone Categories). You can also export
and import Attribute Manager (*.aat) files that contain no
graphic data.

You can also export and import Favorites (*.prf) files
containing your preferred default tool settings.

Transferring Settings between Users and
Computers
You can define the storage location of the Preferences files.
On Windows, this is done in the Registry, while on MacOS,
they are placed by default in the System Folder/Preferences
Folder. The Preferences files belonging to the same ArchiCAD
version (national version and license type) can be transferred
to another computer using the same operating system.
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Chapter 7
Library Management
Libraries contain the external files used by ArchiCAD or referred to by construction elements. This chapter covers the library
management process in detail.

ArchiCAD Libraries
Libraries are folders that contain any number of files of
different types recognized by ArchiCAD. Some of the library
type files contain geometric data that allows you to place
instances of the given item into the ArchiCAD Project, while
others only contain graphic or text information that can be
attached to other library items or to the entire Project.

Library Contents
Libraries contain geometric library parts collectively called
GDL Objects. They can be placed in the Project by one of
ArchiCAD's dedicated tools (Object, Lamp, Door, Window,
Skylight, Corner Window, Stair), automatically by specific
commands or Add-Ons (Markers, Labels, structural Grid,
RoofMaker and TrussMaker elements), or only used as a
reference by other elements (macros, Zone stamps, Property
Objects).

All of these files can be opened in ArchiCAD with the Open
Object command and they can be created in ArchiCAD with
the New Object command. For details, see Chapter 8:
Working with GDL Objects .

The Library also contains files of different formats that are
referred to by ArchiCAD elements:

- Listing Templates are plain text files that are used to
customize the content and the look of quantity
calculations. See the ArchiCAD Calculation Guide.

- Textures are picture files that can be attached to
Materials to provide added realism in rendered views.

- Background images are also picture files used to insert
the 3D model in a lifelike environment.

Library Usage
Libraries are made available to ArchiCAD through the File/
Library Manager… command.

- When you start ArchiCAD for the very first time, by default
it looks for a library named "ArchiCAD Library."

- You can define different or additional libraries for your
Projects in the Library Manager dialog box. When
opening a saved Project, ArchiCAD looks for the libraries
that were last defined for it.

- When creating a new Project with the latest settings,
ArchiCAD will keep (or look for) the last used library.

- When creating a new Project with default settings,
ArchiCAD will again look for your default "ArchiCAD
Library."

Startup Library
When you start ArchiCAD for the very first time, it searches
for a Library under the name “ArchiCAD Library."
If ArchiCAD’s default Library is found on the hard disk in the
same folder/directory as ArchiCAD, it is opened and used as
the Active Library. Otherwise, the Library Manager dialog
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box appears, prompting you to choose a folder/directory to
be the startup Library.

- If you have already used ArchiCAD and start the program
by double-clicking its program icon, the Library set used in
the previous session will be active.

- If you have modified the name of a folder/directory in the
active Library set, or changed its location in the file
hierarchy, it will not be found and the Library Manager
dialog box will be displayed.

- When you open a Project from within ArchiCAD (with the
Open... command), or by double-clicking a Project file in
the Finder or Desktop, it is opened with the Library set it
was originally created with.

If you have modified the name of a folder or directory in the
Active Library set, or changed its location in the file hierarchy,
the Project opens using one of the following protocols:

- If the currently Active Library set includes folders with the
same names as the original ones, the Project is opened
using this current Library set.

- If the original Library set included folders with names
different from those in the current one, ArchiCAD will try
to find Libraries with the same names in the folder or
directory of the Project. If there are folders with those
names, the Project is opened with them.

- If there are no folders bearing the original names, the
Library Manager dialog box is displayed. You can either
specify a Library set to be used with the Project or Cancel
reading altogether.

Note: If you click Done, the Project is opened without a
Library. All Library Parts placed in the file will then be
missing.

The Library Manager Dialog Box
Normally, library elements are arranged hierarchically within
the main Library folder/directory.
You can use specialized Libraries for different applications
(e.g., residential Projects and industrial building design) to
avoid the need for extremely large Libraries. There are also
different Libraries corresponding to different national
standards.
The Library Manager command in the File menu makes
allows access to complete Libraries and individual Library
Parts, both from local volumes and through the Internet.
At startup, ArchiCAD automatically loads the standard Library
provided with the program. In the course of your work, you
may need additional Library Parts or set up your own user
libraries. Typically, each Project file uses a different library
including all the external files it refers to (objects, doors,
windows, lamps, textures, property data, etc.).

The Library Manager dialog box has four tab pages:
- The Local/LAN tab page allows you to manage complete

Libraries and individual Library Parts stored on local disks
or on remote volumes connected to your computer
through a local area network.

- Using the FTP Sites tab page, you can add Libraries and
single Library Parts stored on FTP servers.

- The History tab page lists all the Libraries and Library
Parts loaded while using ArchiCAD.

- The Web Objects tab page allows you to download GDL
Objects from websites and to add them to your local
Libraries.

Local/LAN
On choosing Library Manager, the Local/LAN tab page is
displayed by default.
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On the left-hand side of the dialog box, a tree view of your
computer's file system is displayed, together with the names
of the mounted volumes of your local network. Clicking the
Add button below the path name allows you to add the
selected items to the Active Libraries listed on the right, under
Local Libraries. You can also drag and drop folders or files
from one list to the other.

Note: You can load archive files (.pla) with the Library
Manager. In this case all library parts within the archive
will be available in your project file. Please note that you
cannot modify the scripts of these objects. You have to
extract them from the archive before editing.

- If you highlight the name of a local library folder, the Path
field displays the complete location of the folder in the file
system or in the local area network.

- If you highlight the name of any single item (folder or
individual item) listed in the Active Libraries list, it
immediately appears in the tree view on the left.

- Clicking the Remove button allows you to remove
selected items from the Active Libraries list. You can also
remove items by dragging them out of this area.

Next to the pop-up menu, the Folder up button  helps
you navigate. The Refresh button  can be used to display
changes in the contents of a folder or when changing disks in
a CD-ROM, Zip or floppy drive.

Clicking the Library Cache Settings… button opens a
subdialog box. In the top section of this dialog box, the Use a
Local Copy (Satellite) checkbox allows you to specify a
location for a local copy of the library set used for your
project. This is especially useful when working on a shared
Project. See Teamwork in Chapter 9: Collaboration and
Connectivity.

Note: You can enable or disable Library Part preview icons
in the Options/Preferences/Miscellaneous dialog box.
Making the checkbox inactive will result in faster folder
display.
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FTP Sites
Clicking the FTP Sites tab page changes the appearance of
the left-hand side of the Library Manager dialog box.

To access an FTP server, you need to enter the necessary data
in the Server Properties area, including the host's name and
the user name and the password you have been assigned to
enter the site.

Note: On the MacOS, only servers using "active FTP" can
be connected because of the limitation of the relevant
system library. You can connect to the same FTP servers as
with Netscape Navigator.

The list of specified FTP servers is in the window on the left.
When you select one, it appears in the Look in pop-up
menu. Click the Log In button and you will then see the tree
view of the server's file system in the window on the left. Next
to the pop-up menu, the Folder up and Refresh buttons
have the same function as on the Local Libraries tab page. The
Stop  button has the same function as in Web browser

applications: use it when you feel that connection conditions
are not optimal. Click the Remove host button to remove
selected servers from the list of FTP sites.
Select a library folder or a Library Part and click the Add
button. Its name will appear under the FTP Libraries item in
the Active Libraries list on the right. Click the Remove button
to clear Libraries that are no longer needed.

Check the Save box if you want ArchiCAD to remember your
password the next time you log in.

Note: The FTP protocol uses plain passwords over the
network, which offers little security. ArchiCAD, however,
will encode your passwords before storing them in the
preferences file (Network Settings.prf).

If you click the Library Cache Settings button, the same
subdialog box appears as for the local cache Library. In the
bottom part of that dialog box, you can specify a location for
the internet cache Library. The elements you have downloaded
from the FTP server will be stored in this location, allowing you
to access them quickly.

Note: When downloading Library Parts from an FTP
server, make sure to also copy the files they refer to (for
example macros and textures).

History
Clicking the History tab of the Library Manager dialog box
displays the list of Library folders and single Library Parts
recently accessed from the Library Manager.
If you highlight an item, its location is displayed in the Path
field. You can then choose to add it to the set of current
Libraries. You can clear single items or the entire list.

Note: The clearing of history items is instantaneous. You
cannot undo it by clicking the Cancel button.
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Web Objects
The last tab page of the Library Manager allows you to
download GDL Objects from the Web through the GDL Web
Control. Note that the following description is only valid if this
plug-in has been correctly installed in your web browser's
plug-ins folder.

The pop-up menu next to the Browse button allows you to
choose from recent URLs that you have accessed. If you have
not yet downloaded any objects, the name of the default Web
page set in Preferences/Web Options appears.

When you choose a URL, your default Web browser is
automatically started. You can then navigate the Web looking
for GDL Objects.

On the site containing GDL Objects, choose the one that best
suits your needs, and right-click on it (Windows) or click on it
while holding the Ctrl key down (MacOS). Choose Save
Object… from the context menu that is displayed.

Select a folder to store your downloaded objects in. If you
check the Load into GDL Library box, the object will be
added to your active library set after downloading (this
checkbox is only active if ArchiCAD is running).

You can see the details of the downloaded file's original
location on the left: file name, download date and time and
complete URL. If you select an item here, the right-hand side
of the dialog box shows a preview of your object, with its
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name, location in the file system, size and creation date and
time.

 

Objects downloaded from the Web can be used just like any
other object, with the advantage of being updated with any
changes made to the object on the website.
Objects placed from the Web browser, from the Objects
Settings dialog box or through Drag & Drop also appear in
the Web Objects tab page.

Note: If you click the Clear HTTP Cache button in the
Library Cache Settings dialog box, old web objects will
be cleared from your HTTP cache. On Windows, the cache
is the same as that used by Microsoft Internet Explorer.

Loading Libraries
When you have finished making your library choices on the
tab pages, click the Done / Reload button in the bottom right
corner of the Library Manager dialog box.

A status box will appear on the screen to inform you about
the loading process. By clicking Stop, you can abort loading
the libraries.

When starting a new Project, you can also use the Library
Manager dialog box to check which libraries are currently
used, and then either click the Use Active Libraries button
to continue working with the current set, or define a new
library set as described above.

Note: When working on a shared Project (Teamwork)
only the Team Leader with exclusive access can define the
libraries to be loaded for the Team Project. Teammates can
load other libraries, but only for their own local use.

Moving Library Parts
Individual items from libraries other than the libraries in the
active Library set can be used in your Projects via the Load
Other Object (Window, Door, etc.) commands in the
corresponding tool Settings dialog boxes. Placing objects into
your Project this way does not result in the items being added
to the active Library.
You can also use the drag & drop feature of ArchiCAD to
move Library Parts.

Libraries & the Archive File Format
When you open an Archive Project, a special Library is
created comprising all the Library Parts and properties used
with that Project. Whenever you open this document type, a
dialog box is displayed requesting that you provide a name
for this special Library. This Library then becomes the Active
Library.

Note: If any Library Parts were missing from the current
Library when you saved the Archive document, those
Library Parts will be missing from the Archive, too, even if
the reference names of these items are included.

See also the description of the Archive format in the Save as…
section of Chapter 11: Menu Command Reference.
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Missing Library Parts and the Status
Report Palette
The Status Report Floating Palette shows you the names of the
Library Part files that present problems and the download
status of web objects.

The Palette automatically appears when opening a Project
whose library set is not fully loaded, or you can display it by
choosing Show Status Report Palette in the Window/
Floating Palettes hierarchical menu.

The Palette has two states: compressed and extended. The
extended form is the default setting.
Clicking the arrow top left expands the Palette. It has two tab
pages: Missing/Doubles and Download.
The Missing/Doubles tab page provides the list of Library
Parts missing from your Project, followed by the list of Library
Parts that have identical names.
On top, next to the folder icon , the number of the
problematic items is shown.

The three buttons in the middle of the dialog box allow you
to:

- Copy this list to the clipboard;
- Print this list;

- Save this list to a text file for reference.
Clicking the Library Manager button at bottom left will take
you to the Library Manager dialog box, where you can
locate missing libraries and update the loaded library list in
order to resolve problems.

The Download tab page lists the Library Parts and folders that
you have downloaded either through the Library Manager's
FTP Sites or Web Objects tab pages or through drag & drop
into the Project.

The icons representing the three download states are:

 - download in progress;
 - download completed;

 - download failed.
In the Palette's compressed state, only the number of the
problematic and downloaded items is shown in the header.
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Chapter 8
Working with GDL Objects
This chapter deals with the creation and editing of GDL (Geometric Description Language) Objects stored in outside files,
including Doors, Windows, Lamps and general Objects, as well as calculation database components such as Zone Stamps and
Property Objects.

GDL Objects
GDL (Geometric Description Language) Object is a generic
name for all types of elements that can be placed inside or
outside a building’s structure, for instance pieces of furniture,
office and computer equipment, sanitary ware or even special
structural elements.
From the technical point of view, GDL Objects are separate
files stored in external libraries. Each GDL Object can include
a scale-sensitive symbol representing it in floor plan view, a
set of parameters defining the possible variations of the
product family and a 3D script describing the complex
geometry of the element. The 3D view of the GDL Object is
generated from the 3D script that takes into account the
parameter choices made by the user.
Some GDL Objects do not contain any geometric data. For
example, macros are text-only files that other Objects can
refer to, without needing to include the same script in all of
these Object files, while Property Objects contain descriptive
data only that is used to calculate element quantities.
GDL Objects can be used several times on the same Project,
or even simultaneously by multiple Projects, from multiple
computers. There are several library browsing options
available in the corresponding tools’ Settings dialog box.
Their description is given in the relevant sections of Chapter
4: Element Creation.

Note: Loading the total content of the ArchiCAD Library
uses considerable space on your hard disk. If you know in
advance what type of GDL Object you will need for your
project, it is advisable to load only the folders you need. In
that case, make sure that the Macro folder to which the
loaded elements can refer to is also loaded.

GDL Object Sources
You can find GDL Objects in many locations and obtain them
from a variety of sources.

- First, look at the default ArchiCAD Library included with
your package. Study all the possibilities before you start:
you will discover Library Parts you never thought of using
before.

- Graphisoft publishes several specialized complementary
libraries. Consult your dealer for more information.

- On the Internet, you will find a growing number of
websites dedicated to GDL Objects, such as the GDL
Central (www.gdlcentral.com) or Objects On Line
(www.objectsonline). The Graphisoft website
(www.graphisoft.com) contains a directory of such
locations. In addition, the GDL Web Control allows you to
visualize GDL Objects in your web browser and download
them directly into your ArchiCAD Project.

- There are a number of third party programs or Add-Ons
that can create or edit GDL Objects. These objects contain
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GDL scripts as well as other, application dependent data.
Consult your dealer for availability information.

- DXF libraries are widespread in the CAD world and cover
almost every area of engineering and design. Many
manufacturers offer symbols or models of their products in
DXF format. ArchiCAD can easily import these libraries.

In some cases, you will need elements not found in any
library. You have a variety of choices:

- Sculpting in other 3D applications.
ArchiCAD can import any 3D model you create, such as
those using Zoom or Alias Wavefront. These applications
are multipurpose 3D modelers allowing shapes of free
geometry.

- Sculpting with ArchiCAD’s own 3D tools.
Walls, Slabs, Roofs and other ArchiCAD construction
elements can be used as custom building blocks,
regardless of their originally intended purpose. You can,
for example, model a table easily by using Walls and Slabs.
Solid Element Operations will also assist you in the
creation of special shapes. You can then save such
structures as GDL Objects to be handled as single
construction units, making them available for repeated use
in other Projects as well.

Tracery of a Gothic window modeled with slabs and roofs

- GDL Scripting.
If you want to go beyond all of the above possibilities, or
if you need Library Parts for which the shape can be
controlled with user-definable parameters, your next

option is to use GDL and the scripting environment
offered by ArchiCAD. The Graphisoft GDL Reference
Manual will help you learn to apply ArchiCAD’s powerful
Geometric Description Language for dressing up your
Project with objects, ornaments and other details of your
own design.

To create a new GDL Object in ArchiCAD, choose the File/
GDL Objects/New Object command. All the commands and
controls available for creating new Objects are explained
below, in the section on Creating and Editing Objects.

Object Making with ArchiCAD, written by leading GDL
expert David Nicholson-Cole and published by Graphisoft,
provides a easy to follow introduction into Library Part
creation with and without GDL.

GDL Object Subtypes
All GDL Objects have a subtype, organized in a tree hierarchy
based on the IFC (Industrial Foundation Classes) entity
structure. Subtypes allow you to organize your library parts
into a logical system. Add-Ons also use subtypes to identify
their corresponding library parts.

ArchiCAD subtypes are controlled by subtype object
templates. When you create a new GDL Object, ArchiCAD
will allow you to choose one of the available subtypes for
your element.
Each subtype has a set of compulsory parameters that define
the behavior or functionality of the elements that belong to it.

Some of the subtypes include additional features called
handlers. These define whether the elements that belong to
the subtype can be accessed as general objects by clicking the
Object tool's icon and choosing them in the Object Settings
dialog box, or as specific objects that either have their own
tool icon in the Toolbox (for example Door, Window, Corner
Window, Skylight, Label, Stair) or are placed by special
commands or functions (for example Zone stamps,
RoofMaker objects, Accessory objects, etc.).
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Accessing GDL Objects
If you have a correctly loaded library in ArchiCAD, you can
access its placeable elements in two ways:

- Click the appropriate tool's icon in the Toolbox and open
its settings dialog box. This dialog box contains a browser
area, in which you can choose an element (Object, Lamp,
Stair, Door, Window, Corner Window, Skylight), configure
its settings to best suit your needs and then place this
configured instance in your Project. Each placed instance
can be different, taking into account the given subtype's
specialities and restrictions. The external file is not affected
in any way by the changes you make in the Object (Lamp,
Door, etc.) Settings dialog box.

See Chapter 4: Element Creation for more information on
configuring GDL Object instances.

- Choose the Open Object command in the File menu and
select the GDL Object you wish to edit in the directory
dialog box. You can modify the GDL Object with the
editing controls that will be described in the next sections.
In this case, you will be working on the external file itself,
not on a placed instance, which means that the changes
you make to the external file will affect all of the placed
instances of the given GDL Object.

Parametrics
The parametric nature of GDL Objects makes this format ideal
for representing an entire line of products including variations
in color, style or complexity.

The compact size of this format also makes it the perfect
choice for publication through the internet. The free,
downloadable GDL Web Control allows users to connect to
manufacturer websites and view the latest variations of the
product line. Product catalogs can be easily updated from CD-
ROMs or through an intranet.

 

Applying Parameters
You can customize many GDL Object parameters in its tool
settings dialog box before placing it in the Project. Placed
Objects can also be selected and their parameters modified.

Any Object's basic parameters are its Length and Width
dimensions, called A and B in the parameter list. For example,
if you set different values for A and B for a Round Table, you
will get an elliptic table.
You can customize other dimension parameters. In the case of
the table, these include the overall height, the thickness of the
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table top, or the height or thickness of the frame below the
table top.

 

                     

You will notice that some parameters interact with each other.

In the example of the table, you cannot change the number of
its legs, which will always be 4. The Leg Number parameter
field is grayed.

On the other hand, if the table is round, the Leg Number
parameter becomes active, and you can choose to have a
table with one, three or four legs.

                     

The number of legs can have an effect on the available leg
types. These can either be set with a pop-up in the Parameter
list, or picked from the Custom Settings panel of the object.

While most of the parameter changes are most spectacular in
the 3D view of the GDL Object, there are some special cases
which affect the plan view only.

The Minimal Space checkbox (included with many Objects
from the default ArchiCAD Library) adds a hatching to the
element's Plan Symbol. This represents the area that you want
to keep free of any other Object.

Even the smaller details of Objects can be customized. For the
Cab Sink element below, you can choose among many
different tap and sink types.

          

For the W1 Casement window element, you can experiment
with different internal division numbers.

      

Shutter styles can be picked in the Custom Settings panel.
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The shutters will be added to both sides of the window.

            

Using Objects in 2D and 3D
Some complex elements may take a long time to display in
fully detailed 3D. A good example for this is realistic trees and
other plants that consist of a very large number of polygons.

In the default ArchiCAD Library, you can find different
representations for the same type of Object according to
usage. Plants, People and Vehicles can be found both in the
2D Elements and the Visualization folders.

- The People and Plants in the 2D Elements folder are
shown in elevation view and are meant to be placed in
Section/Elevation windows. Using these simple
representations saves time. Vehicles are also 2D only
elements, but they have two or more representations, a
top view for the Floor Plan and side, front and/or rear
views for Sections/Elevations. A switch in the Parameter
list allows you to choose between them.

    

The counterparts of these elements in the Visualization
folder are full 3D representations meant to appear in the 3D
Window and especially in PhotoRendered pictures.
The Visualization folder also contains a couple of Picture
elements used for texture mapping. They are displayed as
simple fills in shaded views and only appear in photo-
renderings. If you place and make active a Camera, the
picture will always face this camera to avoid distortion.
Many elements can have a different appearance in either 2D
or 3D view. In Floor Plan view, the degree of detail can be set
to depend on the current Floor Plan Scale defined for the
Project.

   

Creating and Editing Objects
The creation of new Objects and the modification of existing
ones is handled in a single environment: the GDL Object
Master Window. In this window, you can add or edit the
Parameters, Components, Descriptors, Scripts and the
2D Symbol of the GDL Object.
The GDL Object Master Window is accessed from the File
menu under GDL Objects/New Object and Open Object.
To create a new GDL Object, choose File/GDL Objects/New
Object. The Master Window is immediately displayed.
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To open a GDL Object, choose File/GDL Objects/Open
Object. This will open a directory dialog box in which you
can browse all accessible volumes.

To show only the elements of one of your loaded libraries,
click the arrow next to the Go to Library control and choose
one of your current libraries. Use the Files of type field to
display GDL Objects by file format.
Select a file and click the Open button. The Master Window
will open with the preview and the defined parameters of the
selected Object.

Each GDL Object has its own Master Window whose
appearance depends on the Object's subtype. Any number of
GDL Object Master Windows can be open at the same time.

To locate an element by subtype, choose File/GDL Objects/
Open Object by Subtype to open the Subtype Hierarchy
dialog box.
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If you select an item here, you can review its Properties in
the bottom section and click the Open button to directly open
that item's Master Window.
The item's names are color-coded.

- Green indicates that the item is placeable.
- Black indicates that the item cannot be placed on its own

and can be only used as a macro reference.
- Bold type indicates that the item is a subtype template.

Master Window Controls
All controls needed to edit a GDL Object are present in the
Master Window.

- The Preview area at top left shows the viewing choices
that resemble those available from the tool settings dialog
box: 2D Symbol (drawing), 2D Full View, Elevation,
Hidden Line, Shading, Preview Picture. Just like in tool
settings, the Elevation, Hidden Line and Shading views can
be rotated by clicking inside the preview.

- Below the preview, the 2D Fragment switchboard
shows the currently active elements of the 2D Symbol. See
details later.

- You can assign Parameters to your Object by clicking the
corresponding button on the left. The next controls are
only shown if the Parameters button is active; they are
hidden if you have clicked the Components or
Descriptors button or displayed any of the Scripts inside
the Master Window.

- On top, the subtype of the open object is shown. You can
change an object's subtype by clicking the Select
Subtype… button which will open the Subtype
Hierarchy dialog box shown earlier. Changing the
Object's subtype modifies its behavior and adds the
parameters and functionality needed for the new subtype.
For example, you can change a plain object into a light
source by changing its subtype to Light.

- If you check the Template box, you can create a new
subtype template. The new template will appear in the
Subject Hierarchy dialog box and any new Objects that
you associate to this subtype will take on all of the
parameters of the subtype.

- If you uncheck the Placeable box, the Object will behave
as a macro. This means that you will not able to place it
directly in the Project, but you can refer to its scripts from
other Objects. This type of Object does not appear in any
of the tool settings dialog boxes.
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- A series of Components and Descriptors can be
assigned to each GDL Object, defining its composition for
use in listing and calculation features. Clicking one of
these buttons changes the right-hand side of the dialog
box into an appropriate editor and hides some of the
controls described above. For details about Component
and Descriptor editing, see the ArchiCAD Calculation
Guide in the More Information section of Chapter 10:
Project Data Calculation in ArchiCAD Help.

- The Script buttons on the right allow you to program your
GDL Object. If you click the button itself, editing will take
place inside the Master Window, while clicking the
window icon next to the script's name will open a separate
window for entering or modifying the script. See GDL
Scripts below.

- At bottom left, the 2D Symbol, 2D Full View, 3D View
and Preview Picture window icons allow you to open the
corresponding views of the GDL Object. Note that they can
be displayed at small size in the Preview area at top left.

When closing the master window, a prompt warns you to
save changes. All the components of your item will be saved
with it.
You can also save your item using the Save or Save as...
commands from any of the library item's windows. After saving,
you can choose the Rebuild command (Display menu) for the
Floor Plan or 3D window to view the modified GDL Object.

Parameters
If the Parameters button is active on the left, you can add and
edit parameters for the GDL Object in the right-hand part of
the dialog box. You assign values to these variables in order
to define the attributes of a particular GDL Object. The values
assigned here will be the default values found in the Settings
dialog box when you choose a tool that uses GDL Objects.
These locally defined Parameters can also be called by the
different Scripts of the Object.

The parameters that appear in blue are the obligatory
parameters that belong to the edited Object's subtype.

Some examples of obligatory parameters:
- x and z dimensions for Windows and Doors;

- x and y dimensions for Objects;
- x and y dimensions, on/off selection, color components

and intensity for Lamps.
The variables that represent a given parameter are always the
same.

The list of optional parameters (below the obligatory
parameters) are available for use in the Object's GDL
description. The values specified for them will become the
default additional values displayed when you open the
appropriate Settings dialog box from the Toolbox.

The optional parameters are typically used to define such
things as the number of window panes or door panels, the
usual materials of a part, etc.
New parameters can be created by pressing the New button
at the top of the Master Window. Remove existing parameters
by selecting them in the list then pressing Delete next to the
New button.

Each parameter in the list can be edited in its own row. Each
line consists of an icon (required), the parameter letter or a
string variable, a descriptive text (optional, but
recommended) and a numeric value.
Highlight the row you wish to edit. For obligatory parameters,
only the numerical value after the “=” sign is editable. For
optional parameters you can edit the type icon, the
descriptive text and the numerical value.

The icons control how the values are interpreted by
ArchiCAD. Clicking an icon displays a dialog box where you
can redefine the parameter’s type by choosing another icon.
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The parameter types (identical for obligatory and optional
parameters) are the following:

 Length: specifies physical dimensions of the GDL Object
(and makes conversions to whatever units you are using.)

 Angle: specifies angular values in decimal degrees for
such GDL operations as rotation transformations and
defining arcs.

 Real Number: specifies decimal non-dimensional
values for uses like including a magnification factor in a
GDL calculation.

 Integer: specifies whole numbers, dimensionless
values for uses like defining the number of identical
components in a GDL description or the number of times
to loop through a part of the GDL Script.

 Boolean: the value of a Boolean parameter can only be
1 or 0 for uses like activating or deactivating an action or
an item in a GDL Object. These values can either be typed
directly into the value box, or set by clicking the checkbox
at the right end of the parameter line.

 Text: specifies character strings up to 255 characters for
uses like defining changes in the GDL Object or typing plain
words instead of numbers in the parameter’s value box.

 Material: Specifies a material as a GDL parameter.

 Line Type: specifies a line type as a GDL parameter.

 Fill Pattern: specifies a fill pattern as a GDL parameter.

 Pen Color: specifies a pen color as a GDL parameter.

Note: If any of the Material, Line, Fill Pattern or Pen Color
parameter types is selected, a button appears at the right end
of the parameter line where you can bring up a pop-up list
of corresponding settings. Any of the attributes currently
available to ArchiCAD can be chosen. See Chapter 6: Project
and Program Customization for details about attributes.

Proper parameter type specifications are especially important
when, for example, you are working with feet and inches,
which only the Length type parameter will accept. Incorrect
use of a specification can also result in misinterpretation of
non-dimensional parameters (i.e., angles or number of
pieces).

Note: Depending on how you write your GDL
descriptions, the parameters you use can affect both the
2D and 3D aspects of the Library Part.

Parameter Types include two further options: Separator 
and Title . These are virtual parameters as they are only
used to make the Parameter List more organized and easier to
view.

To further organize and format the parameter list, use any of
the three list formatting icons,  visible only when a
list item is highlighted.

- Pressing the first icon, Hide Parameter, will remove the
highlighted parameter from the Parameters panel in the
Object Settings dialog box.

- The second tool, Subordinate, will create a hierarchy
among parameters. When a parameter is ordered under
another one, the subordinate parameters appear in a
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sublist within the parameter list of the Object Settings
dialog box. The sublist can be opened and closed by
pressing the small triangle next to the superior parameter.
The superior parameter can be of any type; however, a
Title type parameter cannot be subordinated.

- Pressing the third icon, Bold, will make the parameter
name appear in bold type.

You can restrict the possible values of a parameter by defining
an array or matrix.

When you highlight a list item in the parameter list, a new
button  appears next to the Type icon. Pressing this
button opens the Array Values dialog box.

Note: Once array values have been defined for a parameter,
the Array Values dialog box can only be opened by
pressing the Set button at the top of the Master Window.

In this dialog box, you can define the possible values for that
parameter. Edit the fields of the array by clicking on them and
enter the value in the right side of the dialog box. Where variable
types allow, you can choose values from a pop-up menu.

You can insert or delete rows by selecting the button with the
row number of the array on the left of the dialog box, and
pressing the Insert or Delete button respectively.

For more information on parameters, see the GDL Reference
Manual that is part of your ArchiCAD package.

Details
If you press the Details… button at the top of the Master
Window, a dialog box appears with options specific to the
Library Part type.

The Details dialog box for the  Object, Lamp, Label and
Zone types concerns item (instance) sizes.

Use the Object Instance Sizes radio buttons to set how you
want your placed objects (object instances) to store their
parameter values. Press the Store the ratio of current/
default A/B sizes radio button for placed objects to
proportionally follow any changes in default A and/or B sizes.
If you choose the Store fixed values option, objects already
placed in the project will not change when their default A/B
values are later changed.
Where applicable, the Hotspot on bounding box checkbox
will appear in the Library Part dialog box. If you mark this
checkbox, ArchiCAD will associate five hotspots with the 2D
symbol of the Library Part that are independent of hotspots
defined in the part’s GDL script. These five hotspots will be
located at the four corners and at the center of the symbol’s
bounding box (the imaginary rectangle which circumscribes
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the symbol). The default hotspot used for placement of the
object on your Project will be the lower left one of the five.
(This is indicated by a heavy square highlighting the hotspots
on the 2D symbol in the Tool Settings dialog for the Library
Part, where you can change the active hotspot.) This will
happen regardless of whether you have explicitly defined
hotspots in the Library Part’s GDL script.
If you do not want the lower left corner of the bounding box
to be the default hotspot, leave the checkbox unmarked and
write the required hotspot(s) into the GDL script. In this case,
the default will be the first hotspot encountered in the script.

If neither bounding box nor GDL hotspots are specified,
ArchiCAD will place a single hotspot at the origin of the
Library Part and use this as the default. (This origin is at the
midpoint of a window or door and at the arbitrarily located
coordinate origin of a lamp or object.)

The Fit Size to 2D Drawing button is available only for
Objects, Lamps and Zones. It inserts the current size of the 2D
symbol bounding box on the symbol editing window into this
dialog box, making these sizes the default values for the object.
For Doors and Windows, some special options are available
in the Details dialog box.

In the Nominal Frame Thickness, Parapet Wall Inset and
Opening Oversizing edit fields you can enter real numbers
or parametric GDL expressions to define the geometric
relationship between the wall opening and the Door or
Window.

The radio buttons and edit fields in the Orientation
Displaying section of the Details dialog box allow you to
define the way the opening’s orientation is displayed.

The following figure shows the 3D appearance of some
openings with the Contour option chosen. The outline of the
rectangular opening created by ArchiCAD is visible, and the
shape of the complementary pieces used in the Library Part to
create the modified opening is apparent.

With the No contour option active , these
complementary pieces are integrated into the body of the
wall, as shown in the following figure.

The Framing on Plan buttons and the edit fields work just as
they do in the Door/Window Settings dialog boxes. See
Doors and Windows in Chapter 4: Element Creation.
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GDL Scripts
Under the Parameters/Components/Descriptors buttons,
a second set of buttons and window icons represent the
Library Part’s different Script Windows.

You can either click a button and see the script appear in the
right-hand side of the dialog box, or click a window icon to
open the corresponding script in a separate window.

- The Master Script will be executed each time any of the
other scripts are executed. The primary benefit of this script
is that you can globally define variables or operations, or
access external data before executing other Scripts.

- In the 2D Script window, you can create a parametric 2D
symbol using the transformations and elements available
for the two-dimensional space in GDL. This script will be
used to generate the 2D Full View of the Object.

- In the 3D Script window, you can find and edit the 3D
description of the GDL Object. The script will be used to
generate the 3D View of the Object.

- With the Property Script, you can attach descriptions and
technical data to the Object using its variables and the
related GDL commands and expressions. Component
quantities (weight, price, paint, etc.) can be calculated
according to the expressions in the Properties Script and
included in the lists.
Note: When there is a Property Script defined, the listing
commands will use this script, even if you previously
created Components and Descriptors in the corresponding
sections of the dialog box.

- Using the Parameter Script, you can define the choices
available as a value of a given parameter. For example,
you can restrict the choice of the material of a table top to
wooden materials, or define the different panel styles of a
given door by their name.

- The Interface Script allows you to define a custom user
interface for your GDL Objects, including the graphic
explanation of additional parameters. If an Interface Script

exists, the settings dialog box of the given library part will
include a Custom Settings panel.

- In the Comments window, you can add notes or
messages to a GDL Object, including the web address of
the manufacturer. This text can appear in the preview area
of the Object type tools' settings dialog boxes.

See the Graphisoft GDL Reference Manual for a full
description of GDL scripting commands.

On top of all script windows, some commonly used functions
are available in the form of buttons.

- Clicking the first button transforms selected lines into
comments, that is, lines that will not be executed in the
script. Comments are identified by an exclamation mark at
the beginning of the line.

- The second button has the opposite effect: clicking it will
transform any selected comments into executable lines.

- Clicking the third or fourth button will format the script
window by tabulating selected paragraphs left or right.

- Finally, the fifth button checks the GDL Script of the active
window.

Note: All of these functions are also available as menu
commands from the Edit menu.

Source Debugging
When viewing any script window, choosing the last command
of the Edit menu allows you to debug the script. A dialog box
appears.

The buttons marked with arrow icons perform the following
actions:

- The debugging process starts when the first button from
the left  is pressed.

- The second button from the left  allows you to
execute the highlighted instruction and update the 3D
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model (or the 2D drawing). If the instruction is a macro
call, the debugger will execute it without stepping inside
the macro.

- When clicking the third button from the left  on top of
a highlighted macro call instruction, the debugger will
step into the macro and the debugging process will
continue inside the macro. When pressed on top of any
other instruction, the effect is the same as for the previous
button.

- If you press the fourth button from the left , the
debugger will step out of the macro and continue the
process at higher level, with the first instruction following
that macro call. When pressed inside the main macro, its
effect will be to execute the whole macro.

- Finally, the button with the X  stops the debugging
process.

The debugging process can also be controlled from within the
script by using the special GDL command, BREAKPOINT. The
debugger will stop at a BREAKPOINT if its parameter is true.

Breakpoints can be enabled or disabled in the pop-up menu
located in the top right corner of the Debugger window.
During the debugging process, the global variables,
parameters and variables of the macro can be examined by
adding them to the list.

You can enter new variables in the GDL Debugger dialog
box by clicking the Add… button: a new field appears in the
variable list. Click the Add All button to add all parameters
and variables.
The name and value of any variable can be edited in this
dialog box. Hit the Enter key after you type in the new name
or value to confirm the changes.

Any item can be removed from the list when highlighted by
clicking the Remove button. The type of the variable or
parameter is indicated in the list with the signs: - ...  for
numeric variables and “...” for string variables.
The GDL Debugger can also handle Arrays. Type the Array’s
name in the watched variables list for the Array’s dimension to
appear. Click the dimension to open the Array Values dialog
box. Type the Array’s name, and an index displays the value
of the Array.

2D Symbol
Each GDL Object you place in your Project is shown on the
plan by a 2D Symbol. You can edit an existing symbol or
create a new one with the standard ArchiCAD selection and
2D tools: Arrow, Marquee, Text, Fill, Line, Arc/Circle,
Spline and Hotspot. You can also paste elements from the
3D Window here.

The final symbol that appears on the Floor Plan will be
created from the elements of this window and the 2D Script, if
there is one.

The 2D Symbol Fragments switchboard located under the
preview area lets you show and hide the Fragments of the 2D
Symbol while you are viewing or editing it. Fragments work
like Layers, and they are useful for organizing the various
graphic elements (lines, arcs, text, etc.) that compose the plan
symbol of the GDL Object. There are 16 Fragments available
for use with each GDL Object.

Fragments are especially useful for letting you easily replicate
parts of the Symbol. You can draw a figure in the 2D Symbol
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Window with the various graphic tools, and refer to it by its
Fragment number in a GDL 2D Script that incorporates the
figure in the final symbol in a variety of rotated and translated
positions. See the Graphisoft GDL Reference Manual for more
detailed information on the 2D Script.

To set which Fragment you are drawing in when editing the
2D Symbol Window, choose a number in the settings dialog
box of the Tool you are using.

The switchboard buttons have the following features:

- Show All displays all Fragments of the symbol
superimposed on one another.

- Hide All clears the 2D Symbol Window of all Fragments.
- The list of numerals from 1 to 16 lets you display one or

more Fragments for editing. You can show or hide a
Fragment by clicking the corresponding button on the
switchboard.

Note: Fragments that are hidden are not available for
storing new graphic elements. If you select a hidden

Fragment in the dialog box of the Tool you are using for
editing the symbol, you will get a warning asking you to
change your selection or Show the selected Fragment.

2D Full View
The 2D Full View window allows you to check the symbol
that will be shown on the Floor Plan.

If there is a 2D Script defined, the 2D Full View will be
calculated according to the script, even if the 2D Symbol
window contains drawing elements. However, the 2D Script
can refer to 2D Symbol Fragments.
To exit 2D symbol editing, close the symbol editing worksheet
window or choose a different window either from the Activate
Window menu of the master dialog box, or from the Window
menu.

3D View
In this window you can see the 3D view of the GDL Object
converted from the 3D Script that refers to the current
Parameter values. The viewpoint and other aspects are
controlled using the 3D Projection Settings dialog box
(Image menu) or the 3D Navigation Palette. This will not
affect your settings for the Project's 3D Window.

Matching 2D & 3D Descriptions
The 2D symbol and the 3D description are automatically
linked to each other in the GDL Object. There are no built-in
safeguards against geometric incompatibilities between the
two components. The most common incompatibility error
occurs when the 2D symbol and the 3D shape have different
positions or orientations with respect to the origin.

To avoid this problem, follow these steps:
1) Activate the 3D View of the GDL Object.

2) Choose Top View in Image/3D Projections Settings/
Parallel Projections, and set the angle to 270˚.
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3) Choose Edit/Select All, then Edit/Copy. Activate the
GDL Object's 2D Symbol window and choose Edit/
Paste. This will place the top view of the object (as a
wireframe or hidden line) into the symbol window. It
should match the dimensions and position of the 2D
symbol.

4) Choose Undo once you have verified that the symbol
matches the 3D view. This will remove the 3D lines.

You can use this feature to have ArchiCAD create the 2D
symbol for you. You will only need to add additional hotspots,
line types, etc.
The procedure is the same for Doors and Windows, with the
following modifications:

- Choose Side View instead of Top View (the angle should
still be 270˚).

- A mirrored view will be placed. Select the placed lines and
mirror them across the reference line of the wall.

Note: When you place a wireframe view, redundant lines
are removed. Using Hidden Lines (analytic) will give you
an accurate view, but underlying lines will be hidden.

You can also ensure compatibility between the 2D plan symbol
and the 3D model of a GDL Object by writing a parametric
description in GDL for the symbol. See 2D Script above.

Preview Picture
In the Preview Picture window, you can attach characteristic
graphical information to a GDL Object. The graphic is a PICT
(MacOS) or BMP (Windows) type image and does not affect
the Object’s behavior or appearance in any way. This preview

is displayed as the default representation of your Object in its
tool settings dialog box.

To generate the preview of a new Object:
1) Place the Object in the Project.

2) Select the placed Object and choose Image/3D
Projection Settings/Parallel Projections. Choose a
projection type and set up a view angle that show the
typical features of your Object. Click OK.

3) Choose Image/3D Image Settings. Set the window's
height and width to the same value to obtain a square
shaped window.

4) Check the result in the 3D Window.

5) Choose Image/PhotoRendering Settings/Size &
Background. In the Resulting Image area, define a 128 by
128 pixel size that you will be able to insert in the preview
without any distortion, and choose a neutral background
for the Object (for example, white color for both the Sky
and the Ground).

6) With the Object still selected, choose Image/
PhotoRender Projection. A Model Picture is generated.

7) Choose Edit/Select All, then Edit/Copy.

8) Go back to the Floor Plan. With the Object still selected,
choose File/GDL Objects/Open Object. This will open
the Master Window of the selected Object.

9) Click the Preview Picture icon to open the corresponding
window, then choose Edit/Paste.

10) Save the GDL Object.
You can also paste other data from the clipboard, for example
a photograph of the real-life object.
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Chapter 9
Collaboration and Connectivity
In your architectural practice, you often need to collaborate with colleagues and other professionals. ArchiCAD includes a
number of concepts and techniques that speed and optimize data exchange. In addition, documents created with ArchiCAD
can be reviewed in the special mark-up mode or through the Internet.
This chapter covers: Publishing, Project Mark-Up, Teamwork, Hotlinked Modules and DXF/DWG Data Exchange

Publisher
The Publisher function allows you to output aspects of your
Virtual Building in one of the following ways:

- Save a set of files on your computer's hard disk or to any
volume on the local area network;

- Upload the files to an FTP server through the Internet;
- Print or Plot the files to the device of your choice.

When saving files locally or uploading to the Internet, you can
choose from a variety of formats. If you choose the DWF
format, the published files can be viewed through the Internet
or an intranet with the Java-based Project Reviewer web
environment by anyone who can access the files' location via
a LAN or an FTP connection, without having to install or even
be familiar with ArchiCAD. Colleagues, contractors,
subcontractors or clients can view the design, add their
remarks by redlining it, and send back their corrections or
suggestions to the author of the project. Project Reviewer can
be included with the published file set.

The items you publish are called Views. They include Floor
Plan views (Stories), Sections/Elevations, Details, 3D views
and Lists.

The Publisher function is fully integrated with the Navigator
palette. You can use the Views defined in the View Editor or
define a new View Set based on the Project Map, an existing

View Set or views set up manually. See Chapter 3: Project
Organization and Navigation for details.

Planning to Publish
While Publisher automates the steps you would normally
have to do one-by-one, it must not be forgotten that this is a
large task, and when you publish some parts of your Project,
all the views to be published will have to be generated or
updated. This could take a large amount of computer time.
Also, when planning to publish via the Internet, you should
give some thought to the files you are going to send. For
example, if you publish extensive 3D views of a Project, this
could create very large files, which not only could take a long
time to send but might be too large to be easily downloaded
by your target users. Similarly, do not rely on the default
settings in Publisher, as these could also generate files larger
than needed.
In general, plan your publication carefully, making sure that
you publish all that is required but nothing that is unnecessary.

The Publishing Process
You can access the Publisher function either from the
Navigator palette by activating its third display option top left,
or from the File menu by choosing the Publisher/Publish
command. The Publisher dialog box appears.
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The first steps in configuring the View Set you want to publish
are identical to the setup of the navigation View Sets in the
View Editor, as presented in Chapter 3: Project Organization
and Navigation. You can either use one of the View Sets
defined for navigation, or create a new one.

The controls in the right-hand panel provide additional
options for the publishing process itself.

When you have chosen a View Set to publish and defined the
views that make it up, you need to choose a Publishing
method. Click the View Set Publishing Properties button
under the name of the View set.

At the top of the dialog box that appears, a pop-up menu
allows you to choose from the four publishing methods: Print,
Save Files, Upload to Internet and Plot.

Note: You cannot mix methods within the same set.

The bottom part of the dialog box changes according to the
option you have chosen in the menu.
If you choose Print as the Publishing method, you can only
print with the currently defined printer setup. A checkbox
allows you to print a structure sheet of the defined set.

If you choose Plot, the currently defined plot setup will be used.

If you choose Save files, you can manually enter a path
name, or click on the Browse button and select a location.

- The two radio buttons in the middle of the dialog box
allow you to save your Virtual Building files in a
hierarchical (“real folder”) or flat file structure.
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- You can include the Project Reviewer applet that allows
users to view DWF files in a Web environment. This also
activates the Options button below.

- Clicking the Options... button displays a dialog box in
which you can define the index (or home) file that will be
first seen by the viewer. In addition, you can select a Style
sheet for the index file.

If you choose Upload to Internet as the publishing method,
you must define the location in which you want to place your
files.

- In the top area, you need to enter the host or FTP server
name, your user name and password. You can also type
the explicit server address in the Path field.

- Click the Test login button to check whether the address
is correct. If you are not sure about the correct path, click
the Browse... button. The FTP browser box appears,
allowing you to choose a location. In that case, logging in
will be performed automatically.

- You can include the Project Reviewer applet that allows
users to view DWF files in a Web environment. This also
activates the Options button with the index page and style
sheet options (as when performing a Save, above).

You can also send an email to the people who are going to
review your publication by checking the appropriate box near
the bottom of the dialog box. The Email… button next to this
checkbox opens a dialog box.

By clicking the Add a New Recipient button, you can add
the email address of a person not listed among your Contacts,
while the Add from Contacts allows you to find the address
of a partner already listed in your Contact list (also accessible
directly from the Project Publisher menu). Choose contact
people one by one.
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Enter a subject for your email followed by the text in the
larger field. You have three check box options:

- Attaching publication information to the email;
- Attaching the published files to the email; and

- Attaching the user name and password needed for
accessing the FTP site.
Note: The email will not be sent if the publishing process
fails.

Publisher Contacts

Choosing Contacts in the File/Publisher hierarchical menu
allows you to maintain an email address book of contacts. In
the dialog box that appears, click on New… to add a name,
and enter the email address and any notes that may be
required.

The arrow icon next to the Modify button opens a small pop-
up menu, allowing you to save your contacts into a separate
file, and to open a previously saved contact file.

Publisher E-Mail Preferences

Setting the Email address of the author (the person uploading
the files) is done in Options/Preferences/Publisher. Fill in the
fields as you would for your email or organizer program (e.g.
Outlook).
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Properties of Publication Items
When you have decided on the publishing method and set
the necessary options, the top right part of the Publisher
palette and the icons of the View Set give you some feedback
on the current method. You can also check and set additional
properties for each item at the bottom of the dialog box with
the View Content and Publishing tabs.

- If you are going to print the views, each item's icon is
marked with a small printer sign.

- If you are going to save the views locally, the path of the
folder is shown, and the individual views' icons display the
selected file formats.

- If you are going to upload the files, the FTP site's name is
shown, and the individual views' icons display the selected
file formats.

- If you are going to plot the files, each item's icon is
marked with a small plotter sign.

You can review the properties of each item in the publication
set by clicking on the folder or element at the bottom of the
dialog box.

This section of the dialog box has two tabs: View Content and
Publishing.

View Content is only displayed for views. It provides
information about the View Settings and Storing Options
chosen when creating the view, such as the active Layer
Combination, the Scale, the Zooming option, and, for 3D
views, the window type.
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The file format of both single elements and folder content is
shown on the Publishing tab page. It includes the item's file
format and the date of its creation or modification (the latter
fields are first filled in after you actually publish the files).

You can save or upload files in the following formats:

- Vectorial drawings: DWF (recommended for the Internet),
MOD (module), DWG, DXF

- PlotMaker files: PMK
- Image files: JPG, GIF, TIF, BMP

- Text: RTF, TXT, HTML
- Movie: MOV (QuickTime), AVI

You can change formats with the pop-up menu. For some
formats, a variety of options are available - in these cases, an
Options… button is displayed, and you can choose among
compression settings or color depths.
If the selection contains files of different file formats, the
Format field informs you about the Various file types. You can
only change the format of all items together.
When viewing an image type 2D file, you can crop the image
to the current zoom on the Floor Plan.

If the publishing method is Print or Plot, the Publishing tab
page of the selected item includes some additional controls.

 

Clicking the Print Setup or Plot Setup button opens the
corresponding dialog box, while Print Settings, Print Options
and Plot Settings show simplified versions of the standard
Print… and Plot… dialog boxes, with only the applicable
options available.

 

See also Chapter 13: Printing and Plotting.

Ready to Publish
When all your sets are correctly defined and set up, you are
ready to publish. Click the drop-down list arrow to the right
of the Publish button bottom right in the Publisher palette,
and click on the option you require.

- If you choose this set, the entire active publication set will
be published.
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- If you choose selected items, only the items currently
selected in the active publication set will be published.

- If you choose all the sets, all currently defined sets will
be published.

Now click on Publish. The publishing process starts and a
process dialog box is displayed. When publishing is under
way, a list of the publishing jobs you have launched appears
in this box.

The icons next to the view names inform you whether the job
is completed, under way or failed. You can also click Stop,
which will end the whole publishing procedure, or Pause,
which will cause publication to pause, and change the Stop
button to read Continue, allowing you to continue
publication later.

Notes: Publishing regenerates all the defined views that
have been changed, and this may take some time.
Publishing automatically replaces saved or uploaded files of
the same name without sending you a warning about this.

If you have finished setting up the publication but do not
want to actually start publishing, just switch back the palette
to Navigator view and return to the Publisher at any time. All
Publisher settings are preserved with the project.

Viewing and Redlining DWF Files
If you save files locally or upload them to an FTP server,
consultants or clients can view them without having to install or
open ArchiCAD by simply launching their web browser
application, provided that you've included the appropriate web
environment. If the selected file format is DWF, they can even
add information to the files.

Redlined DWF files can be incorporated in the ArchiCAD file
by using Project Mark-Up. See the next section for details.

See also the About Reviewer item in the Project Reviewer
Favorites which provides an electronic user's guide to
Reviewer in HTML format.

Project Mark-Up
The Mark-Up features facilitates communication between
designers during a Project. It allows you to point out
problematic elements with a color highlight or to add new
elements intended. You may wish to mark up a design for
many reasons - for example to correct and manage a
colleague’s errors or deviations from a project’s guidelines, or
to make alternative design suggestions.

More than one person can mark up a drawing. Project Mark-
Up supports several different commentaries by allowing the
use of different colors for each separate redline.

When Project Mark-Up is switched on, you can use any tool
from the Toolbox to redline your drawing. There are also
special redlining objects provided in the ArchiCAD Library.
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With the Teamwork functionality detailed in the next section,
you can add corrections and suggestions to the workspace of
other members of the design team who can then check them
and, if appropriate, incorporate them into their part of the
design. You can also import redline data created in Project
Reviewer as additions to your published project and
incorporate them into your design.
Mark-Up Entries are view-specific. They cannot contain
elements belonging to different Stories, Section/Elevation
windows or Detail Drawing windows.

Mark-Up Entries can be shown or hidden one by one in the
Mark-Up palette or globally with the corresponding control of
the Options/Display Options dialog box. If an Entry is hidden,
the applied corrections will disappear and highlighted
elements will appear with their real Pen Color and Line Type.

Note: Single Mark-Up Entries can be shown or hidden in
the Mark-Up palette.

Mark-Up Concepts
A Mark-Up Entry is composed of a logically related set of
Corrections, Highlights and Tags placed on the plan, and a
discussion consisting of comments made by one or several
users.
Mark-Up Styles define the appearance of Corrections or
Highlighted elements with Pen Color attributes. Each Mark-Up
Entry can use only one Mark-Up Style. These styles can
indicate the status of the Entry, for example "Drafting Errors,"
"Fixing in Progress" or "Fixed."
You can draw Corrections marked by different style
appearances to suggest the proper arrangement of Project

elements or to add any kind of 2D graphics or text as
annotations.

You can Highlight any existing element to call attention to it,
without actually modifying it. Highlighting is like applying a
special skin of marking attributes to elements without altering
their original ones.

The Project Mark-Up Palette
If you choose Show Mark-Up Tools... in the File menu, the
Project Mark-Up palette appears. The palette includes three
panels in single-user mode and a fourth one that only appears
when you are signed in to a Team Project (see Teamwork
later): Mark-Up Tools, Mark-up Entries, Tag and Discussion
and Teamwork.

On the Active Entry panel, you can choose which of the
Entries defined on the Mark-Up Entries panel (see below) will
be used to house your next Corrections and Highlights.

Note: Only Entries created on the current Story or drawing
window (Section/Elevation, Detail Drawing) can be
activated.

Click the Corrections button  if you wish to actually
draw on the Project. You can use all tools and methods. To
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add freehand redlining, use the Freehand Geometry Method
of the Spline tool.

You can then switch to any other tool and add new elements
to the design with the Pen Color defined in the current Entry's
Mark-Up Style, as shown in the color box next to the
Corrections button. To terminate Corrections, click the
Corrections button again.
You can also turn any selected elements into Corrections by
clicking the Transform into Correction button  or turn
selected Correction element into plain ones by clicking the
Restore Correction Elements to Normal button .

You can also highlight elements to call a colleague's attention
to faulty, redundant or modified elements. Highlighting is
available whenever the palette is shown and an Entry is
active, independently of the state of the Corrections button.
You can Highlight selected elements with the first button
from the left , or Remove the Highlights from selected
elements with the second one .

The Zoom and Select area contains tools that allow you to
work on all the elements of the Active Mark-Up Entry at the
same time.

- If you click the Zoom to Marked Elements button ,
ArchiCAD will fit all the elements that belong to the Active
Entry into the current window.

- If you click the Select Marked Elements button ,
ArchiCAD will select all the elements that belong to the
Active Entry (without fitting them in the window).

On the Mark-Up Entry panel, you can create new Entries,
rename, delete, show/hide and sort existing ones, assign them
to a Mark-Up Style and read information about them.

- You can create new entries by clicking the red folder
button . In the appearing dialog box, you can define the
name of the new entry and assign a style to it. In addition,
instead of creating an entry from scratch, you can choose
to import a DWF file created in Project Reviewer for
redlining the published Project. See Publishing and
Retrieving Mark-Up Information at the end of this section.
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If a Mark-Up Entry was selected in the Mark-Up Entries
panel when you created a new one, the second set of
radio buttons of this dialog box allows you to link the new
Entry to the selected one by choosing Create Response
to. Using this option, you can create hierarchical threads
of Mark-Up Entries and sort Entries by thread (see below).

- The Where field shows the view in which the Entry was
created. Only Entries belonging to the currently active
window and view (Story, Section/Elevation window or
Detail Drawing) can be modified.

- To rename an Entry, select it in the list and type the new
name. You can also change the Style of the selected Entry
by changing another one from the pop-up.

- To delete an Entry, select it and click the button representing
a crossed red folder next to the new entry button.

- The Created field displays the date and time of creation of
the selected Entry. You can change it with the pop-up
arrow to display last Modification.

- You can hide Entries in the project by clicking the closed
Eye icon next to the Entry name. To make them visible
again, click the open Eye icon.

- The Sort by pop-up on top of the panel contains options
for listing the Mark-Up Entries. You can sort Entries by
Name, Date, Style, Thread and View (Story).

 

When choosing the Thread option, linked Mark-Up Entries
are listed in a hierarchical view. You can either create the link
on creating the Entry as response to a selected one, or by
dragging a selected Entry on top of another one in this view.

 

If you click the Show Report of All Entries button, you can
generate a simple report of all Mark-Up Entries for the
currently opened Project. Entries will be listed according to
the current sorting order. You can save or print the contents of
the appearing text window.

On the Tags and Discussions panel, you can add a Text Tag
to the active Mark-Up Entry. Click the Place on Plan button,
then enter the Tag position on the worksheet to display the
remark on the drawing. The style of the Tag Text is
determined by the current default settings of the Text tool
and can be edited as a simple Text block.
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Once placed, the Place on Plan button is replaced by the
Show on Plan checkbox. Use this to switch the visibility of
the Tag on and off.
In addition, you can comment the active Mark-Up Entry by
clicking the Add Comment button. A text window will
appear, in which you can type your comment. This text will
appear in the Discussion window together with all other
comments added to the same Entry.

 

The options of the Teamwork panel are presented in the
next section (Teamwork).

Defining Mark-Up Styles
The Styles that you link to single Mark-Up Entries are defined
as an ArchiCAD attribute. Choose Options/Mark-Up Styles
to display the following dialog box.

The list on top shows the currently defined Mark-Up Style
names.

- Collision is an automatic style which cannot be manually
selected for Mark-Up Entries. It is used by ArchiCAD to
indicate that more than one Mark-Up Entry was used to
highlight the elements that appear with this color.

- The Collision and Problematic styles cannot be deleted,
but they can be renamed.

- To create a new Mark-Up style, just click the New button
and type a name in the appearing dialog box.

The bottom part of the dialog box shows the Style Attributes
of the Style selected in the list at the top.

The Pen Colors that you choose here will be used to color all
the Correction and Highlighted elements that belong to the
Mark-Up Entries assigned to that Style.

Publishing and Retrieving Mark-Up
Information
You can publish your marked up Project using the Publisher
function.

Publisher will remember the Display Options set for Mark-
Ups, that is, whether they are shown or hidden in general.
However, it will not store which Entries were visible when the
View was created. When publishing, the current visibility
status of each Entry will be active.

Provided that the published files are saved in DWF format,
non-ArchiCAD users can add further redlining with Project
Reviewer. Redlined DWF format files can be sent to you by
the reviewer. You can import these DWF files as a new Mark-
Up Entry.
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Teamwork
With ArchiCAD's Teamwork functionality, several members of
a team of architects or related professionals can work
simultaneously on various aspects or parts of the same project.
Before discussing the details of the creation of a shared
project and how collective work can be organized, let us
examine the possible Roles involved in Teamwork.

Team Organization
The team using the Teamwork functionality can be organized
along a wide variety of principles. The flexibility of the
software makes it equally possible to use rigorous sets of
house rules by defining strict hierarchical access privileges in
larger offices, and to leave a large amount of freedom in
smaller practices, where the people working on the same
project are in face-to-face contact.
There are five possible roles in Teamwork: Administrator,
Team Leader, Teammate, Mark-Up and View Only. The
first two have to be defined in advance by the person sharing
the project who can either allow free access by any teammate
or set up a strict cast of members who may access the project
with centrally set passwords.

 The Administrator is the person who coordinates the
team and first shares the project. It is his sole privilege to:

- Allow the signing in of other Team Members;
- Disconnect Team Members;

- Alter other Team Members’ passwords;
- Handle the Administrator and Team Leader passwords;

- Define or modify backup options.
There can only be one Administrator for a project, but he or
she can reach the project from any computer, provided that
the proper name and password is used.

Important: When signed in as the Administrator, it is not
possible to work on the project or reserve areas.

 The Team Leader is the person responsible for the
project. It can either be a physical person (a given member of
the team or even the same person as the Administrator
provided that he/she is also registered as a team member), or
a fictitious person identified by a password only. In practice,
this means that any member of the team can assume the role
and acquire the rights of the Team Leader when using the
latter’s unique password.

The Team Leader has exclusive rights to:
- Modify and delete Layers;

- Modify and delete Layer Combinations;
- Create, modify and delete Stories;

- Modify and delete Pen Color, Material, Fill Type, Line
Type, Zone Category or Composite attributes;

- Define or modify measurement Units and methods;
- Reassign abandoned Mark-Up Entries;

- Modify the loaded Library set used by the Team.
There can only be one person signed in as Team Leader at a
time. Some attribute modifications are permitted only with
exclusive access to the Project, which means that nobody else
can be signed in at that moment and that the Team Leader
reserves the entire project.

 A Teammate is any team member working on any part of
the shared project.

When signing in to the shared project, the Teammate is
prompted to reserve a part of it by making the appropriate
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choices in the Sign In Wizard windows. The part of the shared
project reserved by a Teammate is called a “Workspace.”
The following options are available for making reservations:

- Working on any or all stories;

- Working on any or all layers;
- Working on any or all sections/elevations;

- Working on any or all detail drawings;
- Working on any or all camera/animation paths;

- Working on a physical area defined by a rectangular or
polygonal marquee;

- Any combination of the above.
Teammates can either be defined by the Administrator or self-
registered.

 Registered Team members can also sign in to the project
in the special Mark-Up role. In this case, they cannot create
any new elements, only add corrections or highlight elements
that need to be checked or modified by other Teammates.
Note that Teammates and the Team Leader can also use Mark-
Up tools; this special role prevents any accidental
modification of the Project.

 Viewers, that is, anyone able to access the shared project
through the network can open a copy of the project, save it in
Single-user project format to his own computer and work on
this copy. Modifications made to this copy by the Viewer do
not appear in the Team Project.

Setting Up the Shared Project
To use Teamwork, you first need to set up a shared ArchiCAD
project. Although it is possible to start a Team Project from
scratch and use the default settings provided by ArchiCAD, it
is recommended to define first a number of basic criteria
before sharing the Project, since changing them when there
are already several people working on it is more difficult.

These settings include:

- Project Scale and Measurement Units;
- Stories and Layers;

- Attributes (Pen Colors, Line and Fill Types, Composites,
Materials);

- Grids and Display Options;
- Active Libraries.

When this is done, you can Share the project and the
members of the ArchiCAD team can Sign In to it.

Sharing the Project
When you have finished making the necessary preparations,
you can share the project with the other members of the team.
While the project setup was ideally done by the person who
will act as Team Leader, the actual creation (sharing) of the
Team Project is the job of the Administrator. The two roles can
be filled by the same person, but unique passwords must be
defined for both.
On choosing the Share this Project... command, a dialog
box appears.
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You first start by defining the name and the password of the
Administrator, as well as the password of the Team Leader.

   

Note: Any change made by the Administrator must be
confirmed with his password.

In the middle part of the dialog box, the Administrator can
define in advance the name and password of the teammates
allowed to access the project by choosing the Registered
Members Only checkbox. By choosing the Open Access
option, he or she permits anyone with sufficient network
privileges to sign in to the project.
By clicking the Add New Member... button, you can add
names to the list of registered users.

The two other buttons in this area are only active if the name
of a user is selected in the list of users below.

These buttons allow the Administrator to:
- Delete team members from the list of registered users;

- Change the password of any teammate (the Administrator
is the only person who can change anyone’s password
even if he doesn’t know it);

- Force Sign Out of Teammates to allow Exclusive Access
for the Team Leader if the basic settings and attributes of
the Project need to be changed.

At the bottom of the dialog box, the Backup Options button
allows you to choose how often backup copies of the Team
Project are to be made and how many previous versions of a
project should be kept.

Enabling the creation of new backups means that every time
any team member chooses Send & Receive changes (that is,
the Team Project is modified), a new backup copy is created
of the <Team Project>, the <Team Project>.Adm and the
<Team Project>.txt files.
Backup copies of the Team Project are stored in a folder placed
beside the Team Project, in a folder named
“<ProjectName>.Backups.” This folder contains subfolders for
every new backup, following the options chosen by the
Administrator. These subfolders are named automatically with
the date and time of their creation.

Note: Teammates can make their own backup copies of
their Draft files in the usual manner by choosing the
corresponding options in the Options/Preferences/Data
Safety dialog box.

When you have finished setting up the Team Project, click the
Share button in the bottom right corner. You must confirm
your choices by entering your password again.

After the project has been shared, the Share this Project
command is no longer available. When signing in to the Team
Project, you will see that it is replaced on the menu by the
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Project Sharing Setup or Project Sharing Info command,
depending on the role chosen.

Signing in to the Shared Project
Choosing the Sign In... command in the Teamwork menu
gives access to a directory dialog box listing the shared
projects available on your own computer or on the mounted
network volumes.

Note: Only Team Project type files created with the Share
this Project command appear in this dialog box. On the
other hand, Team Project type files cannot be seen if
choosing the File/Open command.

Once you have chosen a Team Project, it is loaded into your
computer and the first screen of the Sign In Wizard window
appears.

The Sign In Wizard contains a large number of options for
signing into the shared project, including team member roles,
workspace reservations, passwords, library usage and backup
options.
The Sign In Wizard includes one to five screens, depending
on the team member role chosen in the first one:
Administrator, Team Leader, Teammate, Mark-Up or
View only. You first have to choose a role with the radio
buttons in the middle of the window. The options available
for the different team member roles are detailed below.

Note: A virtually unlimited number of Teammates may
sign in to the project at a time, but there can only be one
Administrator and one Team Leader at any moment.

Important: As long as the Sign In Wizard is present on
your screen, you are continuously connected to the Team
Project, which means that no other team member can
either sign in, sign out, send or receive changes. Be sure to
make the Sign In process as short as possible.

Sign In as Teammate
The most commonly used role for signing in is as a
Teammate, that is, a member of the team who will work on a
specific, reserved area of the Project defined by logical (layer)
or physical (story, marquee area) limits.

On the first screen, after having chosen the Teammate role, you
have to identify yourself by name and, if you have one, by
password. This is also where you can create or change your
password.

Note: Passwords must be at least 2 characters long. If you
forget your password, you must ask the Administrator to
give you a new one.

When you have finished working on this screen, click the
Next button.

Note: If Open Access has been enabled by the
Administrator, Teammates will be automatically accepted
and registered.
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The second screen contains options for making reservations on
the Floor Plan by story, layer and physical limit (marquee).

The options are, from top to bottom:
- Check the Skip Floor Plans box if you do not wish to

reserve any part of the Floor Plan.
- Clicking the Cancel button cancels the Sign In process

altogether.

- Clicking the Previous or Next buttons takes you to the
corresponding screen of the Sign In Wizard.

- In the Stories part of the window, you can choose to
reserve all stories (click the checkbox) or any stories of the
project by highlighting their names. The same process
applies for the Layers.

Should any Stories/Layers be already reserved by another
Teammate, a small warning icon (a red triangle with an
exclamation mark) appears next to their name in the list.
If you wish to know which team member has reserved this
story or layer, highlight it and click the triangle icon. A dialog
box will display information about the conflicts in the given
item:

Note: Reserving Layers and Stories actually limits your
access rights: you can work on the same Story as another
Teammate only if your Layer reservations do not overlap.
Similarly, you can work on the same Layers if you reserve
different Stories.

Below the Layer list, a couple of radio buttons allow you to
choose whether to reserve the whole area of the Floor Plan
with the current story and layer options, or to limit the
reservation to a smaller unit delimited by a marquee area.

If you choose the latter option, your name will appear on the
Floor Plan with a green boundary showing the size of the
reserved area. Areas reserved by other teammates appear
inside a red boundary.

At the bottom of the dialog box, the Show Conflicts button
allows you to check whether any reservations you made are
in conflict with options chosen by other teammates who are
currently signed in to the shared project.
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Note: If you have made reservations with a marquee area,
the program will check the Layer and Story conflicts in
combination with this physical limitation. This means that
you may be able to work on the same story and/or the
same layer as another teammate, provided that your
respective workspaces do not overlap.

When you have finished making reservations, click the Next
button in the upper part of the screen to go to the next
screen.
The third screen of the Sign In Wizard allows you to reserve
existing Sections/Elevations and Animation or VR paths.

The top and bottom parts of this screen are basically the same
as the Floor Plan Options. In the middle part of the window,
the two boxed lists work similarly to the Stories and Layers
lists explained earlier. Again, clicking the Show Conflicts
button will display who has already reserved the same
workspace options.

- When reserving a Section window, it does not matter who
has reserved the Section line on the Floor Plan, since the

Section line can only be modified or deleted by the owner
of the Section window.

- New Section windows may be created by any teammate.
The new Section line can be placed into either a reserved
Layer or the ArchiCAD layer.

- Reserving the Model type Section means basically that only
you have access to the 2D items created in this window.
The access to the 3D items is contingent on the Floor Plan
reservations made, meaning that if, for instance, a wall
appearing in the Section window has been reserved on the
Floor Plan by a teammate, only he or she only will be able
to change it in either window.

- Model type Sections can be transformed into Drawings.
After that, the owner of the Section window can modify
items there.

The fourth screen of the Sign In Wizard allows you to reserve
existing Detail Drawings.
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The person who reserves a Detail Drawing in this list has the
right to edit both the corresponding Detail Marker and the
contents of the Detail Drawing window.
The last screen of the Sign In Wizard allows you to check the
reservations made on the previous screens and to actually
sign in to the shared project.

In the top part of this screen, the Next button is replaced by
the Sign In button, allowing you to enter the Project with the
chosen reservations.

Note: If the Sign In button is inactive, this means that the
reservations you have made are in conflict with another
team member. Go back to the reservations screens by
clicking the Previous button and click the Show
Conflicts button there to check what the problem is.

The middle section of the screen shows the description of
your workspace, that is, the story, layer, physical area,
section/elevation, detail and animation/VR path reservations
you have made. If you change your mind, you can still go
back to previous screens by clicking the Previous button.

Below the box displaying the reservations, two additional
checkboxes allow you to further refine your workspace.

Checking the Show My Workspace Only box will limit the
display of the project to the elements that you have reserved.
This can considerably reduce the size of the file both in
memory and on the hard disk. Moreover, in the case of larger
projects, omitting elements not reserved can help you see your
own work more clearly. Still, it is better to use this option if
you are sure that you will not need to see what the other
teammates have done in their own respective workspaces.

Note: Choosing Send and Receive Changes or Receive
Changes will display the entire project again, including its
original setup and the changes made by others. Choose
the Show My Workspace Only command in the
Teamwork menu to hide them again.

The second checkbox, Create Satellite Library, allows you
to create a copy of the central Library set used for the shared
project on the volume of your choice (click the Browse
button and choose a location in the Directory dialog box), on
your own computer. Choosing this option makes access to the
Library Parts faster. It is highly recommended to use it if you
plan to create a local copy of the project or to work off-line.
It is possible to modify your workspace after signing in by
choosing the Change My Workspace... command from the
Teamwork menu. In this case, the Sign-In Wizard appears
again, and you can make the adjustments you need. Note that
choosing this command invalidates all your previously saved
local drafts. See Working on a Local Copy later.

Sign In as Team Leader
Any team member can sign in as the Team Leader, provided
that he or she is a registered user and has knowledge of the
Team Leader password set by the Administrator. Ideally, the
Team Leader is the architect who made the basic settings in
the Project before it was shared.



133

Chapter 9: Collaboration and Connectivity

Graphisoft ArchiCAD User Guide

Basically, the options available for the Team Leader are the
same as for the Teammate. The main differences are as follows:

- In addition to his or her own optional password, the
person signing in as the Team Leader needs to enter the
Team Leader password defined by the shared project’s
Administrator.

- The Team Leader can reserve the whole project with
exclusive access to it, meaning that no one may sign in as
long as the Team Leader is working on the project.

In this case, no additional options need to be chosen and
the Next button at the top of the screen changes to Sign In.

- Only the Team Leader has the right to perform certain
important changes to the shared project’s structure,
including the modification of layers, stories and attributes.
For the most basic changes (changing the drawing scale or
the dimensioning options, creating, modifying or deleting
stories, deleting layers or other attributes), he or she needs
to sign in with exclusive access.

In addition, from within ArchiCAD, only the Team Leader is
allowed to edit Property Objects and Component and

Descriptor databases, which are used for generating
calculation lists.

Note: If other team members are already signed in and it is
absolutely necessary for the Team Leader to have
exclusive access, the Administrator can force the other
users to sign out with the Project Sharing Setup
command. Since this is a rather extreme measure causing
the work of the teammates who haven’t sent in their
changes and signed out to be lost, it should only be used
when absolutely necessary.

Sign In for Mark-Up
Registered team members (Teammates and Team Leader) can
access the shared Team Project and add corrections to the
elements created by other team members. In this case there
are no reservation options, only the Sign In button is active.

In this mode, you cannot create, modify or delete elements.
You can, however, add Mark-Up Entries that can include
suggestions in the form of corrections or highlights. See
Project Mark-Up earlier in this chapter for details.



134

Chapter 9: Collaboration and Connectivity

Graphisoft ArchiCAD User Guide

Sign In as Administrator
The Administrator is the person who first shares the project by
choosing Share this Project... (see above). It may sometimes
be necessary for him to sign in again and make adjustments to
access rights, modify passwords or backup options.
The Sign-In Wizard has the following look when choosing the
Administrator role:

The Administrator cannot make reservations, create, modify
or delete any elements. He can, however, create screen,
electronic, printed or plotted outputs.

The Administrator cannot sign in with exclusive access; he
can, however, force signed in teammates to sign out.

It is possible for any teammate to be the Administrator,
assuming that he knows the defined Administrator name and
password, but he cannot sign in under the same name at the
same time in both roles.
The Administrator’s name can be the same as that of a
Teammate, but it is recommended to use a different, more

neutral name like “Administrator” in order to avoid
misunderstandings.

Actual adjustments may be done by choosing the Project
Sharing Setup command. The options offered here are the
same as those of the Share this Project dialog box, with two
additional controls.

Clicking the Force Sign Out button will disconnect the
signed in teammate whose name is highlighted in the list (for
instance, when the Team Leader absolutely needs to have
exclusive access to the whole project immediately).
Modifications made by teammates that were disconnected by
the Force Sign Out option can only be included in the Team
Project by using the File/Merge command.
Below the buttons is the list of registered users. By highlighting
a name, you can check the latest actions (sign in, send changes,
workspace reservation, sign out) made by that person.
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When the Administrator has finished making the required
adjustments and clicks the OK button, he or she must confirm
them by entering his or her password again.

Note: When signing in to the Shared Project in another
role, the name of this command changes to Project Sharing
Info. The contents of the appearing dialog is similar to
Project Sharing Setup, but it is restricted to the display of
Project information and the list of Teammates with their
Sign-In details.

Sign In for View Only
Any person with network access to the shared Team Project can
sign in to view it. In this case there are no reservation options or
passwords required, only the Sign In button is active.

When signed in as a viewer, you cannot change any element of
the shared Project. You can, however, choose File/Save and
create a single-user copy of the shared Project on your
computer and continue working on it. This file can then be
opened by choosing File/Open. Always bear in mind that at

this moment, you no longer have contact with the Team Project
and that none of your changes can be communicated to it.

Note: If you wish to exclude outsiders from viewing the
project, you must use the operating system’s file sharing
privileges settings.

Working Inside the Reserved Area
Elements inside the reserved area can be freely modified or
deleted by the teammate who has made the reservations.
Elements that are locked, reserved by others or not reserved
at all cannot be modified, but can be viewed in all window
types (Floor Plan, 3D Window, Sections/Elevations, lists).
These elements can be selected, their settings dialog boxes
can be viewed, their parameters can be copied from there or
picked up by Alt-clicking the element.

All elements that have at least one hotspot inside or on the
boundary of the area reserved with the marquee are
considered to be inside the reserved area.

Layers that are not in your workspace are marked by a
specific icon in the layer list.

You cannot create elements outside your reserved workspace,
with one exception: when working on a reserved story and in
a reserved layer, you are allowed to create elements outside
the physical boundary of the area defined with a marquee.

- When updating the Team Project (see below), you have the
option of either releasing these elements created outside
your area for use by other Teammates or keeping them
reserved.
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- If somebody else has created an element in your reserved
area delimited by a marquee and has released it for your
use, you can choose either to keep it or to discard it.

- Elements partially included in different workspace
marquees can only be edited by one Teammate at a time.
To hand over these elements, select them and choose Send
and Receive Changes from the Teamwork menu (see
below). You will be prompted to release these elements as
in the previous case.

Note that any Teammate can create elements on the
ArchiCAD layer without reserving the entire Layer.

Sending and Receiving Changes
Changes made by any team member are sent to the shared
Team Project by choosing the Send and Receive Changes
command from the Teamwork menu, or (optionally) when
signing out.

Changes sent to the Team Project do not appear automatically
in other Teammates’ copies. In order to see changes made by
another Teammate, they too have to choose Receive
Changes.
On choosing Send and Receive Changes, a dialog box
appears:

This dialog box allows junior members of the team to get
another senior team member to validate their work before
copying it into the Team Project. The person confirming the
changes must be a registered team member.
Comments written in the top part of this dialog box are added
to the Teamwork Notes window.
You can also opt to only Receive Changes made by others
without sending in your own to the Team Project.

Teamwork and Project Mark-Up
Any registered team member can add Mark-Up entries to the
workspace of any Teammate, either when signed in as
another Teammate or in special Mark-Up mode. In the latter
case, you cannot create, edit or delete any elements, only
mark them or add corrections.

Every team member can see the Mark-Ups of others, but they
can only edit the ones that they themselves created or that
have been reassigned to them.

Reassigning a Mark-Up Entry can happen in two ways:
- By the Teammate who created the Mark-Up Entry, if he or

she has made suggestions in another person's workspace:
in this case, this Teammate will activate the Mark-Up
palette, select the corresponding Entry on the Mark-Up
Entries panel, and choose the other person's name in the
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Assigned to… pop-up menu in the Teamwork panel.
Reassignment is actually performed when next sending
and receiving changes.

If your Mark-Up Entry contains not only highlighted
elements, but also new, correction elements in the other
person's workspace, you will be warned about this.

In this case, sending changes requires that you get a new
Sign-In ID. After this, any local drafts you created of this
Project will be outdated. Save a new draft and continue
working on that one.

- By the Team Leader, if there are Mark-Up Entries
abandoned by their owner. This can happen, for example,
if a Teammate has been removed from the Team by the
Administrator in Project Sharing Setup. In this case, on
signing in, the Team Leader is automatically offered the list
of entries without an owner, and he or she can choose
among the registered Teammates the one that will receive
this information.

If there are Mark-Up Entries reassigned to you (by either of
the above ways), you will be informed of this on signing in or
when receiving changes.
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When offered the Get Mark-Up Entries dialog box, both the
Team Leader and the Teammate can either choose to accept
the reassigned entries immediately or to postpone this until
later. In the latter case, the dialog box will reappear when
they next sign in or choose to receive changes.

See also… Project Mark-Up earlier in this chapter.

Teamwork and Publishing
Each Teammate can create his or her own View Sets in the
View Editor or Publisher mode of the Navigator palette. These
sets can only be seen by others if the Teammate shares them.

The View Set pop-up menu at top right of the Publisher
palette shows the status of each view set. The teammates icon
indicates a set that belongs to others, while the open hand
indicates a set that you created and shared with others, which
means that they can see it. If there is no icon next to the
name's view, this set belongs to you only and no other
Teammates can see or use them.

  

You can share a view set by making it active and choosing the
Share command in the pop-up menu next to the name field.
You can publish all shared sets, even if they contain views
that are not in your workspace. When saving or uploading
files, the location defined by the author of the set will be
used. To save or upload them to a different location, select
and duplicate the set.

Working on a Local Copy
Relying continuously on the network may sometimes be
troublesome, since the more people use the network
simultaneously, the more it may slow down all of them.
Moreover, some team members may need to work at home or

in a remote location. You may also want to save changes in a
state of the Project that is not yet ready for sending and
receiving changes and made visible to other Teammates. In
this case, the solution is to make a local Draft copy of the
Shared Project, preserving the Sign-In reservations made.

To create a local Draft copy of the Shared Project, choose the
Save command from the File menu.

The created file can be opened similarly to a Solo Project by
choosing File/Open and the Draft option. This file contains
all the relevant data about the Team Project, including the
reservations made by the Teammate.

Note: Sending in changes to the Shared Project does not
mean that your local copy is also saved at the same time.
However, sending changes does trigger an Autosave,
which will allow you to reopen the Draft in case of any
error during the send-receive process.

Since the Draft contains all the information available at the
time of its creation, you can continue working on it as you
normally would if you were still connected to the network.
Of course, changes can only be sent in once you are
reconnected to the network, and the same applies for
updating changes made by other team members.
This way, subcontractors and consultants can also be made
part of the team by incorporating them as off-line team
members with reserved workspaces.

If you save multiple Drafts with variations of the design, you
can send changes from any of them. You cannot continue to
work on changes made to different Drafts with this option.

Signing Out
Choosing the Sign Out command breaks contact with the
Team Project and releases your reserved workspace for other
teammates who may wish to sign in to it.

If you have made any changes, you are prompted to send
them in.
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If you choose No in this dialog box, your changes will be lost.
Note: If you have saved a Local Draft copy of the project
and then signed out without sending in your changes, they
will not be copied back to the central project and will be
lost. You can however still include these changes later by
choosing the File/Merge command.

ArchiCAD will remember your last Workspace reservation
and, when you next Sign In, offer you the same options by
default.

Teamwork Notes
Choosing the Teamwork Notes command in the Teamwork
menu opens the text window bearing the same name.

This window functions as a log file. The following
information about or from the teammates appear in it:

- Sign in/sign out date and time;

- Send changes date and time with name of the person
having confirmed it;

- Any information added to the Send Changes dialog box’s
comment field;

- Comments made by choosing Add Comment (see above);

- Changes made to the team by the Administrator.

Compatibility Note
You cannot work with different versions of ArchiCAD on the
same Team Project.
This means that you should only start using Teamwork with a
Team Project when all of the potential Team Members have
been equipped with the same version of the program.
To use an earlier version Team Project with a more recent
version of ArchiCAD, the Team Leader must sign in with
exclusive access. Before the sign-in process, ArchiCAD will
warn the Team Leader that the Team Project will become
inaccessible to users of previous versions.
After this, the Team Leader should sign out. The Team Project
is now updated and ready to be used by all Team Members. It
cannot be accessed any more with an earlier version of the
program.

The last used workspaces of the Team Members are preserved
in the process. After the Team Leader has finished, all Team
Members can sign in again with ArchiCAD to their workspace
as it was.
See Teamwork Tips in the More Information section of
Chapter 9: Collaboration and Connectivity in ArchiCAD
Help.
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Hotlinked Modules
Using Hotlinked Modules allows you to insert the contents of
external ArchiCAD files (sources) into the currently open
Project (host). Elements inserted into the host follow all
modifications of the source files.

Hotlinked Modules can be used, for example, to manage the
repetitive structures of buildings such as hotels or offices with
a large number of identical rooms by modifying all instances
in a single step. Moreover, the same structures can be used in
multiple Projects. This is also a good way to subdivide large
Projects into easier-to-handle smaller files.

A Hotlink is a logical pointer to a single story of an external
source file and an attribute of element sets called Modules.

- The source file can be a Solo Project, a Team Project or a
Module file.

- The host file can include any number of Hotlinks.
A Module is a set of construction elements placed on the
Floor Plan using a Hotlink.

- The elements are included in the Project, which means
that even if the hotlinked source file is not currently
available, the Modules are still present and visible, they
just can’t be updated as long as the referred source file is
absent.

- Multiple instances of the same Hotlink can be placed, each
instance being a separate Module; the placement
parameters of each instance can be different even though
they share the same Hotlink.

- The Modules’ content can be updated as the hotlinked
source file changes.

- The Module can only be edited as an entity (similarly to
Library Parts or Groups).

- Managing (modifying, updating, breaking, deleting) a
Hotlink will have an effect on all associated Modules.

There is a difference between Modules placed in Projects and
Module type files.

Modules placed in Projects are sets of elements coming from
Solo Project, Team Project or Module type files.

Module type files are a simplified type of ArchiCAD file. They
contain no Section/Elevation data, active Library or
preferences information and only refer to attributes actually
used by their elements. They can either be placed as Modules
or merged into a project through the File/Merge command.
Merged elements cannot be updated from the source file.

Source File Data Interpretation
The Hotlinked Modules feature is strictly a Floor Plan to Floor
Plan communication, which means that only elements
appearing on the source file’s Floor Plan will appear in the
host file.

- Source file elements keep their story-relative elevation
values.

- Section/Elevation markers and the contents of Section/
Elevation Windows as well as Cameras of any type are
skipped when placing the Module.

- Library Parts: Placing a Module does not import the
Library Parts it refers to. Make sure that the Library Parts
used by the source are also available to the host, by either
using the same Libraries for both source and host,
activating the source’s Libraries in host file or putting an
alias/shortcut to the source’s Libraries into the host’s
Libraries.

- Stories: Hotlinks always to refer to a single story. You can,
of course, create separate hotlinks to different stories of a
Project.

- Pen Colors: The settings of the current Project will be
applied to the Module.

- Materials, Line Types, Fill Types and Composites: If
the elements of the Hotlinked Module use attributes that
have the same names as those of the current Project, they
will use the attributes of the host file. If no material, line
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type, fill type or composite of that name exists, new
attributes will be added to the host file.

Note: Attributes imported with the Hotlinked Modules are
added permanently to the Project, i.e., they will not be
removed when deleting Hotlinks or Modules.

Creating Hotlinks
New Hotlinks can be established by choosing the File/
Modules and XREF-s/Hotlink Manager… command and
then clicking the New Hotlink button in the Hotlinks dialog
box.

A directory type dialog box will then appear. A pop-up allows
you to choose to display different hotlinkable file types in the
current directory. Selecting a file here and clicking Select in the
dialog box will open a further dialog box displaying the stories
of the selected file. Select a story here to complete the definition
of the new Hotlink.

You can choose one or several stories of the file to create
hotlinks. File types that can be hotlinked are Solo Projects,
Team Projects and Module files.
You can add here any number of files that you wish to use in
your Project and can now proceed with placing Modules, that
is, instances of the linked files.

Single Step Module Creation
You can easily create any number of Module files when
working in the Floor Plan Window.

1) Draw some elements in the Floor Plan and select them.
2) Go to the File menu, and choose the Save Selection as

Module from the Modules & XREFs hierarchical menu. A
directory dialog box will appear, prompting you to save
the selected elements as a module file. By checking the
Change the Hotlink to the saved file box, you can
immediately replace the selected elements with the
contents of the module, without having to go through the
usual process.
Note: If the selection contains elements that cannot be
modified (locked, located on a locked layer or reserved by
another Teammate) and the Change the Hotlink to the
saved file checkbox is marked, an alert will warn you.
You will then have the choice of either creating the
module with the editable elements only (and at the same
time replacing the selected elements with this module), or
canceling the operation altogether.
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Placing a Module
After defining a list of Hotlinks, you can start placing Modules
in the Project by choosing the File/Modules and XREF-s/
Place Module command.

Note: If you have already placed Modules and there is one
selected on the Floor Plan, the name of this command
changes to Module Settings, allowing you to edit the
placement parameters of the Module.

In the dialog box that appears, click the Choose Hotlink...
button, which will open the corresponding dialog box.

This dialog box lists the Hotlinks that have already been
established between the current Project and other ArchiCAD
files. Select a Hotlink in the list and click OK.

Notes: If the desired Hotlink does not exist yet, click the
New Hotlink… button to add it to the list.
Hotlinks that refer to a missing file cannot be used when
placing Modules.
Placing a Module always reads the existing source file.
Already placed instances of a Hotlink will be updated if
necessary.

The name of the chosen hotlink will appear in the dialog box,
and the Place Module button will become active. Click it to
place an instance of the Hotlinked Module in your Floor Plan.

Note: Similarly to pasted elements, Modules can be placed
into the current zoom or keep their source file coordinates.

You can repeat the placement of the same module any
number of times with different settings. It is also possible to
create multiple instances of the same Hotlinked Module by
using the usual Edit commands (Copy/Paste, Drag/Rotate/
Mirror a Copy, Multiply) on Modules already placed in the
Floor Plan.

A number of options are available for inserting Hotlinked
Modules, and some special rules apply to them.

- Layers: The whole Module is placed on a Master Layer
that you choose from a pop-up menu when placing the
module. (See below for details.)

- Height/Elevation values: Positions relative to the actual
story of the original file are applied. When placing the
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module, you can type a value in the Elevation field to
define the height at which the Module will be placed, i.e.,
an optional vertical offset added to the elements’ original
story-relative elevation.

- Type a value in the Orientation field to place the Module
at an angle that is different from the one defined in the
original file.

- Check the box next to the Orientation field to place a
mirrored Module.
Note: You can also modify the orientation, elevation and
mirroring parameters of selected Modules with the
corresponding Edit menu commands.

The whole Module is placed on a Master Layer. The elements
of the Module keep their element-specific layer assignment
and are placed on the corresponding layers of the current
Project, if layers with these names exist. If necessary, new
layers will be created.
The Master Layer controls the visibility and locking of a
Module as an entity. This Master Layer is an ordinary layer of
the host file and can include any other elements.

- Different instances of the same Module can be assigned to
different Master Layers.

- Element-specific layers control the visibility of the
elements within the Module.

- If an element-specific layer is locked, the Module is still
editable, even if any of its elements are in this locked
layer.

- Locking a Master Layer has priority over the Delete/Break
commands in the Hotlink Manager dialog box. These
commands only act on Modules with an unlocked Master
Layer.

- Layer sets of the source file are not imported with the
Modules.

Note: For best results, use the same layer structure in both
the source and the host file.

Editing Placed Modules
You can select the elements of the Module and read their
settings. Elements belonging to a selected Module will have
hollow square marks on their hotspots.

- If several Modules are selected, their selection dots will
have different colors to help you distinguish them.

- Hotlinked Modules cannot be included in groups.
- Once placed, you can modify the Master Layer and the

placement parameters of the Module, but you cannot
switch to another Hotlink.

- It is possible to use the Find & Select command to locate
Module elements by Hotlink.

Elements in Hotlinked Modules behave similarly to groups. If
you suspend groups, you can select single elements of the
Module, but you will not be able to edit them. Elements
copied in this mode will be pasted as individual elements,
even if copying/pasting the entire contents of a story through
the Story Settings dialog box.

When breaking the Hotlink of a placed Module, the created
elements will be automatically grouped. However, restriction
on grouping will be valid (e.g., Dimension Chains will not be
included in the group).
In the host Project, you can dimension the elements of the
Module just like any other elements. Updating the Module
will also update the dimensions.
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Managing Hotlinks
Existing Hotlinks can be monitored and new ones created by
using the Hotlink Manager… command of the File/
Modules & XREFs hierarchical menu.

The top section of the dialog box contains the list of Hotlinks
linked to your Project. You can see here the name of the
referenced file and the number or name of the stories that
have been used, as well as the number of instances placed in
your Project and the status of the various Hotlinks.

Selecting an item in the list will display all the information
about the linked file in the Hotlink Info… area.

Possible status values:
- OK: the referred file and story exist and the link is up-to-

date, and there is at least one module using the hotlink.
- OK, Open&Check Nested: the same as above, but the

module contains nested modules that need to be updated
from within their own host files.

- Unused: there is no module using the hotlink.

- Missing File: there is at least one module using the
hotlink, but the referred file cannot be found.

- Missing Story: the referred file exists and there is at least
one module using the hotlink, but the referred story
cannot be located.

- Outdated: the referred file and story exist and there is at
least one module using the hotlink, but the stored link
date is different from the last modification date of the
referred file.

- Update, Change, Break, Delete: these status values
appear if you used one of the buttons on the right of the
dialog box to manually change the hotlink. See descriptions
below. Note that these changes will not be actually carried
out until you click OK and leave the dialog box.

- OK, Change Path: the hotlink has been changed to refer
to a file of the same name and date but in a different
location in the file system.

Use the buttons on the right to manage selected hotlinks or all
of them.

- Clicking the New Hotlink... button allows you to add
new items to the list of hotlinked files. The process is the
same as with the Place Module command above, except
that you won’t actually place an instance of the module in
your Worksheet.

- The Change Hotlink.../Read all from... button allows
you to either modify the link to a placed module (if an
item is selected on the list), or to replace all hotlinked files
with ones having the same names but stored in another
location (no selection).

- Clicking the Update/Update All button will update all
related Modules with the current contents of the hotlinked
file. You can update Modules even if the hotlink status is OK.

- Clicking the Save as File… button creates a new Module
file with either the same name as the original file or a new
one. By checking a box in the Save as… dialog box, you
can even switch the hotlink to the newly created file. This
button is only active when a single item is selected in the
list. This way, you can restore missing files from within the
content of placed Modules.
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- Clicking the Break Hotlink/Break All button will break
the link between the original file(s) and the instances
placed in your Project. The elements that make up the
module will then be incorporated as plain elements and
will become individually editable.

- If you click the Delete/Delete All button, the hotlink will
be broken and all instances placed in your Project will be
deleted.

Note: If the Module’s Master Layer is locked, Break and
Delete operations will have no effect on it.

The files that the hotlinked modules refer to can themselves
contain references to other files. The Skip Nested Modules
checkbox allows you to choose whether to use the elements
of these embedded references or to stick to the first level of
hotlinks. See also Hierarchical Hotlinks below.

The Options... button at the bottom of the dialog box opens
an additional dialog box with three choices that affect file
operations.

- Choosing the first radio button will ignore any
modification made on hotlinked files. This is the fastest
opening option for a file containing Modules.

- Choosing the second radio button will look for all
hotlinked files and check their modification date. An alert
will appear asking you to confirm whether you want to
update modifications or not. This is the default setting in
the program.

- Choosing the third radio button will update all Modules
that are hotlinked to modified files.

Notes: The option you choose here will be preserved in
your Preferences file, but will not be saved with the Project.
Should there be any problem in the course of the automatic
updating process, choose the first option (no updates),
open your file again, and then update the hotlinks
manually through the Hotlink Manager dialog box.

At the bottom of the dialog box, the Revert button allows you
to return to the initial state of the hotlink list without having to
click Cancel, then close and reopen this dialog box.
After closing the dialog box, all updating and other
procedures will start. When the process is complete, all
modifications can be reversed with a single Undo step.

Note: Unused Hotlinks will not be saved with the Project
but will be available for placing Modules even after closing
the Project until you next choose New and Reset or Quit
ArchiCAD.

It is possible to have several levels of hotlinked modules
nested into each other.

- When updating the hotlinks, you may choose to skip the
nested Modules by checking the corresponding box in the
Hotlink Manager dialog box. In this case, the elements
coming from nested Modules will be excluded from the
instances placed on the Floor Plan (but will, of course, still
be present in the source file).

- You can only update the first level of Hotlinks from a host
file. Hotlinks to nested Modules can only be edited by
opening the source file (which then becomes the host). If
a modification was made at the bottom level of the hotlink
hierarchy, you will need to open and update every
intermediate level file. This is indicated by the OK Open
& Check Nested status in the Hotlinks list.

If two files refer to each other (for example, each containing
one of the wings of a two-wing building), check the Skip
Nested Modules checkbox in the Hotlink Manager dialog
box in order to avoid recursion resulting in the duplication of
elements.
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It is also possible to hotlink a file to itself. Here again, make
sure that you check the Skip Nested Modules checkbox in
the Hotlink Manager dialog box.

Note: Since this method will also ignore all other nested
Modules, use it only with files that do not contain any
other placed Modules.

Deleting Modules and Breaking Hotlinks
To delete a Module placed on the Floor Plan, select it and
press Backspace or Delete. All the elements making up the
Module will be cleared from your Project.
If you want to clear all the instances of the same Hotlinked
Module, you can go to the Hotlink Manager dialog box,
select a Hotlink’s name and click the Delete button.
You can also choose to break the Hotlink without clearing the
elements that make up a single instance of a Module:
1) Select the Module.

2) Choose File/Modules & XREFs/Module Settings.
3) The Module Settings dialog box appears. This is a slight

variation of the Place Module dialog box, with an additional
checkbox allowing you to break the hotlink to the Module.

4) Check the Break Hotlink of Selected Modules box.
Note: To break the hotlinks and preserve the elements of
ALL instances of one or more Modules, use the Break
Hotlink button of the Hotlink Manager dialog box.

Offset and Rotation Correction
When several instances of a Module have been placed with
different rotation and offset values, and you need to edit the
source file, a relocation effect occurs when you save the
modified file.

To correct this, proceed as follows:
1) Select the Module to edit on the Floor Plan.

2) Choose File/Modules and XREFs/Module Settings.
3) Check the Break Hotlink of Selected Modules box, and

click OK to close the dialog box.

4) Edit the elements as needed.
5) Select the elements again and choose /Modules and

XREFs/Save Selection as Module.
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6) Choose the old name of the Module file to overwrite the
previous source file and check both the Change the
Hotlink to the saved file and Apply offset and
rotation boxes. Click the Save button.

The placed Module instances keep their relative locations.

Pasting and Merging Project Data with
Modules
When pasting or merging data containing placed Modules
into a file containing instances of the same Hotlinks but with
different update times, it is always the more recent Module
content that will be used, forcing the updating of the older
instances.

Warning: After this operation, the Hotlink may still be
outdated.

If pasting or merging placed Modules that do not have a
Hotlink in the file, these new Hotlinks will be appended to
the Hotlink list.

Multiplatform Issues
Host files located on either MacOS or Windows based
computers can accommodate Modules coming from the other
platform through a network.

However, moving the host file to the other platform will
require that you manually select the appropriate file for each
hotlink by clicking the Change Hotlink… button in the
Hotlink Manager… dialog box. After this, the host file will
store hotlink path names according to both platform
standards. If you then change any Hotlink to point to another
file, the path name for the other platform will be cleared.

Note: There is an exception to this rule. If this file has the
same name as the one the Hotlink previously pointed to,
the path name for the other platform will be preserved.

Although it is possible to use Hotlinks having the same file
name but placed at a different location as long as you’re
working on either Macs or PCs, moving the file to the other
platform will merge these different path names. Therefore, it
is recommended to use different file names for different
Module content even if you’re working in a single-platform
context.
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Restoring Missing Hotlinks
The elements making up the Module are actual elements, not
just references to items. This means that when you save the
Project file containing the hotlinked Module, all the data you
need is saved, even if the source files are not available
anymore.
You can work with a Project file containing Modules whose
source is not available just like with any other Modules,
except that the Modules cannot be updated.

If you need to recreate a live Hotlink to a Module whose
source is lost or not available:
1) Choose File/Modules and XREFs/Hotlink Manager.

2) In the list of available hotlinks, select the name of the
hotlink you want to export.

3) Click the Save as file... button and name the newly
created Module type file.

Hotlinked Modules and Teamwork
Using Hotlinked Modules can be combined with the
Teamwork functionality for working on complex projects
shared by several architects.

Modules can be reserved by Story, Layer and Area.
- When reserving a Module by Layer, you must select the

Master Layer of the Module, not the layers of the elements
making up the Module.

- When reserving a Marquee area, each Module that has at
least one element inside your workspace will be entirely
reserved by you.

Teammates can manage the Module instances inside their
own workspaces.

- You can Delete and Break Hotlinks to your own instances.
Note that the Hotlinks dialog box will show that all
instances have been changed, not just yours. Click OK and

open the Hotlinks dialog box again to see the real
situation.

- You can update every instance of placed Modules, both
yours and other Teammates’. If you choose Send and
Receive Changes or Receive Changes, ArchiCAD will
update all instances with the newer versions. Note that
your update can only act on the Team Project if your
Workspace actually did include such a Module. Otherwise,
all modifications will revert if you choose Send and
Receive Changes.

- You can change the Hotlink of your instances of placed
Modules. When you then choose Send and Receive
Changes, you will see that only your own instances will
actually change, while those reserved by other Teammates
will revert to the original Hotlink (resulting in more
Hotlinks). In order to avoid confusion, it is recommended
that Hotlinks be changed in Exclusive Access mode by the
Team Leader. If this is not feasible, all teammates should
change to the same hotlink independently of each other.

- Choosing Automatic Update in the Hotlinks/Options...
dialog box is not effective when choosing Sign In/Sign
Out or Send & Receive Changes. On the other hand, it
will be effective when opening Draft Copies.
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Working with DXF and DWG Files
ArchiCAD is fully prepared to work in collaboration with
users of other CAD systems, especially those supporting
AutoCAD’s native DWG and the industrial standard DXF
formats.

The DXF/DWG Add-On is installed together with the
ArchiCAD package and is smoothly integrated in the
ArchiCAD and PlotMaker user interface. It allows you to:

- Open AutoCAD drawings as ArchiCAD Projects or
ArchiCAD Library Parts.

- Merge AutoCAD drawings with your ArchiCAD Project file.
- Add to the ArchiCAD Project AutoCAD drawings as

external references (XREFs).
- Save your ArchiCAD Floor Plans, Sections/Elevations and

3D views in AutoCAD formats.

- Load AutoCAD drawings into PlotMaker Drawings and
Layouts.

- Save your PlotMaker Drawings and Layouts in AutoCAD
formats.

- Set up Translators that will help you apply repeatedly and
automatically conversion rules between the equivalent
elements and functions of ArchiCAD and DXF/DWG files.

In this section, a simple description of the various processes is
given. For full details, see the DXF/DWG Conversion Guide in
the More Information section of Chapter 9: Collaboration and
Connectivity in ArchiCAD Help.

Defining and Managing Translators
Given the major differences between ArchiCAD and
AutoCAD, conversion from one to the other requires you to
apply conversion rules. These rules can be stored in a file
called a Translator. Translators assist you in applying
conversion rules, sparing you the trouble of setting up the
rules manually every time.

Using common Translators ensures that all team members
have access to the same conversion options. It is therefore
recommended that the CAD Manager (or a person filling the
same type of role in your office) manage the set of Translators
and place them on a server.

Translators can be defined and modified by choosing the
DXF-DWG Translation Setup command in the Tools menu.

In the dialog box that appears, you can check the list of
available Translators. The Info panel contains information
about the selected Translator, while in the Settings in
Selected Translator panel you can check and modify the
rules collected in the translator.
You can select a translator with a single click or start editing
its identification fields with a double-click. These fields are:
the name of the Translator file, the Project it is associated with
and the name of the Partner you are exchanging data with.
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The Project and Partner fields are optional. The Status field is
not editable: it shows whether the Translator is missing or
locked. You can sort the list by any of the fields.

The Settings in Selected Translator panel includes rules for
the following operations:

- Drawing Unit Conversion;

- Opening an AutoCAD DXF or DWG format file;
- Exporting an ArchiCAD file in DXF/DWG format;

- Attribute conversion (Layers, Pen Colors, Line Types, Fonts);
- Miscellaneous (mainly Character conversion).

Drawing Unit
You need to define the correspondence between one AutoCAD
logical drawing unit and ArchiCAD's real-world unit format.

Opening Options
Various options are available depending on the application
you will be using (ArchiCAD or PlotMaker) and the
performed operation (Open/Merge or Open Object). They
mainly concern:

- Model Space and Paper Space conversion;
- AutoCAD Block translation with the additional option of

including 3D Data in the resulting Library Parts;
- The conversion of Dimensions.

Save Options
The first thing you need to define is the AutoCAD version you
are saving your files into. Note that Smart Merge is only
available in AutoCAD R14 or higher.

Some of the additional features that you need to consider:
- Exploding complex ArchiCAD elements;

- Saving Zone stamps and fills;
- Omitting polygon edges from 3D views.

Attributes
Some ArchiCAD attributes (layers, line types, pens, fonts)
have their counterparts in AutoCAD, but certain rules need to
be observed.

The Translator contains five groups of settings for the
different attributes: Layers, Pens & Colors, Line Types, Fills,
and Font-Style Conversion. Each group consists of a Method
and one or several Dictionary sets.

- The Method set contains options for defining the attribute.

- The Dictionary is a list of ArchiCAD attributes and their
AutoCAD counterparts. When you choose Save, an
ArchiCAD attribute found in the dictionary is renamed to
its AutoCAD counterpart, and vice versa when you choose
Open. Attributes not found in the dictionary remain
unchanged.

If you set up a dictionary, the entered attribute pairs will
appear on the corresponding panel of the Translator.

The creation of dictionary items is performed in dialog boxes
listing the available choices.
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Layers

You can convert layers in the DXF/DWG file by ArchiCAD/
PlotMaker layers, Pen Color numbers or element types. In the
first two cases, you can set up a conversion dictionary.
In addition, you can save either all layers or only visible ones
and choose specific layers for Windows and Doors (in
ArchiCAD, they are automatically placed on the same layer as
their host Walls).

Pens & Colors

ArchiCAD Pen Colors are configurable, while AutoCAD's pen
number association to colors cannot be modified.
You can convert ArchiCAD Pens to AutoCAD Colors by pen
index number (although the numbers may represent quite
different colors), search for the best color match or set up a
conversion dictionary.

Line Types

When saving files, you can either set up a line type
conversion table or choose to convert all ArchiCAD line types
to a single type in AutoCAD named BYLAYER.

Note that symbol line types are stored differently in ArchiCAD
and in AutoCAD. Due to these differences, some of
ArchiCAD’s symbol line types will not look the same in
AutoCAD.

Fills

ArchiCAD fill patterns can be saved as solid fills. You can also
export fill backgrounds as additional polygons (as this feature
is not supported by AutoCAD).

Font-Style Conversion

Font names are stored differently in DXF/DWG files and in
ArchiCAD. Even when one-by-one font matching is possible,
a dictionary is necessary. (On a PC, ArchiCAD supports all
available fonts including those installed by AutoCAD).

Miscellaneous Options

The last group of settings concerns character conversion
including the use of national characters not in the English
alphabet, font substitution rules for missing specifications and
binary DXF.

Opening DXF/DWG Files
You can open DXF and DWG format files in ArchiCAD or
PlotMaker as Drawings or Layouts. Choose File/Open and
then select the file you need in the directory dialog box. The
Translator Management dialog box appears. Here you can
choose the Translator to use for converting the file.
You can also open a DXF/DWG file as a Library Part by
choosing the File/GDL Objects/Open Object command.
This will open the Library Part master window where you can
configure the new object obtained from the entire file. If you
choose File/GDL Objects/Import from DXF/DWG, the
blocks of the translated file will be converted and placed in a
new library folder.

Saving DXF/DWG Files
You can save DXF and DWG format files from any project
view in ArchiCAD or from PlotMaker Drawings and Layouts.

When the directory dialog box is displayed, choose the format
you need (DXF or DWG) and enter the name under which
you wish to save the file. The Translator Management dialog
box appears. Here you can choose the Translator to use for
converting the file.
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Merging DXF/DWG Files
You can merge DXF and DWG format files into the currently
open ArchiCAD Project. Choose the file you need in the
directory dialog box. The Translator Management dialog box
appears. Here you can choose the Translator to use for
converting the file.
An additional button appears at the bottom of this dialog box,
called Merge Options. Clicking this button accesses the
ArchiCAD's Smart Merge function.

Note: You can also set up these options in advance with
the Tools/Smart Merge command which opens the same
configuration dialog box.

Smart Merge allows you to work at the same time on the same
project in ArchiCAD and AutoCAD and exchange the
additional information with as little loss and interference as
possible or as needed.
Smart Merge allow you to deal with:

- New elements added in ArchiCAD or AutoCAD.
- Elements created in ArchiCAD or AutoCAD and modified

(stretched, dragged, rotated, mirrored) in the other
application or both applications.

- Elements created in ArchiCAD or AutoCAD and deleted in
either or both applications.

When opening the Merge Options dialog box, you first see it
in its simplified form, where you can only choose a
configuration file.

Clicking the arrow below this control (Edit Rules for current
configuration) opens the lower panel in which all of the rules
can be modified.

The entire process is described in detail in the DXF/DWG
Conversion Guide in the More Information section of Chapter
9: Collaboration and Connectivity in ArchiCAD Help.

Managing External References (XREF)
External reference files (XREF) are similar to hotlinked
modules (presented in the previous section), except that they
are DXF or DWG files and not ArchiCAD files.
In ArchiCAD, external reference files work the same way as in
AutoCAD. You can attach and detach XREF files in ArchiCAD,
unload and reload them, bind them to the project file and
view information about them. These functions are available
from the File menu under the Modules & XREFs/XREF/
XREF Management... command.
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All XREF-related functions can be performed in the dialog box
opened by this command.

The dialog box displays information about the attached files,
including the name of the reference (usually the same as the
attached file), its status (Loaded, Detached, Reloaded,
Unloaded or Bound), size, type (Attach or Overlay), Date and
the number of instances.

The buttons on the right allow you to:
- Attach an external reference file and choose an

attachment method. The difference between the Attach
and Overlay resides in the handling of nested XREFs
which are skipped in Overlay mode.

Note: This function is also available directly as a separate
command under File/Modules and XREFs/XREF.

- Detach an attached external reference file.
- Reload a modified (or unloaded) external DWG or DXF

reference file.
- Unload from memory an external reference file while still

keeping it attached. The elements of the unloaded file do
not appear in the project, but can be made to reappear at
any time by clicking Reload, without needing to attach the
file again.

- Bind the contents of the external reference to the Project,
that is, definitely merge all instances of the reference file
with the ArchiCAD Project and remove the original
external file from the list of XREFs.

- Browse for a different XREF file with which you can
replace the selected one.

The entire process is described in the DXF/DWG Conversion
Guide in the More Information section of Chapter 9:
Collaboration and Connectivity in ArchiCAD Help.

Note: If any of the functions described in this chapter do
not work properly, the DXF/DWG Add-On may be
missing. You can check this easily by choosing File/Open
and looking for the appropriate file types in the Files of
type field. The missing Add-On can be loaded with the
Add-On Manager command in the Tools menu.
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Chapter 10
Project Data Calculation
ArchiCAD's integrated database of construction elements, accessible from the Calculate menu, can be used to display, in list
format, the number, quantities and components of elements in a project and the elements' spatial disposition (zones). The
following chapter sums up the basic concepts involved in the calculation process and enumerates the list types that can be
obtained. The entire process is described in detail in the ArchiCAD Calculation Guide in the More Information section of
Chapter 10: Project Data Calculation in ArchiCAD Help.

Calculation Sources
When performing calculations, ArchiCAD can take raw
information from the following sources:

- The construction elements placed in the project.
Construction element information includes the size,
surface, volume, ID number, and the attributes and
parameters defined for the elements in their settings dialog
boxes or through graphic input.

- Calculation Databases organized by Keys and containing
Components, Descriptors and measurement Units.
Construction elements refer to these data either through a
selection of criteria or individually.

- Property Objects assigned to construction elements.
Property Objects are special GDL Object-type files without
a 3D Script or a 3D view. Property Objects can include
references to databases as well as Component and
Descriptor data explicitly defined for that individual item.
Property Objects are generally used to describe specific
structures for the purposes of calculation: for example, the
quantities and the detailed description of reinforced
concrete beams used in the project.

Components can either be the material ingredients (steel,
concrete, etc.) of a structure, or anything (price, man hours,
etc.) that can be measured in proportion to elements of the

structure type. Each Component has a name, a code, a
quantity definition, a unit and a reference to its proportion to
related construction elements.
Descriptors are text elements related to structure types, e.g.,
finishing, security, shipping, assembly or handling
information. Descriptors are simply displayed in reports:they
are  not used in calculations and are not linked to
components or element parameters. Each Descriptor has a
name (also called short text), a code and the full description
(long text).
Properties can be associated with construction elements
either through criteria or individually. Each Property Object
can be linked to a unique combination of element selection
criteria, e.g., the Property Object called “Concrete Wall.gps”
can be associated with all walls of concrete block fill that are
drawn in pen No.12 and placed on the “Exterior Walls” layer.
When this option is active, ArchiCAD filters the project’s
construction elements and automatically links the Property
Object in question to all elements matching the given Criteria.
Criteria sets are saved within the active Library so that they
can be used in multiple projects.

You can also choose to assign Property data directly,
individually for each element. In this case the link is
established manually item by item in the Listing and Labeling
panel of each eligible element’s Settings dialog box.
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Calculation Setup
The sorting and analyzing of data, the calculation of required
results and the formatting of reports are all done in
accordance with the configuration of the selected List
Scheme. List Schemes are predefined sets of instructions on
how the ArchiCAD listing engine should process project
information to present the required results. List Scheme
formats can be of two types:

- Plain Text reports display calculation results in editable
tabulated text format. The reports appear in text windows
and can be saved as spreadsheets, text files or HTML files.

- Graphic outputs allow for both alphanumeric and image
information, including element symbol drawings, logos and
other bitmaps. Graphic output reports can be saved as RTF
List files, ArchiCAD Project files or PlotMaker documents. It
is also possible to copy all or part of these lists into an
ArchiCAD plan.

Though the contents of each language version are different,
some predefined list schemes are embedded in ArchiCAD and
available even if ArchiCAD is running without an active
Library.
In ArchiCAD's default state, you only have access to the listing
commands themselves. The tools needed to edit the database
(Keys, Components, Descriptors, Units), to establish links
according to criteria and to customize List Schemes can be
activated in Options/Preferences/Imaging and
Calculation.

Choose the level of expertise that you need. If you need to
define custom data or assignments, read the detailed
instructions in the ArchiCAD Calculation Guide in the More
Information section of Chapter 10: Project Data Calculation
in ArchiCAD Help.

List Types
ArchiCAD can generate three types of calculation reports:
Element Lists, Component Lists and Zone Lists.

Element Lists are best used when creating schedules and
inventories, and to display the parameters of construction
elements in a project.

To generate Element Lists, ArchiCAD filters the project or the
selection set for construction elements according to the
configuration of the selected List Scheme. Elements matching
the filter settings will be listed together with element
Parameters, Components and Descriptors, if so defined in the
List Scheme.
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Component Lists are generated when bills of materials,
quantity takeoffs or price lists are required. These reports
typically sum up and display component type properties;
however, certain element parameters can also be listed.

Zone Lists are generally used to create room schedules and
finish schedules. Zone Lists can include parameters of Zones
and related construction elements. When related construction
items are listed, the report is in fact an Element List where the
range of calculated elements is limited by the Zones they
belong to.
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Displaying Lists
Lists are displayed in separate windows. ArchiCAD has a
window for each of the basic list types: Elements,
Components and Zones.

Each time you activate a list type window, its contents will be
updated.
You can access the list windows from two locations:

- By using the commands of the List Elements, List
Components, List Zones hierarchical menu in the
Calculate menu;

- By double-clicking the appropriate item in the Navigator
palette's Project Map view under Lists.

 

The range of elements that will be used in calculation
depends on the current selection made on the Floor Plan.

- If there is no selection made, all elements will be used and
filtered by the listing command's List Scheme by type or
other criteria;

- If there is a selection made, only selected elements will be
used.

For more specific element ranges, use the Setup List Schemes
command and define filters.

When you activate a list type window while elements are
selected in the project, there may be a conflict between the
listing command's criteria and the selection. (For instance, if
you choose a Window schedule when the current selection
also contains Walls and Doors.)
In the Preferences/Imaging and Calculation dialog box in
the Options menu, the Selected Elements to be Calculated
pop-up menu offers three options for managing this situation.

- If you choose the List All option, all the selected elements
will be calculated in the list, even though they do not
correspond to the filtering criteria.

- If you choose the Use Filters option, the filters defined for
the list scheme will be applied to the selected elements;
elements that do not correspond to these criteria will be
ignored.

- If you choose the Show Alert option, a warning of
conflict will appear. You will then be able to choose
between the two options described above.
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Element Information
The Element Information Palette displays information
about the dimensions of element(s) selected on the Floor
Plan. With this feature, you can get instant feedback on some
simple quantities that do not appear in the elements' settings
dialog boxes, without having to use any listing commands.
The Information Content buttons in the top section of the
palette define what information will be shown. If none of the
buttons is active, only the number and type of the selected
elements is displayed.

The six buttons display, from left to right:
- ID, Layer and Linked Property information;

- Length, circumference and thickness values;

- Area values;

- Height values;
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- Surface values;

- Volume values.

You can combine these pieces of information and save and
print them by choosing from the pop-up menu commands in
the top right corner of the palette.

ID Management
The ID field is located on the Listing and Labeling panel of
all construction element type tools as well as the Fill and
Zone tools.

   

The ID serves to identify and group elements in list views.
You can also use the ID in the Label associated to elements.
The text string within the ID field cannot exceed 15
characters. Any character can be used.

Note: All construction elements also have a unique,
automatically generated, internal ID which is conserved
throughout the life of the Project. You can also use this
identifier for labeling or in lists.

Filtering or grouping elements by their IDs is used by many
List Schemes. Totals obtained in calculations can refer to
elements that have the same ID. Therefore, the content of the
ID may be significant.

- If a number is included anywhere in the ID field, drawing
successive elements will add one to this number for each
new element, provided that the Auto ID Increase
checkbox is enabled the Options/Preferences/
Miscellaneous dialog box. If there is no number in the ID
field, each new element of the given type will have the
same ID.

- If elements are duplicated or multiplied, the IDs of the
replicas will remain the same as those of the originals.
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- If you paste elements into a Project, you may have
elements with conflicting IDs.

- When working on a shared Project (Teamwork),
Teammates working in different workspaces may also
generate dissimilar elements with the same ID.

The Element ID Manager command in the Calculate menu
allows you to set the ID numbers of the project's elements
based on their characteristics (attributes). You can also use it
to modify automatically generated ID numbers. Settings can
be saved and stored for future use.

The configurations you create and save with the Element ID
Manager help you prepare Project elements for a clearer
reading of quantity takeoffs.

Note: This command is only available when viewing the
Floor Plan Worksheet.

When you choose Element ID Manager in the Calculate
menu, a dialog box appears.

On top of the dialog box, a pop-up menu lists the different
settings you saved for the different element types. You can
define several settings for any element type, or simply work
on the current element choice. The Edit Settings pop-up
allows you to save, rename and delete settings.

Note: To change a saved setting, select and edit it, then
save it again under the same name.

The dialog box includes two tab pages: Grouping Criteria for
defining attribute choices, and ID Format for defining custom
ID sets.

When the Grouping Criteria tab is active, the pop-up under
the tabs allows you to choose an element (Tool) type.

In the top right corner of the dialog box, the figures show
how many of the Project elements belong to the active
element type.

- If any elements are selected on the Floor Plan, Element ID
Manager works on selected elements only. In this case,
two figures are displayed: the number of selected elements
and the number of elements of the active type.

- If nothing is selected on the Floor Plan, the command
works on all placed elements.

The list on the left contains the criteria that can be chosen for
the given element type. This list is the same as the one used
by the Find & Select command.

Select the criteria you need in the list and click the Add
button. This will place the selected criteria in the list on the
right.
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Elements that have the same grouping criteria will get the
same ID.
When you're finished choosing criteria, click to open the ID
Format tab page, which allows you to define custom ID
Formats.

ID's can contain up to 15 characters or numerals. Element ID
Manager allows you to subdivide the ID into four parts.

For any of the parts, you can type plain text, a counter or a
story number into the ID Components field. You can also opt
not to use one or more of the four parts.

- When choosing the Text type, you can type custom text
up to the number of characters defined.

- When choosing the Counter type, you can type either
numerals or letters such as "aa" that will change
incrementally in the ID.

- When choosing the Story No. type, you cannot enter
custom text; the ordinal number of the story will be used.
Note: Story No. is only available as a type if you've
selected "Story" as a Grouping criterion.

When you have finished configuring the settings and ID
formats, click the Change ID's… button in the bottom right
corner of the dialog box.
The Element ID List dialog box appears.
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You can validate the changes made by clicking OK or return
to the configuration dialog box by clicking Cancel and make
further adjustments.
You can save your settings using the Edit Settings pop-up
menu on top of the dialog box.

The name of the saved set then appears in the Settings field
and can be accessed at any time from that pop-up menu.
These settings are saved by ArchiCAD in a separate file and
can be reused for further Projects, even after choosing New
and Reset.

Creating an Interactive Schedule
ArchiCAD allows you to create simple tabular schedules with
bidirectional update capabilities. In the resulting schedule,
you can summarize and check element data and modify some
of the values of the elements concerned.
The Interactive Schedule hierarchical menu located in the
Calculate menu has two commands: Preview and Settings.

- The commands are available only when the Floor Plan
worksheet is active.

- The commands work on either selected elements or on all
visible elements that conform to the current settings.

- The output is either a list type window or a spreadsheet
placed on the drawing. On Windows only, you can also
obtain the list in Excel and Word format.

Choosing the Settings command opens the corresponding
dialog box where you define the data you wish to display.

When first opening the dialog box, you view the Default
Setting, as shown in the pop-up menu at top left. All setting

controls in the bottom section are grayed, as these default
setting cannot be edited or deleted.

With the three buttons under the pop-up, you can duplicate
the Default Setting and then edit it. All manually created
settings can be duplicated, renamed or deleted.

Settings are stored as individual files in a folder called by
default IS_Settings and located in the current user's
Preferences folder. The path of this folder is indicated in the
top right corner of the dialog box.

With the two buttons below the path name, you can switch to
another folder and copy saved settings from other locations,
include Door and Window Schedule Settings created with
previous versions of ArchiCAD.

When you have duplicated the Default Setting and named it,
the bottom part of the dialog box becomes active. It has four
tab pages for configuring the Interactive Schedule: General,
Fields, Format and Schedule Element.
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The General tab page contains the essential options for the
Interactive Schedule.

On the right, the Criteria list is shown. Those criteria will be
used for filtering the elements to include in the schedule. To
enter a criterion, click the Add button below the list.

Click a criterion line to select it. The selected criterion can be
deleted from the list by clicking the Remove button under the
list.
If a criterion is selected, its field items become active. As in
other parameter lists, arrows can be used to pop up the list of
eligible names, conditions and values for the given
criterion. In the case of value type criteria, you can enter any
value.

 

 

At the right end of the selected line, the + button allows you
to duplicate the given criterion and set further conditions and
values.
You can set several different values for the same criterion
type.

- Values chosen in a pop-up list will be added to each other.
For example, if you have selected the Element Type
criterion name and set it first to Wall type, then added
Object type, both Walls and Objects will appear in the
schedule.

- Specific discrete values entered in the numeric field will
also all be taken into consideration. For example, if you
have selected the Story criterion name and set two
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different values for it, elements on both of these stories
will appear in the schedule.

The list of eligible criteria is filtered by the Element Type
criterion. If you have defined a specific element type and then
click the Add button, you will see that only the parameters of
this type of element can now be selected.

 

Deleting and changing criteria may result in invalidating
already defined ones. If, for example, you have chosen
criteria specific to an element type (such as the Core Fill of a
Column) and then deleted the Element Type criterion, the
corresponding criteria will be grayed and can only be deleted.
If you have selected a GDL Object type of element (Door,
Window, Object, Lamp, Zone), or set only general criteria
such as Layer, Story, Element ID, etc. without selecting
Element Type as a criterion, the Additional Parameters button
at the bottom of the list becomes active.

Clicking this button opens the Select Additional
Parameters dialog box. It will list all the loaded Libraries
with their elements.

Check those Library Parts whose parameters may be needed
for filtering the Schedule. On the right, you can pick the type
of parameters (length, angle, integer, real number, etc.) to
show. Then, in the list generated at the bottom part of the
dialog box, check those parameters that you actually want to
use as filters.

Note that explicit selection made on the Floor Plan may
further restrict the elements to include in the Schedule.
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With the controls on the left, you can decide whether to list all
items one by one or to unite identical items in a single record.
Items are considered identical if all of their criteria defined on
the right are identical. This means that increasing or
decreasing the number of criteria will influence whether two
items are identical in those respects or not.
You can also display the records of the Schedule horizontally
(by rows, default setting) or vertically (by columns).

On the Fields tab page, you can adjust the way the
parameters will be displayed in the schedule.

On the left, available parameters are organized in a tree view
by element types. Click their checkboxes to select the
parameters to include. Checking a type will check all its
subsequent parameters. Additional parameters of Library parts
can be selected by clicking the Additional Parameters... button
below the list (as on the General tab page described above).
The selected parameters will be added to the Parameters to
List field on the right, where you can then select single
parameters. You can reorder the list by dragging the selected
parameter into its new position. The order of parameter
determines both the appearance and the sorting order of the

records in the schedule: they appear in the same order as in
the list and will be sorted by the first parameter, then by the
second one and so on.
Note that only parameters that appear in blue in this list can
be edited interactively from within the Schedule. Parameters
that appear in black can only be modified graphically in the
construction windows.

The three controls at the end of each record line allow you to
define sorting options (ascending or descending) and
summing options (count, summarize values) for the selected
parameter, and to define where to include subtotals (if any) in
the schedule. Parameters can be deleted from the list by
clicking the Remove button.

With the controls on the right, you can customize the
appearance of the selected parameters. Cell and Header
styles and alignment can be set, as well as a custom header
name. You can also use the first parameter of the list as a
subtitle in the Schedule.

On the Format tab page, you can customize the output.

On the left, you can set the default column width of the fields
and the pen color that will be used. Note that if you have
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chosen to display the Schedule by rows, you can change the
width of each column individually when previewing the
Schedule. Below you can choose a font, a text size and a
color for any of the schedule components (header text,
headline text, value text, total text, grand total text) and a line
type and a pen color for any of the schedule's graphic items
(header border, headline border, value cell border, total
borders, grand total borders). These settings are applied to all
Schedules, whether they will be generated in the ArchiCAD
List window or placed on the Floor Plan as an Object.

The controls on the right-hand side of this tab page allow you
to format the pages of the schedule by defining the page size,
the text color used and the items automatically placed in the
footer, such as the current date and time, the project's name
or the page number. These settings only apply to the output
in the ArchiCAD List window.

On the last tab page of the Settings dialog box called Schedule
Element, you can choose a Layer for the Schedule Object and
decide whether the footer should be displayed or not.

When you have finished defining the settings of the schedule,
click OK to close this dialog box.

To actually create the schedule, you first need to choose the
Preview command in the Calculate/Interactive Schedule
hierarchical menu.
A dialog box opens, showing a preview of the schedule. On
top of the dialog box, you can choose from the list of defined
settings.

Note: You can also access the Settings dialog box from
here by clicking the button at top right.

Before actually creating the schedule, you may want to make
the headers more informative by customizing them or edit
some of the values in the list.

Below the Schedule Settings pop-up menu, the header area
is displayed. By default, every parameter chosen to appear in
a column is a header name, but this can be customized on the
schedule editing dialog box's Fields tab page, in the Custom
Header text field. Moreover, you can edit the header in the
preview dialog box with the Edit header pop-up menu and
with a number of shortcuts.

Editing shortcuts:

- Shift-clicking a header selects it.
- Control-clicking (Windows) or Command-clicking

(MacOS) a header makes its name editable.
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- Put the cursor at the joining points of two headers to resize
columns (as you would in a spreadsheet editor).

The Edit header pop-up menu allows you to:

- Insert a higher-level header above the selected columns that
you want to merge (you can select columns by shift-clicking
their headers). You can insert up to four header levels.

- Delete a selected header.
- Delete all headers below the selected one.

- Edit the text of the selected header.

- Set the Bold or Italic style for the selected header.

- Open the Header Properties dialog box.

To edit list items, first select a row by highlighting it. Editable
items appear in blue.

You can make changes by choosing from pop-up menus or
entering data in text or numeric fields.

When you have finished editing the list, click the Apply
Changes button on the right. The elements will be updated
accordingly in the construction windows.

You have two options for displaying the schedule: you can
either open it in a non-editable list type window, or place it
on the Floor Plan. You can also save the Schedule in a tab-
separated text file.

In Windows only, you can also export and display Schedules
directly in Microsoft Word or Excel, provided that MS Office is
installed on your computer.

To display the schedule as a list, choose the ArchiCAD List
window item from the Output to menu on the right, and click
the Create List button.

If you want to place the schedule in the Floor Plan, click the
Place button.

If you have already placed and selected a schedule on the
plan, the Update button also becomes active and you can
click it to update the placed schedule.
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Chapter 11
Menu Command Reference
This chapter reviews the commands available through the ArchiCAD menubar. It provides a short description of each command
and either describes the function or else refers you back to the sections in other chapters that detail these functions.

ArchiCAD Menus
The ArchiCAD menubar includes the following menus:

- The File menu contains the commands that operate on the
file system, including opening, saving, managing and
outputting documents and views.

- The Edit menu contains the basic editing commands with
which you can modify or transform selected elements on
the worksheet.

- The Tools menu commands handle grouping and locking
as well as operations on elements of specific types. It is
also the default location of a large number of external
commands (Add-Ons).

- The Options menu affects the organization of the project
and the appearance of the various elements.

- The Image menu is dedicated to commands related to 3D
views.

- The Calculate menu is the starting place for database
management and the quantity listing commands.

- The Teamwork menu handles all functions connected to
shared projects.

- The Display menu commands allow you to navigate
inside the active window and to refresh its contents.

- The Window menu activates the various windows and
palettes of ArchiCAD.

- The Extras menu contains a number of complex tools.

- The Help menu accesses the on-line documentation,
program information and relevant websites.

Some of the menu commands appear in relevant locations
grouped in context menus.

File Menu Commands
The File menu commands allow you to open, save and merge
files, manage external files and output documents in various
formats.
Note that the availability and the function of some of the
commands depends on the currently active window.

New

Choosing New opens the New Project dialog box in which
you can choose whether to keep the latest used settings, use a
template file or revert to ArchiCAD's default settings.

Since ArchiCAD keeps only one Project open at a time, the
current Project will be closed. If you have any modifications
not yet saved in the opened file, you will be warned to save
them.
If you keep the Alt key pressed when choosing the New
command, its name changes to New and Reset and
ArchiCAD will automatically use the default settings.

See Chapter 6: Project and Program Customization for details
on which settings are preserved in various situations.
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Open...

The Open command allows you to open documents of the
types recognized by ArchiCAD. The sections below detail the
file types that can be opened in the ArchiCAD main window.
Some additional remarks:

- The command is not available if the active window
belongs to an open GDL Object.

- Various types of picture files can be opened as model
pictures, but they will appear in their own separate
windows, not the ArchiCAD main window. All QuickTime
based image files and a number of additional formats are
available.

- You cannot open Shared (Teamwork) Projects directly.
Choose the Teamwork/Sign In command to work on
such files.

- Opening a Backup Project file (.bpn) allows you to
recover the last saved version of a damaged project file,
provided that the Make Backup Copy checkbox is active
in Options/Preferences/Data Safety.

ArchiCAD Projects

Files created with File/New are "solo" Projects  (.pln). This
type of document is the main native document type of
ArchiCAD. It includes all model data and the views generated
for the project, as well as the default settings, attributes and
library references.

When opening a Solo Project, all windows of the current
Project will be closed, and you will be prompted to save any
modifications if necessary.
If you open a Project file and the Status Report Palette appears
with a listing of missing items, this means that the Library
used when creating the Project is not available. This usually
happens when you open the Project on another computer. To
make sure that no files are missing, it is recommended to save
Projects in Archive format before moving them to another
computer. Another solution - inside the same office - is to use

a common standard library that is continuously updated on
each computer.

Solo Projects can be transformed into Teamwork Projects
(.plp) by sharing them.

Archive Files

Archive (.pla) files  are similar to Solo Projects, but these
include all the library parts used in the Project, not only
references to them. To save a Project in the Archive format,
use the Save as... command presented later in this section.

When you open an Archive type document, the Open
Archive Project dialog box appears.

You can choose one of the following three options:
- Read elements directly from archive - this means that

the library parts will not be extracted from the archive file.
You can instantly access the embedded elements, but you
cannot edit them. This also applies to list schemes used in
calculations. This method saves a lot of disk space, but
limits the modification possibilities.

- Extract elements to a new folder - the external library
parts required for the project will be extracted from the
archive and placed in a new folder that you can name.
This solution is recommended if you need to actually work
on the GDL Objects of the Project.

- Select a library - instead of extracting the library parts
saved with the project, you can indicate a folder that
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houses the required elements. This solution is
recommended if you wish to update the Project's GDL
Objects with their latest versions.

Teamwork Draft Files

Teamwork Draft (.plc) files  are created from a Shared
Project by signed-in Team Members by saving a local copy of
the Project on their own computers. Drafts are identical with
solo Projects in most respects, but they still contain the sign-in
and reservation details.

When working off-line, it is recommended that Team Members
save a Draft Archive (.pca) file  that will contain all of the
shared project's library parts (see Archive Files above). Opening
a backup file is also available for Teamwork Drafts (.bpc).

Project Template Files

When selecting a template file (.tpl), you can edit it and
resave it. To open a copy of the template, choose the New
command and select the Template option.

For more information about the settings that can be included
in a Template file, see Chapter 6: Program and Project
Customization.

2D Line Files

2D Line files (.2dl) are vectorial drawings saved from
ArchiCAD's 3D Window or a Section/Elevation window.
These drawings contain no model information and can be
touched up in the Floor Plan worksheet with the 2D tools.

Module Files

Module (.mod) type files  are a simplified ArchiCAD file.
They contain no Section/Elevation data, active Library or
preferences information and only refer to attributes actually
used by their elements.

See also the Merge and Save commands below and Hotlinked
Modules in Chapter 9: Collaboration and Connectivity.

Opening Projects through a Network

If the file that you wish to open is already in use by someone
else on the local network, ArchiCAD will warn you about this
and let you know the name of the user, that is, the name
defined in the Sharing Setup Control Panel (Macintosh) or as
the User Name (Windows). In this case, you have the
following choices:

- cancel opening the file;

- open the file as read-only;
- open the file with full access.

If you choose to open the file as read-only, you can see and
modify the whole file, but you can only save it under a
different name or into another location. If you try to overwrite
the original file, you will again be notified that it is in use and
that you cannot replace it with your modified Project.

You can also choose to open the file with full access.
However, you should be very careful about using this option.

There are a number of reasons why ArchiCAD may state that a
file is in use although it actually is not:

- The person who last used the file did not properly open
and close the file in ArchiCAD, e.g., because of a system
crash.

- You have made a copy of a file that was in use at the
moment, and the copy of the file also includes the name of
the person who was using it during the copying operation.

Note: If you do open a file with full access while another
person is using it, you will both overwrite each other's
work without getting any further warning message from
ArchiCAD. Therefore, be extremely careful when opening
a file with full access in any situation other than the
emergencies mentioned above.

Merge…

The Merge command allows you to paste the elements of
another Project, a Module or a picture file into either the
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current Floor Plan, the currently open Section/Elevation or
Detail Drawing window.

Merging another Project or a Module is a complex
procedure since ArchiCAD has to match the stories of the
merged (imported) file to the current (open) one. When you
merge a multistory building into your current plan, ArchiCAD
will ask you to define which story from the imported file will
match the story you are working on, and it will also suggest a
possible match. If you do not have enough stories in your
current plan to accommodate all the merged ones, ArchiCAD
will automatically create the missing stories.

Since attributes (Layers, Materials, Line Types, Fill Types, etc.)
are identified by their names, the following rules are
observed:

- If the name of the attribute is the same in the two Projects,
the merged (imported) elements will inherit the attributes
of the current Project.

- If the name of an attribute for the merged Project is not
present in the current one, this attribute is appended to the
current Project's attribute set to accommodate the new
names.

When merging a Project or Module, you can drag, rotate and
mirror it before placing it to the final location. The elements
will be surrounded by a dashed rectangle. Click within the
rectangle to move the elements to the desired position. Click
outside the rectangle or click OK in the Control Box to place
the elements.
The elements of the merged files will become independent of
each other after being placed. You can place the same
elements repeatedly with the Paste command.

Note: When merging a Module into a Section/Elevation
Window, only 2D Elements will be pasted.

See also the Save command below and Hotlinked Modules in
Chapter 9: Collaboration and Connectivity.

Choosing from the image file types in the Merge dialog box
gives you access to:

- Documents created in other drawing or painting programs;
- 3D views and elevations saved in picture format;

- PhotoRenderings saved only in picture format.
If you merge a document created with a drawing program,
you will be prompted to choose whether to paste its contents
as drawing elements or a unified bitmap.

- Choosing the drawing elements option means that you
will obtain separately editable ArchiCAD drawing elements
(Lines, Arcs, Texts and Fills) that are scaled according to
the current Floor Plan Scale chosen in the Options
menu. For example, if the scale is set to 1:100, a 10 cm
long line of the picture file will be interpreted as 10 m long
by ArchiCAD’s world coordinates. The merged elements
are placed by default on the appropriate tool's default
Layer. This format is recommended when importing
architectural drawings or symbols created in a drawing
application.

- Choosing the single Figure option will insert the merged
picture as a unified bitmap. It will be pasted pixel by pixel
in the current zoom of the ArchiCAD window, regardless
of the current scale. The merged element is placed on the
Figure tool's default layer. This format is recommended for
illustrations.

Before choosing Merge, you can define the size of the figure
on the worksheet in advance by choosing the Marquee tool
and drawing a selection rectangle of the desired size and
position. The figure will fit into this rectangle.

Note: Be careful to draw the rectangle with the same
proportions as the original picture, otherwise the figure
will be distorted.

Close

Choosing the Close command closes the active window.

- If you close the Floor Plan worksheet, you close the entire
Project. You will be prompted to save recent changes, if
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any. External files (GDL Object windows, pictures) will
remain open.

Note: If you are Signed In to a shared Team Project and
have made changes to it, choosing Close will prompt you
to either Sign Out (and send in your changes) or save a
local Draft copy that will contain these changes.

- If you close the Master Window of a GDL Object (Library
Part), all of the other windows of the Object will also be
closed. You will be prompted to save changes, if any.

Save

The effect of the Save command depends on the currently
active window.

- Choosing Save when the Floor Plan worksheet or a
Section/Elevation window is active saves the Project. If the
Project is as yet untitled, you will be prompted to name it.
Note: If you are Signed In on a shared Team Project, you
will be prompted to save a local Draft copy of the shared
Project.

- Choosing Save when a PhotoRendering window is active
will prompt you to name the image file that you will save;
the Project remains unaffected.

- Choosing Save when a GDL Object window is active will
save the Object; the Project remains unaffected.

The Save command is dimmed when viewing the 3D Window
or a List type window.
Shared Team Projects are saved every time a Team Member
makes changes to it by signing in or out, sending and
receiving changes, modifying passwords, etc.

Save as...

Choosing Save as allows you to save the Project under a new
name, archive it or export the current window's contents in a
variety of file formats. Some of the available options may
depend on the set of currently loaded Add-Ons.

When working in the Floor Plan worksheet of a solo Project
or a Teamwork Draft, you can save your project as:

- A Project under a new name (the new Project will remain
open).

- An Archive that includes the Library items the Project
refers to (see details below).

- A Project in an earlier ArchiCAD file format.

Important: When choosing one of these earlier formats,
an alert will appear, warning you that elements and
information not supported by these previous ArchiCAD
versions will be discarded.

- A Project Template.

- A Module.
Note: If you have selected elements in the worksheet, you
can choose to save a Module that will include those
elements only by choosing the Clipboard as Module
format. You can copy elements from several stories by
using the Marquee tool's multistory option.

- A drawing file in PlotMaker format.

- A GDL script describing the entire Project.
- A picture in a large variety of common formats.

When working in the 3D Window, you can save the 3D view
as:

- A drawing file in ArchiCAD 2D Lines or PlotMaker format.
- A picture in a large variety of common formats.

When working in a Section/Elevation window, you can
either save:

- The entire Project in the same formats as from the Floor
Plan worksheet.

- The contents of the current window in a variety of
common picture and drawing formats.

PhotoRendered Model Pictures can be saved in all
QuickTime based image file formats as well as in WMF and
EMF (Windows only) format.
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Basic Element, Component and Zone Lists can be saved as
Plain Text, Tabulated Text or HTML tables, while formatted
lists including graphic information can be saved in .rtf (Rich
Text Format), ArchiCAD Project or PlotMaker drawing format.

Saving Archive Projects

ArchiCAD Projects may refer to a number of items called
Library Parts, stored as outside files in Library folders or
directories. If you want to ensure that all files referenced in
the Project are included, you should save the project as an
Archive. Documents saved as Archives are stored together
with all the Library Parts and properties contained by and
defined with the Project.

Warning: If any Library Part of your Project is missing
from the current Library when you save the Project as an
Archive, it will not be included in the Archive document
either.

The Archive format is recommended for:

- Moving a Project to another computer;
- Storing the completed Projects.

If you choose the Archive format in the directory dialog box
when saving the project, an Options button appears. Clicking
it opens a dialog box, in which you can specify which types
of library parts should be included in the archive. You can
also decide to save the entire library with the Project, even
those elements that have no placed instances.

Because of the larger volume of information it stores, an
Archive file is somewhat larger than the corresponding Project
document.

Important: Archives cannot store the descriptions of fonts
used in the Project. This means that if you wish to display

textual information the same way as it appears in the
original environment, you have to install the appropriate
fonts.
Archives cannot store any Add-Ons that affect the placed
elements.

Modules and XREF's

The commands of this hierarchical menu help you manage
linked files of different types. See Chapter 9: Collaboration
and Connectivity for details.

Show/Hide Mark-Up Tools

This command opens the Mark-Up Tools palette. See the
description of the entire Mark-Up process in Chapter 9:
Collaboration and Connectivity,

Publisher

The Publisher function allows you to publish (print, save,
upload, plot) 2D, 3D and listing aspects of your Virtual
Building. See the description of the entire process in Chapter 9:
Collaboration and Connectivity.

Project Info…

This command displays editable information about the
currently opened Project.
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Library Manager...

This command allows ArchiCAD to access complete Libraries
and individual Library Parts both from local volumes and
through the Internet. See the complete description of Library
handling in Chapter 7.

GDL Objects

This hierarchical menu contains all the commands relative to
GDL Objects, including the creation of new Objects and the
editing of existing ones. See Chapter 8: Working with GDL
Objects for full details.

Plot Setup…/Plot…

With these commands, you specify the plotter driver, paper
size and other characteristics of your plotter output and start
plotting your project. See Chapter 13: Printing and Plotting
for details.

Page Setup…/Print…

With these commands, you define the page size, orientation,
and other features of printed documents, set printing
parameters and start printing your project. See Chapter 13:
Printing and Plotting for details.

Recent Documents

This menu item lists the last opened documents for easier
access.

Exit/Quit

Choosing the Quit (MacOS) or Exit (Windows) command
closes all ArchiCAD windows and exits the program. The
command can be chosen from any display mode and a
warning message is displayed prompting you to save changes
before quitting.

Edit Menu Commands
In addition to the standard editing commands (such as Undo/
Redo, Cut, Copy, Paste and Clear), ArchiCAD’s Edit menu
contains more sophisticated transformation commands and
options for editing text windows.
The Edit menu is available for all edit window types (Floor
Plan, 3D Window, Sections/Elevations, Scripts), but its
actual contents changes according to the type of Window you
are currently viewing.

Undo/Redo

The Undo and Redo commands allow you to undo (revert to a
previous step) and redo a large number of construction
operations. The name of the command to be undone is
displayed in the menu along with the Undo or Redo command.
This capability also allows you to test tentative solutions by
trying them out until you arrive at the desired result.
The number of steps that can be undone and redone (from 1
to 99) is set using in the Preferences/Data Safety dialog box
in the Options menu. The default value is 20. After redoing a
series of steps, Undo will only be available when you
complete a new undoable action.
In text type windows, only the last editing step can be
undone/redone.

Note: Each time you save the Project, your previously
available Undo steps will be cleared. You do not need to
save repeatedly in order to survive a system crash as in
many other applications, since ArchiCAD’s Autosave will
save your Project in case of a crash. Autosave does not
clear the undoable steps.

See also Autosave in Chapter 6: Project and Program
Customization.

Repeat (Last Command Name)

Choosing this command repeats the last editing command if
applicable.
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Cut

The Cut command removes selected elements from a Project
and places them on the Clipboard for future use via the Paste
command. It can also be used for dialog box or Coordinate
Box numeric field contents. Cut can be used in construction
or text editing modes. The part of the drawing to be cut is
determined by the selection you have made.

Note: The Cut command is not available in the 3D
Window.

You can cut any element from a Section/Elevation Model
Window. The element removed is placed on the Clipboard
and the change can immediately be seen on the Floor Plan.
Cut elements can only be pasted in the form of fills and lines,
either on the Floor Plan or in a Section/Elevation Window.
You cannot create new construction elements in Section/
Elevation Windows using Cut/Paste.

In Text type windows, you can use the Cut command as in
any word processor.

Copy

The Copy command is similar to the Cut command. It puts
the selected construction or text elements on the Clipboard,
but the selected elements are not removed from the original
document.

You can copy any element from a Section/Elevation Model
Window, but you can only paste it in the form of fills and
lines, either on the Floor Plan or in a Section/Elevation
Window.
You cannot create new construction elements in Section/
Elevation Windows using Copy/Paste.
Unlike Cut, Copy can be used in the 3D Window to get
image data. If the 3D Window is active and a 2D selection
rectangle is drawn, choosing Copy will bring up a dialog box
in which you can specify which elements of the selection you
want to copy to the Clipboard.

- Painting Screenshot will copy the contents of the 3D
Window as a unified picture (Figure).

- When choosing Drawing, the resulting image will consist
of the parts described in the dialog box. The size of the
picture obtained will be equal to the size of the image in
the 3D Window. This is important when pasting the
copied parts into another application such as SuperPaint
or Photoshop.

- The Scaled drawing option creates an image that keeps
the sizes of the Floor Plan. If you paste a Side view of the
Project on the Floor Plan using the Scaled drawing
option, the sizes will match the sizes of the plan.

With the Elements to Copy pop-up menus you can define
which elements of the 3D View you want to copy to the
Clipboard.

      

Copying the shadows of top views can be useful if you want
to place accurate, measurable shadows on the Floor Plan.
Shadows and 3D hatching of orthogonal views add a further
touch of realism to elevation drawings.

In the lower part of the dialog box you can define whether to
save/copy invisible Polygons (for example, the polygon
elements of a window behind a wall) or only visible ones.
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You also have the option of copying the polygons with or
without frames.

   

You will see the Remove Redundant Lines checkbox if you
want to copy the selection in Drawing or Scaled drawing
mode from a wireframe or a hidden line picture. If you check
this checkbox, lines exactly on top of each other will be
omitted in the copied file.

Hint: If you want to copy the elements of the 3D
Window, e.g., for an elevation view, it is recommended to
use the Calculate split polygons and Frameless
options. However, split polygons may require a lot of time
and RAM.

Note: The Copy command can only be used in the 3D
Window for copying images with the 2D Marquee.

Paste

With the Paste command, you can paste the contents of the
Clipboard onto the current Project or a text Window. The
Clipboard can be used not only to hold ArchiCAD elements
for pasting, but also to import bitmap graphics and other
types of information.

See also the Merge command (File menu). Pasting Floor
Plan elements is covered in Chapter 4: Element Creation.

All elements generated from either type of Section/
Elevation Window (Model or Drawing) or from the 3D
Window will be pasted as fills and lines, either in the Floor
Plan or in Section/Elevation windows. You cannot create
new construction elements in Section/Elevation windows or
the 3D Window using either Cut/Paste or Copy/Paste.
When pasting pictures containing drawing elements from
another application, the following dialog box appears:

You can either paste the picture as a set of drawing elements
which are then interpreted by ArchiCAD as lines, text blocks
and fills, or as a single unit (Figure).
You can paste multi-line texts from word-processing
applications into ArchiCAD.

Clear

Selected items are removed from Project or text Windows
when you choose the Clear command. As opposed to Cut or
Copy, the cleared elements are not preserved on the
Clipboard. They are easily retrieved by Undo.
The keyboard equivalent of Clear is hitting the Backspace or
Delete key.
Clearing construction elements in any construction
window (Floor Plan, 3D, Model type Section/Elevation)
will also delete these elements from all the other
windows.

Note: Clearing any additional (i.e., manually added)
elements from a Section/Elevation Model window or
any elements from a Section/Elevation Drawing
window will leave all other windows unchanged.

Select All...

Choosing the Select All … command selects all the elements
of the currently active Window that have been created by the
currently active Tool in all visible layers. The name of the
active Tool is added to the Select All... command’s menu
title.

See also Selection in Chapter 5: Drafting and Editing
Techniques.
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Find & Select

With this command, you can search and select elements
based on a set of customizable conditions. The range of
available criteria depends on the selected element type.

See also Selection in Chapter 5: Drafting and Editing
Techniques.

Drag

The Drag command allows you to move any selected
construction element in the Project. See Chapter 5: Drafting
and Editing Techniques.

Rotate

The Rotate command allows you to rotate any selected
element in the Floor Plan or in the 3D Window, or to rotate
manually added elements in the Section/Elevation
windows. Even in the 3D Window, rotation is always
performed across a horizontal plane. See Chapter 5: Drafting
and Editing Techniques.

Mirror

The Mirror command creates a mirror image of any selected
construction element on the Floor Plan or in the 3D
Window. See Chapter 5: Drafting and Editing Techniques.

Elevate…

The Elevate… command allows you to move selected
elements vertically along the Z axis. See Chapter 5: Drafting
and Editing Techniques.

Multiply…

The Multiply… command creates any number of exact
copies of selected elements. See Chapter 4: Element Creation.

Stretch

The Stretch command is used to stretch or shrink selected
elements. See Chapter 5: Drafting and Editing Techniques.

Resize...

Choosing the Resize command allows you to enlarge or
reduce selected elements either through numeric input or
graphically. See Chapter 5: Drafting and Editing Techniques.

Split

This menu command allows you to split elements along a line
segment, arc or polygon edge. See Chapter 5: Drafting and
Editing Techniques.

Adjust

This menu command adjusts (extends or trims) the endpoints
of Walls, Beams, Arcs and Lines to a line or arc segment or
polygon edge. See Chapter 5: Drafting and Editing
Techniques.

Trim to Roof...

You can cut gable shapes from walls, beams, columns,
slabs and Library Parts (including doors and windows) to
fit under roofs. See Roofs in Chapter 4: Element Creation.

Trim Zone…

This command allows you to trim the 3D shape of Zones with
Roofs, Slabs and Beams. See Zones in Chapter 4: Element
Creation.

Solid Element Operations…

Construction elements can perform Boolean 3D solid
operations (subtraction, intersection, addition) on other ones.
See Chapter 5: Drafting and Editing Techniques.

Align 3D Texture

The orientation and origin of construction element textures
can be fine tuned with the commands of this hierarchical
menu. They are only available when working in the 3D
Window. See Chapter 5: Drafting and Editing Techniques.
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Edit Selection Set…

This command opens a dialog box which makes it possible to
edit specific attributes for a collection of dissimilar element
types simultaneously. See Selection in Chapter 5: Drafting
and Editing Techniques.

Tool Settings

This is a dynamic menu item, as its name changes based on
the current selection or active Tool.

- If no element is currently selected, the command opens
the settings dialog box of the active Tool with the default
settings.

- If one element is currently selected, the command opens
the dialog box corresponding to that element with the
settings of the selected element.

- If multiple elements are selected, the command opens the
dialog box corresponding to the element that was selected
last.

See also the description of the different tool settings dialog
boxes in Chapter 4: Element Creation.

Edit Menu Commands for Text Windows
When working in a text type Window, most of the Edit menu
commands change in order to provide you with basic word
processing features. These are Text Style…, Find &
Replace, Find Selection, Find Again, Replace Again, Go
To Line.

See the Editing Text section of Chapter 5: Drafting and
Editing Techniques.

In addition, some special commands are included for use in
GDL Script windows only.

Comment/Uncomment

These commands are available for the Library Part 2D, 3D
and Properties Script Windows only. They allow you to

change selected command lines into comment lines and vice
versa. The Comment command adds exclamation marks (!)
in front of selected lines, while the Uncomment command
removes them. This feature can come in handy when you
wish to visualize only a part of your script.

Hint: You can comment or uncomment the whole
contents of the Window by first choosing the Select All
command from the Edit menu.

Note: These commands are also available as shortcuts
 at the bottom of the text Window.

Increase Indent/Decrease Indent

This command will place/remove the number of spaces
defined in the Text Window Format dialog box for tabs at
the beginning of the paragraph.

Note: These commands are also available as shortcuts
 at the bottom of the text Window.

Check Script

With this command, you can check whether the syntax of the
GDL script in the active Window is correct.
If you wish to check all the scripts of the current Library Part,
activate its master Window before choosing the command.

Note: This command is also available as a shortcut at the
bottom of the text Window.

Open Debugger

This command is only active when a GDL Script Window is
in front and allows you to debug GDL Scripts. See the
description of the GDL Debugger Window in Chapter 8:
Working with GDL Objects.

Tools Menu Commands
The Tools menu contains a large variety of commands for
grouping, locking, transforming and labeling elements, and
for defining the order in which they are drawn on top of each
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other in the Floor Plan. The Tools menu also includes
productivity tools such as updating zone information, creating
automatic dimensions, searching and replacing text in
different types of elements, modifying walls and setting up a
structural grid.

In addition, the Tools menu contains the Add-On Manager
command allowing you to add and manage external functions
defined as ArchiCAD Add-Ons. Some of these Add-Ons may
appear in the Tools menu itself. See Add-On Management in
Chapter 6: Project and Program Customization.

Group/Ungroup/Suspend Groups/Autogroup

The Group command creates a new group with the selected
items. Elements of different types can be grouped together
and you can even group existing groups. Choosing Ungroup
deletes the group information from the selected items.

Suspend Group temporarily switches off all group
information, while the Autogroup toggle command allows
you to create elements that are automatically grouped.
See Groups in Chapter 5: Drafting and Editing Techniques.

Display Order

The commands of this group affect the way elements will
overlap each other on the Floor Plan. See Drawing Order in
Chapter 5: Drafting and Editing Techniques.

Lock/Unlock/Unlock All

The Lock command locks the selected items to prevent them
from being accidentally modified. Locked elements can still
be selected and used for relative construction, and you can
even pick up their settings through parameter transfer.

Note for Teamwork users: You can only lock items
which you have reserved. Locked items cannot be
reserved by others. The locking information is kept even
after you have signed out from the Teamwork Project.

The Unlock command unlocks the selected item(s). You can
only unlock items locked by you.

With the Unlock All command, you can unlock all locked
elements, even if they are not selected. You can only unlock
items locked by you. When signed in to a Teamwork Project
as the Team Leader, you can unlock all the elements locked
by any Teammate.

Magic Wand Settings…

This command affects the transformation of Arcs, Circles and
Splines into curved Walls or polygon-type elements. See
Using the Magic Wand in Chapter 4: Element Creation.

Create Patch…

With this command, you can save the area enclosed by the
2D Marquee as a parametric 2D Library element. You can
later use this to “sticker” your plans in order to provide the
necessary detail in Floor Plan and Section views while saving
time on modeling.
To create a Patch, enclose any area of the Plan or the
Section/Elevation window within a Marquee, and select the
Create Patch… command from the Tools menu. The dialog
box that appears will let you specify the location and name of
the created element.

If you check the Place Patch Now checkbox, you can place
the created element immediately after it has been saved.
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Note: Objects created this way will be enhanced with
parametric behavior, specified by a special template in the
ArchiCAD Library. If this template is missing from the
loaded libraries you will still be able to save patches, but
they will be plain stickers with no special intelligence. If
ArchiCAD fails to locate the Patch Template, it will notify
you, and you will have the option to either proceed or
cancel the operation.

See also Detail Drawings in Chapter 4: Element Creation.

Explode

Choosing this command will turn elements selected on the
current Story or in the current Section Window into basic
elements (Lines without arrowheads, Circles, Arcs, Elliptic
arcs, Splines, unframed Fills, single-line Texts). Original
elements are deleted from that location.

Exceptions:
- In Section/Elevation Windows, cut construction

elements cannot be exploded, since these cannot be
deleted in Section view;

- Zone polygons and Stamps;

- Section lines and Cameras;
- Basic 2D elements.

Some examples:
- Slabs, Roofs and Meshes are decomposed into lines.

- Walls and Columns are decomposed into Lines and
Fills. (Doors and Windows inserted into Walls are also
exploded.)

- Doors and Windows (if selected without the Wall they
are placed into) are decomposed as Library Parts and are
replaced by empty hole type openings.

- Dimensions are decomposed into Lines and the basic
elements of arrowheads (Lines, Circles, Arcs, Fills).

- PolyLines are decomposed into Lines and Arcs.

- GDL Objects are decomposed into basic 2D drawing
elements.

Note: If Autogroup is On, the exploded elements will be
created in grouped mode.

Line Extras

The commands of this hierarchical menu allow you to join
Line segments in different ways. See Splitting and Adjusting
in Chapter 5: Drafting and Editing Techniques for details.

With the last menu item, you can place lines on selected roofs
at specified height values. See Roofs in Chapter 4: Element
Creation.

Update Zones…

Choosing the Update Zones... command will adjust the
Zones to your updated design and alert you about any
problematic Zones that might have been created. See Zones
in Chapter 4: Element Creation.

Add-On Manager

The Add-On Manager allows you to load and remove external
functions called Add-Ons. See Chapter 6: Project and
Program Customization for the feature's full description.

Automatic Dimensioning

The Automatic Dimensioning hierarchical menu includes
two commands for creating automatic exterior and interior
dimensions associated to selected elements. See Dimensions
in Chapter 4: Element Creation.
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Smart Merge

Choosing the Smart Merge command allows you to
configure the way AutoCAD files are merged into ArchiCAD
Projects and what happens to elements that are modified or
deleted in either ArchiCAD or AutoCAD.

See also DXF/DWG in Chapter 9: Collaboration and
Connectivity, and the detailed options in the DXF/DWG
Conversion Guide available in electronic format as part of
your ArchiCAD package.

Create Stair Using Selection

Choosing this command allows you to create a new stair with
the StairMaker Add-On. It is only active if a Fill and a Line
representing the shape and the walking line of the stair are
selected in the Floor Plan. See Stairs in Chapter 4: Element
Creation for details.

Spell Checker

The Spell Checker command allows you to check the
spelling of your ArchiCAD project. The available features are
quite similar to those used by Microsoft Word. Spell checking
works on Text blocks, Zones, Labels, custom text entered into
Dimension labels, as well as on Door, Window, Object and
Lamp parameters.

See Editing Text in Chapter 5: Drafting and Editing
Techniques.

Secondary Dimensions

The Secondary Dimensions hierarchical menu allows you
to add metric unit equivalents to dimension values displayed
in feet and inches, and vice versa. See Dimensions in Chapter
4: Element Creation.

Modify Wall

Modify Wall is a hierarchical menu that allows you to modify
the thickness, the reference line position and the direction of

selected Wall type elements. See Walls in Chapter 4: Element
Creation for the commands' detailed description.

Search and Replace Text...

With this command, you can locate and modify texts in all
eligible types of elements in the Floor Plan and in Sections/
Elevations windows.

Note: In text type Windows, the Find & Replace…
command from the Edit menu offers similar functions.

See Editing Text in Chapter 5: Drafting and Editing
Techniques.

Structural Grid…

This command allows you to create a custom local structural
grid. Optionally, you can populate the grid with Beams and
Columns at grid intersection points.

The command is only available in the Floor Plan Window.
When you choose the Structural Grid… command, a dialog
box opens. Make the settings you need and click the OK
button.

A ghost form of the grid appears. With the help of the
zooming and panning controls, find the planned location of
your grid on the Floor Plan, and then click to place the grid.

           

The dialog box contains two tab pages for defining the grid's
form and look.
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The first tab page, Form and Size, allows you to choose
between creating an orthogonal (box) grid and weblike
(arced) structure. The available options are different for the
two grid types and will be discussed separately.

Some of the features are common to both box and arc forms:
- The grid can either be placed directly as defined or after a

rotation with the pair of buttons next to the Type buttons.
- Below the Type and Placement buttons, you can define

the Anchor Point of the grid, that is, the point by which
the grid will be placed on the Floor Plan.

   

Note: The Extension lines extend beyond the Anchor
Point. The length of these lines can be customized in the

Options subdialog box accessed from the Attributes and
Elements tab page.

- The Place Grid and Elements on all Stories checkbox
allows you to duplicate the grid on all the current stories
of your Project. If you want them to also appear on stories
that you create later, you will have to copy and paste the
placed elements from a story on which they appear.

Note: When there is only one story defined for your
Project, this checkbox is automatically grayed.

If you choose the Box Grid type on the Form and Size tab
page, the two fields on the right allow you to define the
horizontal and vertical spacing of the grid. Different values
can be entered between any two grid lines, and any number
of lines can be defined in either direction.
To enter new grid lines, click the Insert button. You can also
delete any of the grid lines.

- When no grid line is highlighted, clicking the Insert
button will add a new line to the bottom of the list.

- If a grid line is highlighted, clicking the Insert button will
add a new line below the selected one.

- If a grid line is selected, the Delete button becomes active,
offering the option to remove it.
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If you choose the Arc Grid type on the Form and Size tab
page, the Spacing area of the dialog box contains different
options.
On the left, you define gaps between circular grid lines, just
like you would define horizontal lines for a Box Grid.

On the right, you can define the angle value between radial
grid lines. Different values can be assigned to any gap.

The length of the Arc Grid's outer radius is defined by a
numeric field under the Anchor Point setting.
An alternate way of defining radial grid lines can be reached
by checking the Distribute box and entering the number of
lines in the Number of Axes field.
In this case, the Radial Grid Lines box is grayed and neither
the number of lines nor the angle values entered here
previously have any effect. The grid's width is placed
manually.

The second tab page of the dialog box - Attributes and
Elements - provides controls for defining the look of the
grid. These controls are almost identical for the two grid types
and will be presented together.
In the top left section of the tab page, you find familiar
controls for choosing attributes: line types, pen colors and
font types and sizes for the grid lines and markers.

Different pen colors can be chosen for the grid lines, the
marker text and the marker circles.
The grid structure is assigned to a single layer using the pop-up
menu in the bottom of the dialog box. The other placed
elements (Columns, Beams) will be placed on their default layer.

The bottom left section of the tab page helps you define the
way the grid axis lines are numbered.

The axis numbering pop-ups (Horizontal/Circular and
Vertical/Radial) offer a choice of options as seen below.

The Omit at Anchor Point checkboxes allow you to draw
the grid without a grid line at the previously set anchor point.
This can help you align grids that have different geometries,
without creating a common axis.
The Create Markers area in the main dialog box contains four
checkboxes with which you can customize marker placement
on all sides of the grid.
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The Options… button in the middle section of the dialog box
opens the Grid Options dialog box, with some additional
controls for the axes.

In the Range section, you can modify the prefix for both axes
and choose where to start the numeric or text numbering.
The numbering direction can also be defined here.

In the Extension section, you can define an additional
segment in all four directions.  This extension is only there to
help you better locate the markers attached to the grid lines.
No beams will be placed on it (see below).
In the Generate Elements area of the Attributes and
Elements tab page, three buttons are located on top,
representing the Column, Beam and Dimension Tools.

- Activating the Column button will add columns at every
axis intersection point of the structural grid.

- Activating the Beam button will add beams over all line
segments of the structural grid, with the exception of the
extension lines.

- Activating the Dimension button will place Dimension
Units between all intersection points. A value field below
the buttons allows you to define the gap between the
dimensioned element and the Dimension Line.

Note: Dimensioning is only available for linear segments.
Radial segments must be dimensioned manually.

All placed elements will use the current default sizes and
settings including the Dimension Tool's font type and size.

Note: If the Place on All Stories checkbox is active, the
Columns' height will be the elevation of the story and the
Beams will be placed on top of the Columns.

All the created elements will be placed Grouped. If you
Ungroup the structural grid, all of its elements can be edited
individually.
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Although the Structural Grid tool can only be used in the
Floor Plan to define grids, the generated column and beam
elements can be viewed in 3D and used for construction
purposes.

See also Grids in Chapter 3: Project Organization and
Navigation.

Interior Elevation

The Interior Elevation hierarchical menu allows you to
create interior elevations of Zones. The interior elevations will
appear in a new listing type window from which you can
copy and paste them on the Floor Plan or in a Section/
Elevation window.

- If you choose Create, interior elevations will be generated
for all selected zones, provided that a marker has been
placed in them. If no zone is selected, interior elevations
will be generated for all selected markers.

- If you choose Update, all existing interior elevations will
be regenerated using the current settings.

- Choosing the Settings…. command opens a dialog box
where you can configure default values and options for
interior elevations to be subsequently generated.

The Interior Elevation marker is a GDL Object. A number of
markers are available in the standard ArchiCAD library.

The marker's four cardinal points are enabled or disabled by
the four corresponding parameters, either as numbers
representing the four directions (0 means the direction is off)
or as a simple on/off checkbox.

The Interior Elevation command will create interior
elevations in the directions that are active.

An additional parameter in the Interior Elevation Marker's
settings dialog box allows you to choose between displaying
a normal or an outfolded (spread-out) elevation.

- The normal interior elevation is a section delimited by the
horizontal and vertical boundaries of the Zone. The
section line goes through the Interior Elevation marker.

- The outfolded interior elevation shows all the vertical
surfaces along the perimeter of the Zone.
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To create an interior elevation, you first need to define a Zone
delimited by the elements you wish to display and then place
an Interior Elevation marker in it.

Then, select the Interior Elevation marker. Choose between a
normal and an outfolded elevation by making the
corresponding parameter active or inactive. If you wish to
display a normal interior elevation, define the directions that
you wish to show by enabling or disabling parameters.
Choose the Interior Elevation/Create command.

Note: As the generated Interior Elevations are 2D GDL
Objects, you need select a location for storing them in one
of your active libraries. If you haven't defined a location
yet, the Interior Elevation Settings dialog box appears.
Click the Browse… button in the Storing Objects section.

The interior elevations will be generated in a new list type
window.

With the Marquee tool, you can copy the generated interior
elevations and paste them into either the Floor Plan or any
Section/Elevation window. The elements will be pasted as
lines and text.

Note: Clearing the Interior Elevation marker will also
delete the Interior Elevations, but they remain visible in
the list window until you close it.

If you choose Interior Elevation/Settings…, you can define
several options in the appearing dialog box.

On the first tab page, you can enter the text that you want to
show on the interior elevations. The pop-up also allows you
to insert the current Zone Name, Elevation Number, etc… into
the text. Set text attributes and text position on the same page.

On the Layout tab page, you can set the arrangement and gap
of the individual elevations separately for the different
elevations of one room, and for elevations of different rooms.
If you want to place a gap between the different sides on a
spread-out elevation, check the "apply gap…" checkbox.
You can set the sorting order of the individual Zones; the
interior elevations of a room will be sorted by their number.
You can also set the contour pen of the elevations.
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On the Options tab page, you can choose which elements to
display, as well as the layer set you want use. If you wish to
create more interior elevations later, it is recommended that
you save your current layer combination. You can save your
settings or load previously saved settings. Click on the Save
current Layer Set button at the top right of the dialog box.

Click the Browse… button in the Storing Objects section to
define a location for storing the generated Interior Elevations.

See also Zones in Chapter 4: Element Creation.

Options Menu Commands
The Options menu’s items allow you to configure and
customize the environment in which you will create your
design, including the scale, grid, story and layer structure, the
display and output options for element classes and general
program preferences.

Floor Plan Scale…

This command defines the scale used in the Floor Plan.
When working in a Section/Elevation or Detail Drawing
window, the name of the command changes dynamically.
You can set up a different scale for each window. See Scale in
Chapter 3: Project Organization and Navigation for details.

Display Options…

The Display Options command opens a dialog box where
you can customize the way the various construction elements
are displayed in the Floor Plan, Section/Elevation and
Detail Drawing windows. Some options also affect the
elements' behavior on printouts, plots and in exported file
formats. Available choices are detailed in the sections
dedicated to the element types in Chapter 4. See also Chapter
6: Project and Program Customization.

Grids & Background, Grid Snap, Grid Display

These commands define the setup, the availability and the
visibility of the construction and snap grid. See Grids in
Chapter 3: Project Organization and Navigation for details.

Clean Wall & Beam Intersections

The Clean Wall & Beam Intersections command operates
as a toggle. When the command is checked, the clean
intersections feature is activated. When it is unchecked, the
feature is disabled. See Walls and Beams in Chapter 4:
Element Creation.

Stories

The commands of this hierarchical menu provide complete
control over the Stories of the ArchiCAD project. See their
detailed description under Stories in Chapter 3: Project
Organization and Navigation.

Layers

ArchiCAD layers are used to organize the elements in your
drawing for selective displays and quantity calculations. The
Layers hierarchical menu contains all the commands needed
to set up and manage the ArchiCAD project's layer structure.
See their detailed description under Stories in Chapter 3:
Project Organization and Navigation.
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Pens & Colors, Line Types, Fill Types, Composites,
Materials

These commands define the set of attributes used to display
element contours and hatches in Plan view and their outlines
and bodies in 3D view. Their use and availability is explained
in detail in Chapter 6: Project and Program Customization.

Zone Categories...

Zones sharing the same function or purpose can be grouped
in categories. Zone Categories are defined by Code, Name,
Color and Zone Stamp. See Zones in Chapter 4: Element
Creation.

Mark-Up Styles…

This command allows you to manage the styles available for
Mark-Up elements. See Mark-Up in Chapter 9.

Attribute Manager...

Attribute Manager allows you to copy (append, overwrite)
attributes (Layers, Layer Combinations, Pens & Colors, Line
Types, Fill Types, Composite Structures, Materials, Zone
Categories and Cities) between two opened files. It can also
duplicate or delete attributes in either of the two files. See
Chapter 6: Project and Program Customization for details.

Preferences

The Preferences hierarchical menu allows you to customize
various aspects of the project and the environment. The
Preferences dialog box is a single screen: you can navigate
among its panels by choosing a name in the pop-up menu on
top or click the Next and Previous buttons to go from screen
to screen.

The use of generic Preferences is described in Chapter 6:
Project and Program Customization. Preferences related to
specific element types, for example Dimensions and Zones,
are described in Chapter 4: Element Creation.

Customize

The Customize hierarchical menu allows you to customize
the Info Box, the various Tool Settings dialog boxes, the
Toolbar (Windows only), the keyboard shortcuts assigned
to various menu commands and the shapes of the floating
palettes. See Chapter 6: Project and Program Customization
for details.

Image Menu Commands
The Image menu contains all the commands related to 3D
imaging, photorealistic rendering and animation.

Note: Views in the Navigator palette retain all of the
settings made in the dialog boxes accessed by the Image
menu commands.

3D Projection Settings…

Before you display a 3D view or ask for a photorealistic
rendering, you can choose from a number of view options in
the 3D Projection Settings dialog box. See 3D Image Setup
and the Navigator Preview palette in Chapter 3: Project
Organization and Navigation for the detailed description of
this feature.

Elements to Show in 3D

With this command, you can select which Stories and
construction element types should appear in the 3D Window.
Note that explicit Floor Plan selection overrides the settings of
the dialog box this command opens. See 3D Image Setup in
Chapter 3: Project Organization and Navigation for the
detailed description of this feature.

3D Cutting Planes…

By using 3D sections, you can get either ordinary cross
sections or special sections to visualize the Project in new
ways.
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Note: While the Section/Elevation tool is best suited for
sectional drawings, 3D Cutaway can be useful for special
3D visualizations allowing an insight into building spaces.

The 3D Cutting Planes… command is available if the 3D
window is opened and contains elements. Its dialog box has
options for controlling all aspects of the 3D section process.
Each of the controls in the dialog box are described in the
following sections.

The three basic orthogonal representations of your building
(front, side and top) are displayed in the 3D Section dialog
box.
To create a section, draw a line through any of the views
which represents a cutting plane perpendicular to the given
orthogonal view. The Eyeball cursor appears after you have
drawn each line, prompting you to click on whichever side of
the line you would like removed. The parts of the Project
views displayed as shaded will be removed, leaving a
sectional view of the model.

If you define the cut line numerically, click on the name of
any coordinate to lock it, and click it again to release it.

To create ordinary cross sections, draw a single line and set a
view in the 3D Parallel Projection Settings which is
perpendicular to the section plane.
When drawing the line, you can use the rulers or numeric
input the same way as on the Floor Plan. If you miss with
your first attempt, double-click the line of the cutting plane
with the Mercedes cursor. The line is removed and you can
start another.

If you want to remove all cutting planes, click the Clear All
Cutting Planes button.

When the cutting planes are correct, click the OK button to
return to the 3D model.

Hint: The number of cutting possibilities offered here is
much greater than you generally need in architecture. You
can, however, make good use of them when you are
dealing with non-orthogonal details or when showing
material cutaways. For generating straightforward sections,
use the Section/Elevation Tool. See Chapter 4.
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The Fill Material & Edge Pen of Cuts controls allow you to
highlight the edges and surfaces of elements cut in 3D
Sections.

You can create special section cut surfaces with different
colored edges, as well as cut surfaces having custom material
definitions. These attributes are used on all 3D elements
which are cut by the 3D Cutting Plane, helping to emphasize
the cut surface areas.
To create such highlighting, click the Custom radio button
and choose a material from the pop-up menu and/or a pen
from the palette.

If you click Use Element Attributes, the cut surfaces of
Walls, Slabs and Roofs will have the same colors/materials as
the uncut edges (as defined in their respective settings dialog
boxes).

Cut surfaces of Library Parts will be painted according to the
material set for the Library Part. If the Library Part has internal
material descriptions, the first one in the script will define the
material for cut surfaces.

Note: The 3D Cutting Planes feature does not show the
various layers of composite walls. To obtain sections
showing these (as required for working drawings, for
example) use the Section/Elevation Tool.

The 3D section cuts you define are stored within the Project
document and can be recreated after opening the Project in a
future session.

3D Cutaway

3D Cutaway is an imaging mode in ArchiCAD. If it is active, the
cutting places defined in the 3D Cutting Planes dialog box are
applied to the model every time it is rebuilt. To activate 3D
Cutaway, select its menu item. A Checkmark placed before
the name of the command indicates that it is active. To
deactivate 3D Cutaway, choose the command again and the
Checkmark disappears.

Note: The 3D Window must be open for this command to
be available.

Once the sectional 3D model has been created, you can save
it in a variety of formats for additional work. See the File menu
commands earlier in this chapter.

3D Window Settings…

Choosing the 3D Window Settings… command displays a
dialog box that allows you to define the characteristics of the
image in the 3D Window.

On top of the dialog box, you can choose in two pop-up
menus the 3D Engine to use and the 3D display mode.
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By default, two rendering engines are offered: the internal
ArchiCAD engine and the OpenGL engine.
The use of the OpenGL engine is recommended if you have a
high-performance OpenGL display card. Note, however, that
some effects, for example sun shadows, vectorial 3D hatching
and the option to save the contents of the 3D window as a
vectorial 2D drawing are not available with OpenGL. You can
use additional options for OpenGL by clicking the Options
button.

Note that OpenGL does not support semitransparent surfaces.
However, ArchiCAD can skip these surfaces according to the
value set with the sliding switch at the bottom of the OpenGL
Options dialog box. Materials that are less transparent than
the threshold will be hidden and excluded from output files.

In the second pop-up of the 3D Window Settings dialog
box, the four viewing modes are offered: Block, Wireframe,
Hidden Line and Shading. These modes differ in the
amount of detail they show. See View Modes under 3D Image
Setup in Chapter 3: Project Organization and Navigation.

Note: If you have defined a Layer as Wireframe, its
elements will always appear in Wireframe mode, even if
you have chosen another 3D view mode here.

Note that both the 3D Engines and the 3D view modes are
also accessible directly from the 3D Engine and Mode

hierarchical menu located below the 3D Window Settings
command.
The Methods section on the left contains choices for Hidden
Line and Shaded 3D Modes.

You can choose whether to have a hidden line projection of
your project executed by the Analytic or the Raster method.

Hidden Line views created with the Analytic method offer a
more accurate display.

Making a Hidden Line view using the Raster method is
recommended for fast feedback on screen, when extreme
model complexity makes the Analytic method too slow.

In shaded mode you can choose between Analytic and Raster
computational methods, which work as described for Hidden
Line above. Some of the important features of the two
methods are listed below.

Analytic shading:

- accurate surface polygons;
- zoomable image, resolution-independent;

- 3D hatching and 3D shadows can be applied;

- can be saved in several formats including PlotMaker;
- plottable at any size with HP DesignJet raster plotters.

Raster shading:

- bitmapped image;

- no effects are available, cannot be plotted.
You can also choose whether or not you want to see the
contours of the elements in Shaded Mode. The contours are
lines showing the edges of model elements.

- The Draft option produces a fast result, but it doesn’t
eliminate all the lines that the Hidden Line Analytic
method would.

- The Best option produces a perfect result, but it may be
rather slow for large and complex 3D models.

With the Vertical Raster Strips control you can specify the
number of vertical strips used to model your Raster Hidden
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Line or Raster Shaded models. More strips will produce a
more realistic image but will take longer to process.
For fast but clean images, select 3 to 10 vertical strips,
depending on your screen size. Do not go beyond 50 strips,
as this will usually not enhance the image any more, but will
take more time to calculate. Beyond a limit, the only way to
get better images is by using the Analytic Hidden Line, the
Analytic Shading or PhotoRendering methods.
In the Effects section of the dialog box you can specify the
use of 3D hatching, shadow-casting and transparency,

The Vectorial 3D Hatching effect is available only for
Analytic Shaded or Analytic Hidden Line images. If you have
already selected a 3D Hatching in the Materials dialog box
for any material you are using in your Project, you can decide
if you want to display this material in the 3D view with or
without the hatching. An example of roof tile material with
roof tile 3D Hatching is shown below.

Note: Vectorial 3D Hatching is also available for Section/
Elevation Windows, but this setting has to be made
individually in each Section's dialog box. The choices made
in the 3D Window Settings dialog box have no effect on
Sections.

See also Materials in Chapter 6: Project and Program
Customization.

Checking the Transparency in Shading box will produce
transparent views of elements that have the appropriate
Materials setting when generating a shaded view. Below, the
same glass wall appears with Transparency in Shading Off
and On.

 

This option is not available when printing to a PostScript
printer.

With the Vectorial Sun Shadows control you can enable
ArchiCAD’s shadow-casting capability, as well as specify
whether shadow contours should be shown.

Note: ArchiCAD calculates the shadow of each individual
element in your model. If you choose Contours Off, each
shadow remains an independent entity, but if you choose
Contours On, the individual shadows are merged into
each other where they overlap, resulting in one, or a few,
large shadows. (You would notice this if you saved the 3D
image as a 2D file and selected a shadow area for editing.
If the view was generated with Contours Off, you could
select and move each individual shadow. Otherwise,
clicking the shadow area would select it in its entirety.)

If the displaying of shadows is enabled, you can decide
whether you want to see the shadows on all surfaces or only
at a single, horizontal level. The latter option is useful for
shadow studies in top view.

In the Display section on the right of the 3D Window Settings
dialog box you can set the size and background of the 3D
Window, as well as line thickness used for 3D view contours.
In the GDL Object Hotspots, section, two radio buttons
allow you choose whether to display in 3D the hotspots
defined in the 2D symbol of GDL Objects. Enabling them
gives you more editing points.
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Note: If the GDL Object has no 3D hotspots at all, the 2D
hotspots will be always displayed, as well as their copies
projected to the zzyzx height value, provided that such a
parameter has been defined for the object. See the GDL
Reference Guide for more details.

3D Engine and Mode

This hierarchical menu gives you quick access to the 3D
Rendering Engines and 3D View Modes that you can also set
in the 3D Window Settings dialog box.

PhotoRendering Settings

The PhotoRendering Settings submenu contains four
commands. These in turn access dialog boxes with settings
for the photorendering process. The four commands are also
available from the top of each of the four dialog boxes. The
following sections describe these dialog boxes.

Note: The speed of PhotoRendering is defined most of all
by image size, while model complexity affects speed if
shadows are used. The PhotoRendering effects define the
final quality or character of your rendering.

Effects

Choosing Effects displays the following dialog box:

On top of the dialog box, you can choose a photorendering
engine. Depending on your choice, additional options may be
available. Add-Ons can install additional rendering engines.
The controls below concern the internal ArchiCAD rendering
engine.

The Method setting determines how closely the program
should adhere to its ultimate imaging capacity.
With the Best button selected, the program calculates the
light attributes of each pixel. As the choices decrease in
quality, ArchiCAD calculates individual values for every
second or third pixel only. The quality increase will affect
curved surfaces more than others.
Using multiple light sources or picture mapping may require
the Final or Best settings.
The Flat Shading button results in each shape being roughly
approximated by flat surfaces only. Special effects like
Transparency, Fog, Emission, Smooth Surfaces, Highlights and
Light Decay are unavailable. The Flat Shading option is faster
than all the other options in this dialog box, but slower than
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the Shading or Shading with Contour formats in the 3D
Window.

The contour quality of your renderings is controlled by the
Antialiasing settings. Jaggedness of the contour is gradually
eliminated as you move from Off to Best.

You may want to use the Best option only for final documents,
since processing time increases along with quality.

The series of checkboxes in the Effects section lets you
enable a variety of light and material effects, some of which
are initially set in the Options/Materials dialog box.

Specular reflections are taken into consideration and
displayed as highlights in your PhotoRenderings when this
box is checked.

Note: If Highlights is unchecked, or the Flat Shading
method is used, specular reflections are ignored in the
rendering.

Check the Fog option if you have set fog color and intensity
in the 3D Projection Settings dialog box and wish to use it
in your PhotoRendering.

Fog on Fog off

Check the Emission option if you have chosen, or created,
light emitting Materials and want this quality to be displayed
in the renderings.

The Transparency option controls whether the transparency
of materials will be taken into account.

Curved surfaces, which are normally approximated by flat
planes, are represented by more lifelike surfaces when this
option is on. The degree of smoothing is set through the
Smooth Surfaces control, with up to one pixel accuracy.
If Lamp Falloff is not checked, the angle falloff and distance
falloff values in the GDL Scripts of Lamps will be handled as
being zero. This results in a sharp border between illuminated
and dark areas. If it is checked, the values originally given will
be used, resulting in a smooth transition between illuminated
and dark areas.

Note: Lamps must be enabled at the Light Sources
checkboxes for falloff to operate.

If the Textures box is checked, bitmapped pictures referred
to in the GDL script of some library parts will appear on the
corresponding surfaces.
It also controls whether the textures linked to materials in the
Materials dialog box are displayed in PhotoRenderings as
described.

You can select which Light Sources (Sun, Lamps or both)
you want to use to illuminate the model during the
PhotoRendering process. You should select at least one of the
two choices.
The Lamps checkbox can only be effective if Lamp type
library parts have been placed on the plan. They must be
switched on in their Settings dialog box.
In the Shadow Casting section, you can define which of the
available light sources you want to cast shadows in the
PhotoRendered picture. Check the High Accuracy box if you
notice incorrect results on your PhotoRendered picture,
especially missing shadows of relatively small elements. This
may occur if you zoom in on a small detail of an otherwise
large project in the 3D Window and make a photorendering
of that detail.
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By clicking the Options button, you are presented with two
additional options for the ArchiCAD Internal Engine.

- If the Use transparency in shadow calculation
checkbox is checked, ArchiCAD will create different
shadows for materials with different transparency. The
color of the transparent material will also affect the color
of the shadow in the final photorendering. This is also
valid for materials with Alpha channel, where the Alpha
channel is used to define the transparency of the material.

- Use the sliding switch next to the Texture antialiasing
checkbox to set the desired image quality.
Notes: This option is only available if you have chosen the
ArchiCAD Rendering Engine and set Antialiasing to
Best in the Effects dialog box. As this procedure is very
time consuming, use it only if you require a superior
image quality for printing.

Choosing the Sketch rendering engine grays out all of the
controls in the Effects dialog box. Click the Options button to
access the additional controls that are provided.

The Sketch engine creates a 3D image that resembles a
drawing made by hand.

Image Size & Background

In this dialog box you can set the attributes of the background
for your rendered 3D model.
If the Colors radio button is on, you can set the color of the
sky and the ground in the Edit Color subdialog box after
clicking the Sky Color or Ground Color button. During the
photorendering process ArchiCAD will automatically locate
the horizon line of the background to correspond with the
horizon of the picture.
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In parallel projections, if the bottom of the elements is visible,
sky color is used; if not, ground color is used. The 3D Window
can also use the colors specified here. If you just need a plain,
single color background, click the Chain icon next to the
Preview Window and set either the Sky or the Ground Color
by pushing their button.
ArchiCAD PhotoRendering supports precise horizontal and
vertical pixel size and dots per inch resolution. This makes it
possible to merge background bitmap images of known
proportions and resolutions with PhotoRendering images.

You can make a powerful graphic statement by placing a
rendered model against an existing picture as the
background. Just turn on the Picture radio button and search
for the appropriate picture from the directory dialog box.
If you want a different picture for the background, click the
Open Picture button and select another picture.

Your rendered model will be merged into the background
picture in an intelligent manner, masking it when necessary as
shown below.

 

Note: You can save the background picture together with
your Project by using the Save Archive command. See the
discussion in the File menu section.

The background picture you selected is fitted into the Preview
Window of the dialog box, and you can rescale it with the
Resolution and Magnification settings.

The size of the picture will change in the Preview Window,
and you can check its real size with the values written above
the horizontal line on the right side of the dialog box. (You
can also get a sense of how its size is changing by comparing
it to the image frame, discussed below, which grows and
shrinks as you change these settings.)
If the Show: radio button is set to Picture, the Preview
Window will show you the whole opened picture, and a bold
frame inside it represents the dimensions of your rendered
image. You can drag this by clicking inside the frame.

If the bold frame is not visible, it is too large. Just click in the
picture and you will see the bold frame. In this case, change
either the magnification, the resolution or the image size
values to bring the ratio of the incoming and outgoing image
sizes closer. Ideally the frame is smaller than the background
picture so that you can choose the best detail. If the radio
button is set to Image, you will see only the framed part of
the background in the Preview Window. You can select
another part of the background picture here by clicking the
Preview Window and dragging the frame on top of the
background picture.
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The Use Alpha Channel checkbox will allow you to use the
Alpha Channel information of the opened background picture
if it has any. White color of the Alpha Channel will make the
background picture dominant, while black color of the Alpha
Channel will make the photorendered image of ArchiCAD
dominant over the background.

See also Textures in the Materials section of Chapter 6: Project
and Program Customization.

The size of the resulting photorendered image can be set
numerically, or you can adjust it to the size of the currently
used 3D Window by clicking the Size to 3D Window button.
The proportion of the height and width of the resulting image
will be indicated by the image frame in the Preview Window.

Click the Size to 3D Window button to match the size of
future PhotoRenderings to the current size of the 3D Window.
If the proportions are different, you get stripes of the
background color at the top and bottom and on the left and
right sides of the PhotoRendered image. This will be apparent
with internal perspectives or with external perspectives where
the view does not enclose the entire Project and it is clipped
by the image boundaries.

If you check the Keep Proportions checkbox, the height
and width ratio of the resulting image will keep its current
proportions. If you change either the horizontal or vertical
values, the other value will be updated accordingly.

Brightness & Partial Imaging

This dialog box gives you choices regarding exposure and
provides you with the option of making partial
PhotoRenderings.
Use the dimmer switch to set the desired brightness from dark
to bright.

You have three options for correcting possible
Overexposures. (Overexposure occurs when the
computational method results in a brighter color requirement
than the brightest white on the monitor.)

1) ArchiCAD can make all surfaces darker than their
computed color and make the brightest color white. This
keeps the contrast between bright and dark parts of the
image, but details in darker areas may be lost.

2) You can choose to darken only the overexposed surfaces.
This way, dark areas will not be extremely dark, but the
contrast between shades in bright areas will be smaller.

3) Paint the overexposed surfaces with the selected color to
show their place in the picture. This is an editing tool that
helps you fine-tune the lighting of your renderings by
changing elements of the model (e.g., relocating or
dimming individual lamps) rather than applying one of the
overall corrections described above.

When you click the Apply button, ArchiCAD will create a
new image from the latest PhotoRendered image using the
brightness and overexposure correction settings in the dialog
box. Creating this new image will take much less time.

The Partial PhotoRendering settings allow you to specify a
range of lines and columns to be rendered for your image.
This is useful when you do not want to waste time rendering
the entire image.
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This method can also be useful for comparing different
material or light conditions within a single image. Additionally,
it can be used for continuing images which were stopped
when being processed. (You must save the half-completed
image and open it as a background picture).

Use this method if you made a modification in the model that
affects only the unrendered part of the entire image. This
allows you to re-render a part of it.

Memory

On the Memory tab page, you can see information about the
size of the available memory. ArchiCAD can also estimate the
amount of memory that is needed for your PhotoRendered
image, if you click the Estimate Complexity button.

PhotoRender Projection

This command instructs ArchiCAD to make a photorealistic
picture of the current projection according to the settings
described above. This will appear in a new Window, which is
not editable.

You can have several Model Picture Windows on your screen
at once to compare different settings. You can also save them
as bitmap files for processing or for use with other programs.

You can use the Marquee tool to select and copy parts of
Model Pictures.

Important: PhotoRendered Model Pictures are not saved
with your Project. If you wish to keep them, you have to
save them manually. Closing a Model Picture Window that
you haven’t saved means you won’t be able to access this
image again.

Create…

The name of this command changes according to the type of
camera currently selected in the Camera/VR Settings dialog
box (Camera, VR Object, VR Scene). See Cameras in Chapter
4: Element Creation for detailed descriptions.

Create Sun Study…

The Create Sun Study... command generates a series of
normal or photorendered 3D pictures defined by the current
3D Projection Settings, the current 3D Window or
Photorendering Settings, respectively and the Sun position
settings defined in the Create Sun Study dialog box, similarly
to the Create Fly-Through command. You can either have
the resulting animation shown immediately on the screen, or
save these pictures in the desired file format and show them in
the future using the PlayBack utility provided with ArchiCAD.
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All the projections in a Sun Study will be generated in
accordance with the current parallel projection or perspective
view defined in the 3D Projection Settings dialog box.
Geographical data for the location of the model and Sun
parameters can be set in the Sun Options dialog box.

You can define a particular day of the year for the previously
set geographical location in the upper left part of the dialog
box. Use the pop-up menu to select the month and type the
day in the edit box or use the arrows to advance up or down.
Use the radio buttons in the middle left section of the dialog
box to define a full Sun Study from sunrise to sunset for the
selected day or specify a part of the day for the Sun Study.
Type a number in the Interval edit box or use the arrows to
define the time between two frames in minute intervals.

- Click the Show button to have the Sun Study processed
and immediately displayed on your screen.

- Click the Save button to save the Sun Study in the selected
file format.

See also Cameras in Chapter 4: Element Creation, and 3D
Image Setup in Chapter 3: Project Organization and
Navigation.

Align View...

When using a scanned photograph as the background of your
rendering, you may want to fit your ArchiCAD model into the
photograph's environment. In the photorendering made from
the Camera placed by this command, the perspective of your
building in ArchiCAD will match the perspective of the
background.

For this feature, you need to select two clearly visible vertical
segments on the photograph (e.g., the sides of a door or a
window, two vertical edges of a wall, or two flagpoles), and
connect them with their exact position in the virtual model or
its environment. This is done by connecting each of four
points on the placed photograph (the tops and bottoms of the
two vertical segments) with their position on the Floor Plan,

and then entering their Z coordinates in the Align View
dialog box.

Note: This function is mainly useful in refurbishing, when
a photograph of the existing environment is available.

Using the Figure tool, place the scanned image on the Floor
Plan at any size or resolution.
You then have two possibilities for aligning the camera view
to the photograph: you can either use existing lines or can
manually draw lines between the corresponding points of the
Floor Plan and the photograph.

To draw the connection lines automatically:
1) Select the placed photo.

2) Choose the Align View… command. ArchiCAD will
prompt you to make six clicks on the Floor Plan with the
Pencil cursor, identifying the correspondence points
between the picture and the plan. The connection lines are
drawn automatically.

3) The Align View dialog box appears, prompting you to
enter the height values for the four points.

4) Click OK. The camera will be placed on the Floor Plan on
a new path.

To draw the connection lines manually:
1) Using the Line tool, connect the tops and bottoms of two

vertical lines visible on the photograph with their location
on the Floor Plan (e.g., the sides of a door or a window,
two vertical edges of a wall, or two flagpoles). This will
give you four lines, each extending from a floor plan
location to a point on the photograph, with the two line
pairs connecting where they meet on the Floor Plan.

2) Select the photo and the four lines.
3) Choose the Align View… command. The dialog box

appears, prompting you to enter the height values for the
four points.
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4) Click OK to close the Align View dialog box. The camera
will be placed on the Floor Plan, on a new Path.

Select the elements you wish to display on the image, then
select the Camera, and choose the PhotoRender Projection
command from the Image menu.

In the picture below, only the Object type elements have
been selected on the Floor Plan and they appear against the
backdrop of the scanned photograph.

Notes: For greater precision, you can enter the horizon of
the photograph by simply rotating the picture on the Floor
Plan so that the horizon is exactly parallel to the unskewed
x-axis (otherwise the command will calculate the horizon
for you).
The precision of the result depends largely on that of the
entered points, but even very careful preparation may
result in a Camera that is slightly off position. In this case,
set the photograph as the background of your 3D window,
and fine-tune the Camera's position in Wireframe or
Hidden Line mode using ArchiCAD's 3D navigation tools.

Calculate Menu Commands
The Calculate menu is structured in four sections:

- The top three commands allow you to create lists of
elements, components and zones based on predefined
schemes.
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- The next command accesses the list scheme setup dialog
box in which you can configure or duplicate existing
schemes to suit any special needs.

- The next section contains database commands for creating
new properties (including Property Object files) that
contain component information to be linked to elements,
based on either individual assignment or a set of criteria.

- The bottom section of the Calculate menu contains
additional commands related to quantity calculations.
These commands are described below.

Note: By default, some of the expert database commands
are hidden. This means that, if you check the current
setting in Preferences/Imaging & Calculations, the
Short version of the Calculate menu is active. You can
enable the list schemes configuration and database editing
commands by choosing the Standard or Full options.

The listing commands are described in Chapter 10: Project
Data Calculation, while the complete description of the
calculation process (including database editing and list
template creation) is given in the ArchiCAD Calculation
Guide, which is also part of the ArchiCAD package in
electronic format.

List Elements, List Components, List Zones

These hierarchical menus each contain a set of commands
that correspond to a predefined List Scheme. Choosing a
command will activate the corresponding list type window
and display the appropriate data in the format defined by the
List Scheme.

Note: All the predefined lists can also be accessed from
the Lists folder in the Navigator palette's Project Map.

Find by Properties

The Find by Properties command allows you to find
elements according to component definitions: for example, to
locate all Walls with brick components. You can either search
elements or Property Objects.

This command works similarly to Find & Select (Edit menu),
but you have a maximum of three criteria available with an
"and" relation to each other. These are considered if the
checkbox is checked on the left.
Property Objects will be listed in the dialog box.

Elements can be:
- added to the selection;
- removed from the selection;

- kept selected in the selection (the rest of the selection will
be deselected).

Interactive Element Schedule

Using this command, ArchiCAD allows you to create simple
tabular schedules with bidirectional update capabilities. In the
resulting schedule, you can summarize and check element
data and modify some of the values of the elements
concerned. See Interactive Element Schedule in Chapter 10:
Project Data Calculation for details.
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Element ID Manager…

The Element ID Manager command allows you to set the
identification tags (ID numbers) of the project's elements
based on their characteristics (attributes). See ID Management
in Chapter 10: Project Data Calculation for details.

Construction Simulation

The commands of the Construction Simulation hierarchical
menu allow you to simulate the construction process with
ArchiCAD's 3D model by associating construction elements to
a task list. This list can be created within ArchiCAD or (in
Windows only) imported from a Microsoft Project database .

Notes: The Construction Simulation menu is only
available when the Floor Plan Worksheet is the active
Window.
Only one Construction Simulation project (task list) can be
linked to an ArchiCAD Project. Opening a Construction
Simulation Project with another ArchiCAD Project will
create unresolved references.

The menu's commands are:
- Show/Hide Task List: opens the Construction

Simulation dialog box, listing all the defined tasks with
their status. Tasks can be defined directly in this dialog
box or (in Windows only) imported from a Microsoft
Project database.

- Open Project…: allows you to import a Microsoft Project
database (in Windows only).

- Save Project…: saves the task list in a database format.
- Save Project as…: saves the task list in a database format

under a new name. Use this to avoid overwriting the
original database.

- Create Movie…: allows you to create an animation
showing the progress of the construction process.

Before you can export a Project from Microsoft Project to
ArchiCAD, you need to run the "CS Map Installer" utility that
can be found in the ArchiCAD Folder/Add-Ons/Standard/MS
Project folder (in Windows only). This will install a special
text export format in your copy of MS Project.

Create a project in MS Project, following the instructions in
that software's reference manual.
Choose File/Save as… in MS Project. Select the text file
format and click Save. In the appearing Export Mapping
dialog, select the "Construction Simulation" format and click
the Save button.
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Go to ArchiCAD and choose the Calculate/Construction
Simulation/Open Project… command. In the dialog that
appears, select the file you just saved from MS Project. Click
Open.
The Construction Simulation dialog box opens.

The dialog box includes the following fields: Tasks, Type,
Progress, Start Date and Finish Date. Fields can be edited
by double-clicking in them. Clicking on any header will sort
the task list by that key.

The Tasks, Start Date and Finish Date fields are imported
from MS Project. You can either keep these or overwrite them,
and you can manually enter new tasks.
The Progress field is automatically filled by ArchiCAD to
conform to the Current Date defined at the bottom of the
dialog box. Otherwise, this field is not editable.

Types are defined manually with a pop-up menu listing task
types. There are five types of construction tasks:

- Build: Elements do not exist when simulation starts. They
are constructed during the task and then remain there.

- Demolish: Elements are present on the site when
simulation starts. They are removed during the task.

- Restore: Elements are present both at the start and the
end of the task. Work is performed on them during the
task.

- Freeze: Elements are present both at the start and the end
of the task, but no work is performed on them.

- Temporary: Elements are not present when simulation
starts. They are constructed during the task and are
removed at the end of the task.

When the task list is complete, you can start linking ArchiCAD
elements to the items of the task list.

Go to the Floor Plan Window and select some elements. In
the Construction Simulation dialog box, select the task that
you wish to link the elements to and click the Link button on
the right.

Note: Any element can be linked to as many as 10 tasks at
the same time.

The buttons on the right-hand side of the Construction
Simulation dialog box allow you to manage the task list.

- Link assigns a task to selected Floor Plan elements.
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- Unlink deletes the link between the selected task and the
Floor Plan elements it has been assigned to.

- Show Linked Tasks highlights the names of the task(s)
assigned to the element selected on the Floor Plan.

Note: If you select a highlighted task in the list, the
button's name changes to "Unmark Task."

- Select Linked Items will select the elements on the Floor
Plan to which the highlighted task is assigned.

- Select Unlinked Items will select Plan all elements on
the Floor that have not been linked to any task.

- New Task allows you to add new tasks to the list.

- Delete Task will remove the highlighted task from the list.
Once the task list is complete, you can simulate the
construction process using the controls at the bottom of the
Construction Simulation Window.

The Current Date field allows you to check the date or to
choose another day to show the state of the building.

The Show Built button will show elements in their current
state. It will also move all elements whose construction has
not started yet on a hidden layer called "CS Hidden Layer".
These elements will not appear in either ArchiCAD Window
until you choose to show them again.
Clicking the Show All button will revert the display of all
elements to their "normal" state. It will also move the elements
hidden by the Show Built button back to their original layers.

Different construction states are displayed in different ways.
ArchiCAD divides the linked elements into three categories
according to the current date. This division is triggered when
the Show Built button is clicked.

- Completed elements are displayed with their normal
color (pen color on the Floor Plan, material in 3D).

- Started elements are displayed with different colors
according to the task type (see below).

- Elements whose construction has not started yet are
moved to the "CS Hidden Layer" and are not displayed at
all.

According to task types, the color changes are as follows:

- Build type elements are not visible before their task starts;
they are displayed with pen number 251 on the Floor Plan
and with the predefined "CS Build" material while the task
is carried out and are displayed with their full original
colors when completed.

- Demolish type elements are visible with their full original
colors until the task starts; they are displayed with pen
number 252 on the Floor Plan and with the predefined "CS
Demolish" material while the task is carried out; and are
not visible any more when the task is completed.

- Restoration type elements are visible with their full
original colors before the task starts and again when the
task is completed. While the task is carried out, they are
displayed with pen number 253 and with the predefined
"CS Restoration" material.

- Freeze type elements are visible with their full original
colors before the tasks starts and again when the task is
completed. While the task is carried out, they are
displayed with pen number 254 and with the predefined
"CS Freeze" material.

- Temporary elements are not visible either before the task
begins or when it is completed. While the task is carried
out, they are displayed with pen number 255 and with the
predefined "CS Temporary" material.

Note: CS Build, CS Demolish, CS Restoration, CS Freeze
and CS Temporary are predefined, transparent materials
that have no texture or 3D hatching associated with them.

The last item on the Construction Simulation hierarchical
menu allows you to create an animation for the simulation
process.

Choosing the command displays the Animation dialog box.
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On top of the dialog box, you can define the starting and
finishing date of the simulation.

In the middle section, you can define the interval in days. The
number of frames field is grayed, as it uses the current setting
of the Create Fly-Through command.
In the bottom part, you can choose between using the current
view or an existing camera path for creating the animation.

Note: If you choose the current view, check your settings
in the Image/3D Projection Settings dialog box and
make sure that a perspective view is set up.

On the right, you can choose to save the movie in QuickTime
Movie or AVI (Windows only) format and define additional
information such as a caption and custom text.
When you click Save, you can define the location of the
animation file.

Teamwork Menu Commands
The commands of the Teamwork menu allow you to access
all the options needed for creating, signing into and
interacting with a shared project. See Chapter 9: Collaboration
and Connectivity.

Display Menu Commands
The commands on the Display menu affect the view in the
current ArchiCAD Window. You can use these commands to
navigate inside a window or to refresh its view. Most of these
commands or functions can also be accessed as shortcuts next
to the bottom scrollbar of the ArchiCAD windows. See
Chapter 2: The ArchiCAD User Interface for details.

Window Menu Commands
The Window menu allows you to quickly access ArchiCAD
windows and palettes. See Chapter 2: The ArchiCAD User
Interface for details.

Extras Menu Commands
The Extras houses some special utilities, for example
Accessories, RoofMaker, TrussMaker and Interior Wizard.
These tools help you enhance your design in 3D view and
Section/Elevation windows. See Chapter 4: Element Creation
for the description of these tools.

Help Menu Commands
The Help menu contains the commands that allow you to
access the electronic help files provided with ArchiCAD in
HTML format. Program information and on-line access are
also available from here.
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Chapter 12
Using PlotMaker
PlotMaker is a layouting program that is part of the ArchiCAD package. This standalone application is optimized to prepare an
architectural documentation set based on the views, drawings and images created with ArchiCAD. PlotMaker can also
accommodate data from external sources such as other CAD and image files, word-processing documents and spreadsheets.

PlotMaker Concepts
PlotMaker allows you to set up Layout templates, combine
and arrange Layouts within one Layout Book divided in any
number of hierarchical subsets, place drawings and images on
the Layouts and optimize them for printing or plotting.

In addition to ArchiCAD files, PlotMaker recognizes a large
number of external CAD and Image file formats. PlotMaker
can also serve as an OLE-client application and accommodate
files originating from commonly used programs such as
Microsoft Word and Excel.

While PlotMaker is a strictly 2D drawing environment, the 3D
information contained in the original ArchiCAD files is not
affected by PlotMaker operations.

Layout Book Components
The PlotMaker Layout Book file contains all documents that
compose your architectural documentation – floor plans, details,
cross-sections, views, 3D views - in the form of Layouts. Within
the Layout Book, you can place any set of drawings or images
onto Layouts, and edit and format them. Then you will save,
print, plot and publish part or all of your Layout Book.

The main components of the Layout Book are:
- The Master Layout that defines the size and output

options of the Layouts (pages) or the Layout Book. These
templates can also include items that will appear on all of

the single Layouts, for example border lines, a title block
or a company logo. A Layout Book can include multiple
Master Layouts.

- The Layouts on which you can arrange any number of
imported drawings, images and other graphic or text items.

- The imported Drawings that can be placed and arranged
at different sizes, with different framing and display
options. Imported drawings can be automatically updated,
and you can even initiate the updating process by
launching ArchiCAD from within PlotMaker to perform the
modifications in the source file.
Note: Drawing is a collective name used for imported
ArchiCAD views, independent drawings or images, files
imported from other CAD programs or OLE-capable
applications.

- The Navigator palette which serves as a table of contents
for your Layout Book and allows you to quickly access any
of its Layouts, placed Drawings or Master items.

Starting PlotMaker
If you launch the PlotMaker application itself (without
opening a file by double-clicking its icon), a startup dialog
box will appear prompting you to choose an action, that is,
create a new Layout Book or Drawing or open an existing
one.
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This works similarly to the ArchiCAD startup dialog box. By
checking the box at bottom left, you can disable the display of
this dialog box every time you launch PlotMaker. You can
enable the dialog box again in Options/Preferences/
Miscellaneous.

The options for creating new Layout Books and Drawings are
detailed in the File menu section later in this chapter.

The PlotMaker User Interface
PlotMaker’s user interface combines elements familiar to
ArchiCAD users with the components typically used in layout
organization.
In PlotMaker, you will use Layout Windows and Drawing
Windows to open and edit elements. Keep in mind that
Drawing window features refer to objects (i.e. lines, arcs and
text), while Layout window features refer not only to graphic
shapes but also to drawings as individual objects.

The floating palettes used by PlotMaker to help you navigate
and work in the different windows are customized versions of
their equivalents in ArchiCAD. Basically, 3D capabilities are
missing from PlotMaker's Toolbox and the Control Box. The

PlotMaker Control Box combines the relevant controls
familiar from the ArchiCAD Control Box, Coordinate Box and
Info Box palettes.

The Layout Window
In the illustration above, the Layout window is the large
window on the right. Several Layout windows can be opened
at the same time, but you can also use the same window to
show the currently active Layout (or Master Layout).

- The blue frame shows the actual area of the Layout.
- The white area represents the usable print area of the

paper.
- The grey area represents the non-printing area (margins)

of the paper.
- The dotted blue line represents output pages (visible when

a single Layout will take up more than one printed page.)

The size and the margins of the Layout are defined with the
Master Layout (see later). You can also adjust these options in
the Print Setup or Plot Setup dialog boxes when outputting
the Layouts. See Chapter 13: Printing and Plotting for details.
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You can place, arrange and transform drawings in the Layout
window, and manually add 2D elements as well as AutoText
items (for example, the number of the Layout in the Book or
the name of the client).
Drawings can be added and placed on the Layout using the
Import command (File menu). Any number of drawings of
different formats can be placed on the same Layout.

Imported drawings can be displayed with or without a frame,
as monochrome bitmaps or vectorized color objects. You can
scale, arrange, edit and manipulate them as needed.

Basically, two types of drawings (or other objects) can be
placed on the layout:

- Drawings imported and automatically placed from
ArchiCAD. These drawings can be edited by opening them
directly in ArchiCAD.

- Manually placed drawings can be edited inside PlotMaker
either before or after they are placed in the Layout. Each
drawing can be opened in a separate Drawing window
and you can then edit its individual graphic elements.

A hotlink exists between the imported file and the placed
Drawing. The links can be updated automatically or manually.
See details in the Managing Linked Drawings section later.

The Drawing Window
To open a drawing, first select it on the Layout, then choose
the Open Selection command in the File menu. Note that this
command name is only visible when there is nothing selected;
if you have selected a drawing, the command name changes
dynamically.

- For manually placed drawings, the name of the command
changes to Open "Drawing Name." Choosing the
command opens the drawing in a Drawing window that is
associated to it. This is true for both drawings that are
embedded in the PlotMaker Layout and those that are
linked to external drawing files.

Note: You can also open or activate a Drawing window by
double-clicking one of the drawing's hotspots on the Layout.

- For automatically placed drawings, the name of the
command changes to Open "Drawing Name" in
ArchiCAD. Choosing the command launches ArchiCAD,
opens the appropriate file and goes to the corresponding
view. You can then modify the ArchiCAD file, save it, and
then update the drawings in the PlotMaker Layout.

The Drawing window is an editable 2D environment in which
the 2D drafting tools familiar from ArchiCAD can be used to
touch up imported drawings or create new ones.

Note: Although many basic drawing and editing
capabilities are available through the PlotMaker Toolbox, it
is not intended to be a full-fledged drawing program. The
drawing features are provided for the specific purposes of
editing drawings after importing them, and to enhance a
Layout with graphics and text.

The Navigator Palette
The key to both importing drawing files and finding your way
around in even a complex layout book structure is the
Navigator palette located by default on the left edge of the
PlotMaker screen.
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Use the palette to:
- Create and organize the elements of your Layout Book;

- Navigate within the Layout Book;
- Open a new Layout Window or Drawing Window;

- Set and adjust parameters for the Book, Layouts, Subsets
and Drawings;

- Update Drawings;
- Name Layouts or Subsets.

To show or hide the palette, click the Navigator icon at the
bottom of the Layout window or use the Show/Hide
Navigator command in the Window menu.

Click the pop-up button at the top left of the Navigator palette
to view the components of your Layout Book according to
one of four different views: Tree by Subsets, Tree by Masters,
Layout List and Drawing Usage.
In all of the views, the Properties section at the bottom of
the Palette displays information about the selected element.
The Properties section allows you to edit certain parameters,
such as Layout Name or Drawing Scale, depending on the
element.

- Tree by Subsets groups your Layouts according to Subsets
and shows the names of the drawings that belong to each.

- Tree by Masters only lists your Layouts according to the
Master Layouts they are assigned to.

- Layout List is a numbered list of layouts organized
according to Layout ID number, Layout name, page
number and the associated Master Layout.

Note: The Layout ID number is generated sequentially
from top to bottom according to the Tree by Subset view.
Adding new Layouts will update the ID numbers. The
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navigation arrows at the bottom of the Layout window also
use these ID numbers as reference.

- Drawing Usage plays the major role in the management
of all the drawings that are placed on the Layouts of the
current Layout Book. See Managing Linked Drawings
later.

In tree views, items can be listed by name, number or both.
Drawings are listed in the Layout Book accompanied by icons
that correspond to the file type (for example, JPEG or PMK).
Views imported from ArchiCAD project files retain their icons
(for example, floor plan or section).

You can move and rearrange elements using the drag and
drop technique to:

- Create hierarchical Subsets;
- Move a Layout from one Subset to another;

- Apply a Master Layout to a Layout (see later);
- Move a Drawing from one Layout to another Layout.

Note: In this case, the proportionate distance of the center
of the Drawing from the Layout origin remains unchanged.

While you are editing the elements of your Layout Book, the
Navigator palette keeps track of which element you are
working on.
Elements selected within the Navigator will be highlighted.

When you move over and work in the Layout window, the
highlight changes to a box.

Layout elements that are open are shown in bold.

The Toolbox and the Control Box
The PlotMaker Toolbox and Control Box are simplified
versions of their ArchiCAD equivalents. The Control Box
combines some of the controls of the ArchiCAD Control Box,
Coordinate Box and Info Box palettes.
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Context Menus
The context menus allow you to quickly access frequently
used menu commands. They can be accessed from the Layout
window, the Drawing window and the Navigator palette and
their content varies according to the window or the current
selection. To display the context menus, click with the right
mouse button (in Windows) or with the Ctrl key pressed
(MacOS).

Working with PlotMaker
There are many ways to integrate PlotMaker smoothly into
your practice. The following outline includes the
recommended steps.

- Setting up the Master Layout;

- Defining the Structure of the Layout Book;
- Generating the Layouts of the Book;

- Importing and placing the Drawings;
- Managing Linked Drawings.

The next sections present these steps in detail.

Setting up the Master Layout
The Master Layout is a template that defines the size of any
number of Layouts in a Layout Book. It can also contain a
number of master items that will appear on all of the Layouts
that are based on it, including AutoText elements that are
filled in automatically. A Layout Book can include multiple
Master Layouts.
To access a Master Layout, select it in the Masters Folder in
the Navigator's tree view and double-click it. Alternatively,
you can choose the Go to Master Layout command in the
Book menu.

One of the Master Layouts will be applied by default to newly
created Layouts. In the Navigator, the default Master Layout is
earmarked.

To choose a different Master Layout as a default, select it in
the Navigator palette and use the context menu, or check the
Set as Default box in its Master Layout Settings dialog box.

Note: You cannot simply uncheck the Set as Default box
in the current default Master Layout's settings dialog box;
you have to explicitly override this setting by making
another Master Layout your default choice.

To apply another Master Layout to a Layout, go to the
Navigator and make one of the tree views active.

- Drag and drop any Master Layout onto the selected
Layout,

- Drag and drop a Layout onto any Master Layout, or

- Select a Layout, then choose another Master Layout with
the pop-up menu in the Properties section.

Note: You can also apply a Master Layout to an open
Layout by selecting Layout Settings from the Book menu.

You can create new Master Layouts by choosing the Create
New Master command from the Book menu, the Navigator
palette's menu (opened by the arrow top right) or the context
menu opened by right-clicking a Master Layout in the
Navigator.

Master Layout Settings
The Master Layout's size and output options (inherited by all
the Layouts that use it as a template) can be set in the Master
Layout Settings dialog box.
To open this dialog box, you can choose the Master Layout
Settings command in the Book menu, the Navigator palette's
menu (opened by the arrow top right) or the context menu
opened by right-clicking a Master Layout in the Navigator

Note: If you open the Master Layout Settings dialog box
from the Book menu, the settings refer to the Master
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Layout associated with the Layout in the active window. If
you open the dialog box using the Navigator context
menu, the settings refer to the Master Layout selected in
the Navigator.

In the top section of the dialog box, you can define the Paper
Size, Margins and orientations of the Layouts by choosing
either preset or custom values.

To use the options of your current Printer or Plotter, activate
the appropriate option from the pop-up menu and click the
Print Setup (or Plot Setup) button to access the
corresponding dialog box. Make your choices as described in
the relevant sections of Chapter 13: Printing and Plotting,
then close the Print Setup or Plot Setup dialog box and click
the Apply button.

If you check the Set Layout Size equal to Usable Print
Area box, the size of the layout will correspond to that of the
current paper. By unchecking it, the bottom part of the dialog
box becomes active, and you can then decide to define a
different layout size.

PlotMaker will then determine the number of pages required
to print out a layout of that size. A diagram (the grey box in
the center) helps you visualize the final output. The white
tiles represent the output pages. The blue frame shows you
the Layout size as compared to the paper. Click and drag a tile
to create additional pages (tiles) inside the diagram.

- Tiling refers to the distribution of sheets of paper over a
Layout. Click the tile points to visualize different ways of
printing out the Layout on multiple sheets of paper.

- The Overlapping fields let you set a particular Layout
margin to be printed twice - at the edge of two adjoining
pages in your final documentation - to make it easier to
affix pages to each other. (If you do not set any overlap,
the entire Layout will still plot or print.)

The Set as Default for New Layouts checkbox ensures that
newly created Layouts will automatically contain the settings
and content of this Master Layout.
Note that, when printing or plotting, you can override these
settings in the Print Setup or Plot Setup dialog boxes without
affecting the choices made in Master Layout Settings.

Master Layout Items
The graphic and text items that you place on the Master
Layout will appear on every Layout that uses it as a template.
You can choose to hide these elements on all Layouts (but not
an individual ones) by choosing the appropriate option in
Options/Display Options.
Typically, you will place a Title Block on the Master Layout by
using the PlotMaker drafting tools. You can also add special
predefined automatic text items (AutoText) that are generated
by PlotMaker (for example the Layout Name), determined by
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the current system settings (for example the current Date,
Time or the file's Path) or extracted from the Book Info
entered for the Layout Book (Book menu), such as the name
of the Client and the Project.
To add AutoText, activate the Text tool in the Toolbox. Click
at the location where you wish to insert the text, then select
the AutoText command from the Edit menu or the Insert
AutoText command from the context menu obtained by
right-clicking near the location of the flashing cursor.

Choose a type in the menu. A label corresponding to the
chosen type will appear after the cursor (for example
<BOOKNAME>). You can add any number of these AutoText
labels and type additional text into the same text block. The
current Text Settings will be applied.
When you have finished inserting text, the AutoText field
represented by its label will be updated to show the actual
value, if applicable. For example, the current date will appear
as such on the Master Layout, but the Layout Number can
only be interpreted if you activate a Layout. In this case
"Undefined Value" will appear on the Master Layout. Note that
if you refer to items of the Book Info dialog box that are not
filled in, the #Field Empty# caption will appear here.

Note: You can edit the AutoText labels on the Layout, but
then PlotMaker will no longer recognize it as AutoText. On
the other hand, if you manually type a correctly spelled
AutoText label into a text block, PlotMaker will recognize
it as such.

Defining the Structure of the Layout
Book
Layouts represent the pages of a Layout Book: one or more
physical sheets of drawing paper onto which you place
Drawings, as well as text, graphics and other images, to be
output to your printer or plotter. Layouts can be optionally
organized in Subsets at an infinite number of levels.

Subsets are folders in the Navigator Palette, containing one
or more Layouts. You create Subsets as an organizational tool
to help you group and keep track of Layouts while you work.
Subsets are also the basis for assigning hierarchical numbering
to your Layout Book.
PlotMaker's numbering function allows you to automatically
number the elements of the Layout Book or to customize the
numbering of either the entire book or parts of it. The
resulting page number is usually a letter-number combination,
such as A-03/a.

Note: This page numbering function is independent of the
automatically generated unique Layout ID numbers.

The smart numbering system automatically adjusts itself
whenever the Layout Book is changed (for example by the
addition of new Layouts, changes in the Layout order or in the
document structure).

You can number the elements of your Layout Book with the
Book Settings command located in the Book menu. This
command is also accessible from the Navigator's pop-up
menu or the context menu if the Book is selected; clicking the
Set button in the Navigator also opens the same dialog box.
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- The Use Flat Layout Order option assigns numbers to all
the Layouts of the Book. The numbering is performed in
the Navigator from top to bottom regardless of the Layouts'
position in the hierarchy. In this case, Subsets will have no
numbers. The numbers will use the prefix and style you
define in the Book Settings dialog box.

- The Use Hierarchy option assigns numbers that reflect
the position of the Layouts within the tree view hierarchy,
including their position in Subsets. In this system, the
Subsets can also receive a number, which shows up as part
of the number assigned to each of its Layouts.

In assigning numbers, every setting that is applied (whether
chosen by the user or set by default) to an element at a higher
level will automatically be applied to elements that are lower
in the hierarchy. If you change a setting at a higher level, the
change will also be applied at the lower levels.
Any element can be assigned a custom setting. However, use
of a custom setting will override the automatic numbering
assigned to elements in the levels below, which will now
adopt the custom setting.

In the hierarchical system, the numbers assigned at each level
consist of two parts:

- a character string inherited from a higher level, and
- a number (or letter) assigned in linear order.

The numbering format can be set at every level of the
hierarchy: Book, Subset, and Layout.

Subset numbering and Layout numbering can be defined
separately.
The Subset Settings dialog box can be accessed from the
Navigator in one of three ways, provided that the Tree by
Subsets view is displayed and the given Subset is selected:

- Clicking the Set button at the bottom of the palette;
- Choosing the Subset Settings command in the Navigator's

pop-up menu in the upper right corner;

- Choosing the Subset Settings command in the context
menu opened by right-clicking (or Ctrl-clicking) the name
of the Subset.
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You can exclude the Subset from automatic numbering. If you
do, then only Custom numbering can be applied to those
elements.

- If you choose the Continue Upper Level Numbering
option, Layouts within this Subset will be numbered as if
they were not within this Subset, but rather part of the
level above. In this case you are only using the Subset as a
logical grouping which has no effect on numbering.

- If you choose the Customize option, the lower-level items
inside the Subset will inherit the number assigned to the
Subset, along with an added prefix and an ordered
number. The Preview shows you the final resulting
number assigned to each Layout.

Note: When numbering by letters exhausts the alphabet,
the numbering continues as follows: y, z, aa, ab, ac ... (The
initial letter in double-letter numbering always consists of
a single character regardless of the language being used.)

When moving a Subset within the hierarchy, automatic
numbering is adjusted accordingly.
You can also define a custom number for any particular layout
by choosing Layout Settings.

This command is available for the currently active Layout
from the Book menu (or from the bottom of the Edit menu, if
the Arrow tool is active in the Toolbox and nothing is
selected).
You can also access it for a Layout selected in any of the
Navigator palette's view (except Drawing Usage) with the
same shortcuts as the Book or the Subset (Set button,
Navigator pop-up palette, context menu).

Generating and Organizing the Layouts
of the Book
You can generate Layouts either manually or automatically
when importing Drawings.

To manually create a new Layout, use the New Layout
command available from:

- the Book menu;
- the Navigator pop-up menu;

- the context menu of any selected Layout in Navigator.
The New Subset command is available from:

- the Navigator pop-up menu;
- the context menu of the Book and any selected Subset in

Navigator.
You can name Layouts or Subset by selecting them in the
Navigator and overwriting the Name field in the Properties
section.
For Layouts, you can also change the name in the Layout
Settings dialog box.
Once you create a new Layout or Subset, the Navigator's Tree
by Subsets view will list it directly underneath the currently
highlighted element. If a Layout window is currently open,
the new Layout will be displayed behind the opened Layout.

If a Subset is currently highlighted in the Navigator palette,
the Create New Layout command will place a new Layout as
the last element inside the Subset folder.
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Importing Layouts
You can also import Layouts, Master Layouts or entire Layout
Books into your Layout Book using the Import command
from the File menu.

When the directory dialog box appears, select the Layout
Book types option in the Files of Type field to show only
Layout Books. Layouts and Batches created with earlier
versions of PlotMaker will also be available and can be
converted to the new format.

When you import a Layout, you also import its Master Layout
and the links associated with the Drawings in the Layout.

You can choose where to place the imported Layout(s),
provided that a Subset was selected in the Navigator before
choosing the Import command: inside the current Subset or as
individual Layouts appended to the Layout Book.

Note: Master Layouts will always be placed in the Masters
folder. You cannot create additional folders here.

If you check the Use Source Hierarchy box, then the
hierarchy of the View Set created in ArchiCAD remains in
effect, since PlotMaker will recreate the same folder structure
inside the Navigator palette.

When importing drawings, you can also choose to place them
on new Layouts, as detailed in the next section.

Placing the Drawings
To place a Drawing onto a Layout, use the File/Import
command. This will open the directory-type Import dialog
box in which you can pick files.

The following file types can be chosen:
- ArchiCAD Projects;

- PlotMaker Layout Books (see above);
- Images of various formats;

- PlotMaker Drawings;
- Linked Drawing Objects originating from OLE-capable
applications such as Microsoft Word or Excel.
Once you have selected the Drawing(s), press the Open
button. The imported drawing follows the cursor on the
Layout window until you click to position it. If multiple
drawings are imported, they are added one on top of the
other starting from the bottom left corner of the page. You can
then manually move them into their proper place.
If you choose the ArchiCAD Project option in the Import
dialog box, PlotMaker will display the list of available views
found in the various View Sets defined in the ArchiCAD
Navigator palette.
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The pop-up menu on top of this dialog box allows you to
choose a View Set. Then you can check the boxes in front of
the various Views to import them. Checking a box in front of a
folder name will import all the Views that the folder contains.
In this dialog box you can also choose the Layout(s) onto
which to place the selected Views. The same options are also
available if you choose a drawing or image format in the
Import dialog box and then select multiple drawings.

You can:
- Place each selected View or Drawing onto the currently

active Layout;
- Place each View or Drawing on a New Layout in the

Current Subset (provided that a Subset was selected in the
Navigator palette prior to choosing the Import command);

- Place each View or Drawing on a New Layout appended
to the Layout Book.
Important: Importing Project files will start ArchiCAD in
the background and may therefore take some time.
PlotMaker informs you continuously of the state of the
Import operation in a progress window.

Drawings created in PlotMaker can be placed on the Layout
by choosing the Add to Layout... command in the File menu.
The visible contents of the active Drawing window will be
placed on the Layout and the previously independent
drawing will become part of the Layout, linked to the original
drawing file with a hotlink.
It is possible to place OLE (Object Linking and Embedding)
Objects coming from any OLE-server enabled application.
OLE server applications include Microsoft Excel, Microsoft
Word, CorelDraw and Photoshop.

There are two methods for placing OLE Objects in a Layout:
through the Import… command and by pasting data from
the clipboard. In the second case, copy data the from OLE-
enabled application and paste it directly into the PlotMaker
layout.
Choose Copy from the server application, and then choose
Paste in PlotMaker. A dialog box appears, prompting you to
choose a method of pasting the copied elements.

- If you choose Plain Elements, the result will be a plain
pasting operation without any link to the OLE server
application.

- If you choose Linked object, a link is created between
PlotMaker and the original file.

- If you have selected an OLE Object before pasting the
data, the third radio button, New link of the selected
object becomes active. This allows you to replace the
placed data with another part of the linked file.
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Linked Detail and Section Markers
In ArchiCAD, you can set the Sheet Marker parameter of  a
Detail Drawing or a Section/Elevation to "PlotMaker." If you
import one of these Detail Drawings or Section/Elevations
into PlotMaker, the placed drawing will display the number of
the Layout sheet on which the Floor Plan view that belongs to
it has been placed.

Editing Drawings in the Layout Window
Once the Drawing has been placed on the Layout, you can
adjust its display option, size, frame, shape and location.

Placed Drawings can be selected by any of their hotspots,
placed at their four corners, the midpoints of their four sides
and their centerpoints.

After selecting a placed Drawing, choose the Drawing
Settings command from the bottom of the Edit menu. You
can also access the dialog box it displays by double-clicking
the Arrow tool in the Toolbox. In the Navigator palette, you
can access the Drawing Settings of any drawing (even if it is
not selected in the Layout) by selecting it there and choosing
the command in the context menu.
The illustration below shows the default options for placed
drawings.
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In the top section of the dialog box, you can see the scale at
which the drawing is placed. By default, the drawing scale is
used.
You can independently set the scale for each Drawing. This is
convenient for showing details of important areas of your
project, or for placing several views on a single page.
Choose a predefined scale from the pop-up menu or type a
custom value in the Output Scale field. This value does not
affect the internal scale of the Drawing.
The two buttons below allow you to fit the selected Drawing
to the size of the Layout or the Paper page.

Note: You can also modify the scale of the selected
drawing graphically in the Layout window by stretching it
diagonally while pressing the Shift key (stretching it
horizontally or vertically will crop it).

In the Text and Markers section below, you can set options
for Text and Markers.

- Fix Text retains the original text size after you re-scale the
Drawing,

- Resize to Output Scale resizes the text and markers
accordingly.

For more detail about these options, see Chapter 13: Printing
and Plotting.

If the placed item is a bitmap picture, the top section of the
Drawing Settings dialog box allows you to set the output size
and resolution of the picture element. These options are
similar to those of Figures placed in ArchiCAD.

The bottom part of the Drawing Settings dialog box deals
with the Frame and Output Color options for both vectorial
drawings and bitmaps.

Imported drawings are displayed with a rectangular frame by
default.

- To hide the frames of all drawings, choose the appropriate
option in the Display Options dialog box (Options
menu).

- To show the Drawing frame only, without the drawing,
select the Frame Only option in the Drawing Settings
dialog box' Show on Layout pop-up menu. This setting
will be applied to the selected Drawing only. The frame
will appear even if you have chosen to hide frames in
Display Options.
Note: Displaying frames only speeds up the process of
manipulating drawings. When plotting or printing, all
details will be drawn, even if the drawing is shown only as
a frame on the screen.

With the Frame pop-up menu, you can change the default
rectangular frame to an oval or polygonal one.
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If you change the frame to polygonal, you can adjust its nodes
and edges with the pet palette familiar from ArchiCAD.

 

Oval and polygon shapes are also available for framing OLE
Objects.

With the Set Polygon as Drawing Frame command from
the Edit menu, you can use a previously drawn Fill's shape as
the frame of a placed Drawing.

1) Activate the Fill tool in the Toolbox and draw a Fill of any
shape in the Layout window. The Fill can include holes.

2) Import the drawing and place it on top of the Fill.

3) Select both the placed Drawing and the Fill and choose
Set Polygon as Drawing Frame.

The Drawing will be framed by the polygon's contour. The
Fill will be deleted from the worksheet.

Below the Frame shape controls, you can customize the
drawing's placement angle and the drawing's background as
transparent or opaque.

Check the Draw Border box to create a custom border that
will be part of the printed output. Click the Border button to
access a dialog box in which you can set the Line Type, Pen
Color and Layer of the Border line. Note that these settings
apply to Border only; Drawings contain Layer, Line Type and
Pen Color information for their elements.

By default, all imported drawings are displayed in vectorial
color in the Layout window. In the Show on Layout pop-up
menu, you can set the preview to black and white bitmaps or
frame only.
In the Output Color section, you can choose whether to
print and plot the selected drawing in color, grayscale or
black and white. Note that the actual output color depth
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depends on the output device's capabilities and the setting
you make in the Print or Plot dialog box.

At the bottom of the Drawing Settings dialog box, the
Additional Info… button opens onto three tab pages with
additional information about the Drawing’s contents.

- The Drawing Info tab page includes the information
entered in the ArchiCAD Project's Project Info dialog box
(File menu).

- The ArchiCAD Info tab page shows details about
Drawings or Views imported from ArchiCAD, including
the path of the Project and the Display Options used for
the View.

- The PlotMaker Info tab page lists the number of lines,
circles/arcs, splines, text blocks, fills, hotspots and pictures
included in the drawing. The memory chip icon informs you
about the size of the Drawing in terms of memory. For
Bitmap Drawings, this tab page will give you further
information about the picture content of the Drawing, e.g.
the horizontal and vertical size in pixels and the color depth.
The floppy disk icon represents the size of the picture in the
file (in compressed form), while the memory chip icon
represents its size in terms of memory (expanded).

 

Manipulating Drawings

A Drawing on the Layout can be stretched by dragging one of
its boundary hotspots after selecting it with the Arrow tool. A
proportional stretch can be executed if you first fix the
diagonal of the frame and use the Shift key during the stretch.
You can also drag or rotate placed drawings or their copies.
These options are available for OLE Objects, too, but they
cannot be rotated.
With the Multiply command (Edit menu), you can create
multiple copies of the same Drawing and then customize each
copy's settings.

Modifying Drawings
It is not recommended to edit linked drawings by opening
them in a separate Drawing window. They should be edited
in their source files.
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You can, however, freely work on unlinked drawings using
many of the editing tools and commands familiar from
ArchiCAD, as well as some special techniques detailed below.
Regarding drawing files that you have manually saved from
ArchiCAD and placed on the PlotMaker layout, be aware that
if you modify the source file in ArchiCAD, save it again under
the same name and then wish to update it in PlotMaker,
changes made to the placed Drawing linked to the drawing
file will be discarded.
The Merge Overlappings command (Edit menu) filters the
coinciding lines which commonly occur in heavily layered
drawings or 2D representations of 3D structures. It also
unifies the connecting lines, which form a straight line but are
not one line segment. Only lines with the same pen and
thickness are unified. This command can be applied either to
the entire Layout or to the active drawing.

Selecting the Explode Fill command from the Edit menu will
deconstruct previously selected Fills to vectorial elements so
that every line and point element of the vectorial Fills will be
treated independently as it would be plotted on a pen plotter.
This way you can modify these Fills easily. This conversion is
independent of the Display Options settings.

Managing Linked Drawings
The source files attached to Drawings place on Layouts may
undergo modification during project documentation.
Therefore, you need to be able to check at any time the status
of the linked files.
At the center of the drawing management process is the
Drawing Usage view of the Navigator palette. It shows the
list of files placed in the Layout Book and provides
information about the files' type, location and update mode.

Whenever you place a drawing or picture on the Layout from
another file, a Hotlink is created between the original file and
the drawing placed on the Layout. The Hotlink can refer to:

- A drawing or image file;

- A View from an ArchiCAD Project;
- No external source (drawing embedded in the Layout).

Using the buttons at the bottom of the Navigator palette you
can break, reestablish or modify links to source documents.
To update linked Drawings from source files, use the Update
button.
For each drawing, the update method can be set to
automatic or manual.
If you have chosen the automatic update mode for a drawing,
it will be updated every time you choose the Rebuild
command in the Display menu.
To manually update a drawing at any time, select it in
Drawing Usage and click the Update button.
When opening a Layout Book that includes drawings that
have been modified (that is, their modification date has been
changed), a dialog box is displayed.

You can either update all drawings, none of them or choose
to go to the Drawing Usage view and select those drawings
that you wish to update.

Updating Drawings consists of two steps:
- First, drawings which have separate source files (i.e., are

not part of an ArchiCAD project) are updated. This is the
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faster step, but while it is underway PlotMaker cannot be
used for other purposes.

- Next, Views which originate from ArchiCAD projects are
regenerated and saved. During this step, the user can
continue working while the Drawing placed on the Layout
displays a message (Updating, To be Updated, Generated
Drawing) indicating that a Drawing update is due or
underway.

Important: When updating ArchiCAD Views, ArchiCAD
will be started in the background.

The Navigator palette also displays an icon in its upper right
corner to indicate when a Drawing update is in progress. By
clicking this icon you can switch to Drawing Usage view.

The Drawing Usage view informs you about the status of each
placed drawing. Click the Refresh status button to display
the latest information on the status of all of your drawings.

The following status values are possible:
- OK: The link is established between the file and the

drawing placed on the Layout.

- Modified: The file that the placed drawing is linked to
was modified after the Layout was opened or after you last
rebuilt the Layout.

- Not Mounted: The volume that contains the original file is
not mounted yet.

- Deleted: The original file has been deleted.
- Wrong type: PlotMaker has found a file with the same

name but of a different type at the original location of the
original file.

- Refresh: This status appears if you click the Update
button and link the Drawing appearing on the Layout to a
saved file. The connection will be established between the
Drawing and the file when you click OK in the dialog box.

- Cancelled: This status appears if you are searching for a
file and try to mount a server but decide to cancel the
operation.

- Can't Access: This status appears if the volume where the
drawing file resides cannot be found even after clicking
the Update button.

- Error: This status may appear when updating files
imported from ArchiCAD or if there was a problem when
generating a specific drawing. In this case, the Properties
panel of the Drawing Usage view gives you more detailed
information about the problem.

- On Mac/On Windows: This status only appears when
opening a Layout created on the other platform, because
hotlinks are then lost. When selecting such a file in the list,
its Info field will display Available only on Mac/Windows.
If you wish to open a Layout created on the other
platform, the Drawings placed in it should first be
gathered in a single folder. Select all of their names in the
Drawing Usage dialog box and click the Read all from ...
button. The hotlinks will be reestablished.

- Opened: If a Drawing is currently opened in its own
window, you can break its link, but you can neither
update it nor link it to a file.

- Opened, Broken: This status appears for opened
Drawings whose link has been broken.

- Relink: This status appears after clicking the Link to ...
button.

- Not yet read: This status appears in the rare case when
you open a Layout that does not include drawings and has
not at first found the hotlinked drawings, but the volume
containing them has been mounted in the meantime. By
choosing Rebuild on the Layout, these links will be
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updated. (You can achieve the same result by selecting the
file names in this dialog box and updating them.)

Note: If you break the link to an OLE Object imported as a
Linked Drawing Object, PlotMaker will get the object from
the server application in EMF/WMF (Windows) or PICT
(Macintosh) format and convert it into PlotMaker drawing
format. The data will be saved as a placed drawing within
the layout.

When importing or updating files from ArchiCAD, if there are
errors related to the opening of the project but not necessarily
connected to a specific view (for example, warnings about
Library items), a Warning box will displays the list of possible
problems.

PlotMaker Menu Commands
PlotMaker basically uses a restricted set of the ArchiCAD
commands. In addition, there are a number of commands
specific to PlotMaker. The sections below only list the
commands whose functionality differ from ArchiCAD or do
not have an equivalent in that program. Some of the menu
commands are discussed in detail in previous sections of this
chapter as indicated in the introductory paragraph of each
menu.

File Menu
With the commands of the File menu, you can create new
files, open and close files, import and add files to the Layout.
This menu also houses the Publisher function described in
Chapter 9: Collaboration and Connectivity as well as the
printing and plotting command detailed in Chapter 13:
Printing and Plotting.

New

With the New command, you can create a new Layout Book
or Drawing.

The New Layout Book command opens a Layout Window
containing an empty Layout. The last used settings will be
applied. The Navigator Palette will list the new Layout Book
containing one Layout, followed by a default master Layout in
a separate folder.

If you hold down the Alt key, the New command changes to
New & Reset. In this case, a new Layout Book is opened with
PlotMaker’s default settings.

The New/Drawing command creates an empty drawing
window for 2D drawing. All of its pen attributes (pen weights,
colors and assignments) are inherited from the current Layout.

Open…

Choosing this command opens a directory dialog box
allowing you to choose a file type recognized by PlotMaker.
Macintosh and Windows files are compatible with each other,
and both can be opened on either of the platforms.
Choosing a Drawing or Image type file will open a file in its
own drawing window to allow editing. The drawing can be
edited and saved as an independent document.

You can also open plot files saved in HPGL format to check
them before plotting them. Plot files will be opened in
Drawing windows. See also Chapter 13: Printing and
Plotting.

Close

If a Layout is the active window, choosing Close closes the
entire Layout Book. Only independent drawings will remain
open. If a Drawing window is active, choosing Close will
only close that particular window.

Save

The Save command saves the Layout Book in PlotMaker’s
native format (LBK), or (if a Drawing Window is open) the
selected Drawing in any drawing format you choose.
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When first saving the Layout Book, you can either save the
links to the imported files or embed the drawings in the
Layout Book file. In this case, all drawings (even those that
originate from ArchiCAD Project Views) will be saved with the
PlotMaker file which can then be moved to another computer
for printing or plotting all the data without editing it in
ArchiCAD.
This feature is also useful when OLE Objects have been
placed as Linked Drawing Objects and you wish to transfer
the file to a computer where the OLE server application is not
available.

If the Layout Book was first saved with only the links to the
imported files (the default setting in the current version of
PlotMaker) and you now wish to include those files
themselves, choose the Save as… command and check the
Include all linked files klbox.

Note: Drawings that have not been hotlinked (or whose
link was broken) will always be saved with the Layout
Book.

Save as…

Choosing this command creates a copy of the currently active
Layout Book or Drawing. Drawings can be saved in any
available drawing or image format.

Note: When saving a copy of a drawing, it is the original
drawing that remains on screen and the hotlink still refers
to this drawing.

All QuickTime based image files can be saved by PlotMaker.
The available file types include Photoshop, MacPaint, QTIF,
PNG, Truevision TGA Image, TIFF, progressive JPGs, and
others. Images in GIFF format can be placed on Layouts, but
PlotMaker cannot save drawings in this format. File formats
saved on Macintosh or Windows system (e.g. PICT or BMP)
can be read by both systems.

Layouts and Drawings saved in the DXF/DWG/EPS format
can be opened by any drawing program that supports the

DXF/DWG or EPS file structure. EPS files can be placed in
DTP applications, where a low resolution preview will be
displayed on the screen and the resolution-independent
PostScript file will be printed on PostScript printers. EPS files
cannot be edited or printed directly on PostScript printers.

Edit Menu
The commands of the Edit menu are available in both the
Layout and Drawing windows. Most of them will only act on
selected elements. On the Layout, you can only manipulate
placed drawings as an entity. To edit their elements, open
them in Drawing windows or in their original application.

Undo

The Undo command allows you to undo the last editing
operation. Rectangles, polylines, and freehand lines are
undone in a single step. After you have chosen Undo, the
command's name changes to Redo. The Merge Overlappings,
Explode Fill, Set Polygon as Drawing Frame and Insert
AutoText commands are discussed in earlier sections.

Cut/Copy/Paste

The Cut and Copy commands respectively remove or copy
drawn objects selected by the Marquee or Arrow tool and
place them on the Clipboard.

Note: Drawings placed in the Layout cannot be copied to
the Clipboard. To copy a complete drawing, select all of its
elements and choose the Copy command.

To Cut or Copy with PostScript, keep the Alt key pressed
while choosing the Cut or Copy command. When the Edit
menu is displayed, you will notice that the names of the menu
items have been changed. This feature allows you to place a
PostScript version of the selected objects on the Clipboard.
Drawings transferred this way benefit from PostScript even if
the host program cannot import PostScript (EPSF) documents.
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Copy and Paste are executed in paper coordinates. If you
copy something, the size of it in the clipboard will be the
same as if plotting or printing it on a paper.

Hint: if you want to rescale elements in PlotMaker, copy
them, change the drawing scale and paste them.

Selection Settings

The name of the last command of the Edit menu changes
depending on which element or tool is selected.

- If no element is selected, the command will contain the
settings of currently active tool. The settings dialog boxes
of the PlotMaker tools are simplified versions of the
corresponding ArchiCAD tool settings dialog boxes.

 

Note: Custom line weights (in points or mm) can be
defined for each element regardless of the Pen the element
is drawn with. If you check Pen Weight box, the value
assigned in the Pens and Colors dialog box is used, while
if you uncheck it, you can enter a custom thickness.

- If no element is selected on the Layout and the Arrow tool
is active, the name of this command becomes Layout
Settings. This dialog box was presented in the Generating
and Organizing Layouts section earlier in this chapter.

- If a drawing element is selected on the Layout or in a
Drawing window, the name of the command at the bottom
of the Edit menu changes to the name of the tool that
created that element.

- If you select one or more drawings on the Layout, the
name of the command is Drawing Settings. This dialog
box was presented in the Placing Drawings section earlier
in this chapter.

- If you select a bitmap in a Drawing window, the name of
the command is Picture Settings.

At the top of the dialog box, you can control the size and
resolution of the picture. Additionally, you can activate the
Chain icon to keep the current proportions of the picture
while editing it, or make it inactive to change its proportions.
Clicking the Restore Original Values button will revert
settings to the size and resolution data stored with the picture.
At the bottom, the Bitmap area contains information only, it
cannot be modified.

Tools Menu
The Tools menu contains the same grouping and Display
Order commands as ArchiCAD. See their description in
Chapter 5: Drafting and Editing Techniques.
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Book Menu
This entire menu is specific to PlotMaker and contains
commands related to the Layout Book. You can use these
commands to check and modify the basic settings of the
Book, the Layout and the Master Layout, including the
numbering options. You can also insert new Layouts and
Master Layouts in the Layout Book. Most of these commands
can also be accessed from the Navigator by clicking on the
arrow icon in its top right corner.

Book Info

When starting a project, it is recommended to fill in this form
which contains the most important information related to
your documentation. Later you can use this data as AutoText,
without having to frequently retype these items.

Go to (Layout)

Use the commands of this hierarchical menu to go to the next
or the previous Layout of the Book, the first or last Layout or
enter the number of a specific Layout.

Go to Master Layout

Choose this command to display a Master Layout. Defined
Master Layouts are listed in a hierarchical menu. You can
achieve the same result by double-clicking the Master Layout's
icon in the Navigator palette.

Options Menu
The commands of the Options menu contain the scaling and
display options as well as the attributes used in the Layout
Book and the placed Drawings. See Chapter 6: Project and
Program Customization for the general handling of attributes.

Drawing Scale…

This command is only available in Drawing windows. Each
Drawing can have its own scale.

Display Options...

PlotMaker has some specific Display and Output options.

- There are two display options for Lines. In True Weight
mode, all pens are displayed with their correct weight as
set in the Pens & Colors dialog box, while in Hairlines
mode all pens are displayed as thin lines of one pixel
width. This allows for faster screen redraws.

- A generic setting controls the display of Pictures in the
document.

- The Frames of drawings can be displayed or hidden on
the Layout. The drawing’s name can also be optionally
shown with the frame. Placed drawings’ names normally
appear in grey. If the drawing was opened in a separate
window, its name will appear in red on the Layout.

- With the Page Breaks control, you can hide or display the
dotted blue line that represents the size of your sheets.

- You can show or hide Page Overlappings on your screen.
- Master Layout Items can be optionally shown or hidden

on the Layouts.
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The five different modes of Fill display have the following
Display and Output consequences:

- All to Bitmap Pattern (recommended setting) mode
displays and prints the Fills as patterns and usually plots
them in vectorial mode except on some raster plotters,
where the 100, 75, 50, 25 and 0% patterns will be plotted
as the hue at a lower saturation.

- Keep Original Settings mode displays the fills as they
are. Choose this option to keep the relevant settings of the
original ArchiCAD file for construction and polygon fills.
The display options settings of each element can be reset
individually.

- All to Empty mode displays, plots, and prints only the
contours (if any) of the Fill.

- All to Solid mode shows polygons with a solid (100 %) fill.

- Vector mode displays, prints and plots lines, except that
on some raster plotters the 100% Fill will be plotted as a
solid fill.

Grids

PlotMaker’s Grid System functions like ArchiCAD’s and can be
set through the Options/Grids menu command. However,
rotated and skewed grids are not available in PlotMaker.

Note: By default, the Grid is hidden in Layout windows
and shown in Drawing windows.

Layers/All Layers

PlotMaker has a double layering system. The Layout Book has
its own Layers as do all of the placed Drawings.

- The Layers... command acts on the current Drawing
window or on the drawings selected in the Layout; if no
drawing is selected, the command acts on the Layout Book.

- The All Layers... command is only active when the Layout
window is in front and acts on both the Layout and all of
the placed drawings.

If you have chosen All Layers..., the Layers and Layer
combinations shown in the Layers dialog box are those used
in either the Layout or in any of the placed Drawings.

When choosing either All Layers with at least one placed
drawing on the Layout, or choosing Layers when at least one
placed drawing is selected on the Layout, you can only show
and hide layers and choose a layer combination. Locking-
unlocking, creating, renaming or deleting layers is not
possible. The lock icons do not appear in the list.
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- Layers whose visibility (show-hide) is not the same in
different drawings will be indicated by a third icon
displaying an open and a half-shut eye.

- Layer combinations that have the same name but a
different content can be chosen for all placed drawings.

- The visibility of the layers can be different for the same
drawing that has been added more than once.

- Only the visibility of the layers depends on the placement of
the drawing; any other setting comes from the hotlinked
original drawing file. For example, if a layer has been
deleted from the original file, it will also disappear from the
placed drawing.

Pens & Colors…/All Pens & Colors…

The Pens & Colors dialog box allows you to define the color
and the weight (stroke thickness) of each Pen.

Note: The All Pens & Colors dialog box can only be
opened when the Layout window is active. The settings
defined here apply to all of the elements of the Layout,
including placed drawings.

If the Layout is the active window, the settings defined under
the Pens & Colors dialog box are applied to one or several

selected drawings, or the Layout itself (if no drawing has been
selected). In the upper right corner of the dialog box, you can
see the number of drawings the settings affect.

Note: Moving a Drawing or other item from one Layout to
another will not affect its pen color or pen weight.

If you are editing the pens of several drawings (or of the Layout
and some drawings) simultaneously, some of the squares turn
white to show inconsistencies.
If you check the Show only pens used checkbox, only those
pen colors will be shown that you use on your current
drawing(s). The other pens will be gray.
The assigned Pen Weight is the thickness that appears on the
printer and plotter output, regardless of the scale set. You can
choose to display on screen all lines in Hairline mode in
Display Options.

Custom line weights (in points or mm) can be defined for
each element regardless of the Pen the element is drawn with.
The Tool Settings dialog boxes associated with each tool
contain a Pen Weight checkbox. See Selection Settings (Edit
menu) earlier.

Note: For printers and raster plotters, zero pen weight
means hairline thickness. Making solid fillings with this
thickness will take a lot of time.

Preferences

The Working Units, Mouse Constraints and Publisher options
are the same as those in ArchiCAD.
On the Temporary and Cache Folder screen, you can
check the location of the Cache Data used when you import
your drawings directly from ArchiCAD. In this case the
program generates the drawing files automatically in the
background, and stores them in the chosen Cache folder. The
program accesses the cache folder for quick display and
update of the drawings on your layout.
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You can also decide to include the Cache data in the Layout
Book file. In this case, the size of the Layout Book file will
significantly increase, since it will now include the drawings
which you imported directly from ArchiCAD.

Note: If you want your Layout Book file to embed all
drawings, check the Include Drawings box in the Save
as… dialog box. This option is recommended for
archiving purposes, or for moving the file to a computer
where the ArchiCAD or the OLE-server applications from
which you have imported files are not available.

On the Miscellaneous screen, enabling the Uniform Pens
& Color option will replace individual Pens & Colors settings
of all drawings placed on the current Layout.

To ease recognition, you can also set a different color for
elements inherited from Master Layout.

Display Menu
The commands of the Display menu resemble those of
ArchiCAD. Note that the Rebuild command creates a new
bitmapped image of the placed drawings on the Layout at the
current Zoom level. It works on one or more selected
drawings, or on all the drawings in the Layout, if none are
currently selected. Rebuilding the Layout updates the hotlinks
between imported files and placed drawings.

Window Menu
From the Window menu, you can access all open PlotMaker
windows. The Tile Windows command arranges all open
windows so that they fit neatly next to each other, while
Stack Windows maximizes the size of all open windows and
staggers them on top of each other so that the top left corner
of each windows is visible.
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Compatibility Note
PlotMaker 3.0 is a major upgrade from previous versions.
Here is some information about the handling of files created
with previous versions of the program.

- You can import LAY files from a previous version of
PlotMaker into your new Layout Book using the Import
command.

- Drawing files imported onto Layouts from outside sources
retain their original names, which cannot be modified.
Every imported element retains the icon that corresponds
to its file type.

- Adding Batch files (PBO) will add the component Layouts
as individual Layouts (LAY) to your Layout Book.
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Chapter 13
Printing and Plotting
You can print and plot the various aspects of your Virtual Building either directly from ArchiCAD or by using the additional
features provided by PlotMaker. This chapter reviews the possibilities offered by the two programs, sums up the output options
available for different element types and points out further output possibilities.

Printer Setup
Choose Page Setup from the File menu in either ArchiCAD
or PlotMaker to select a printer and set such information as
the page size and the orientation of your documents.
Additional options depend on your printer driver.

Printing from ArchiCAD
You can print both graphic data and the contents of text
windows, including lists and scripts.
When you choose the Print command from the File menu,
the upper half of the dialog box provides the system print

settings, copies, page range, etc. The lower half displays
options that are unique to ArchiCAD.

Note that when printing the 3D Window or a formatted list
window, your choices are restricted to a smaller number of
relevant options.

Print Range
When printing from a 2D window (Floor Plan, Section/
Elevation, Detail Drawing), you can choose whether to
print the entire drawing or the current view only (that is, the
visible content of the window).
Accordingly, the Sheets to Print area shows you the number
of sheets of the paper size chosen in Page Setup that will be
needed to print the drawing and provides a preview of the
tiling of the pages. These controls are also affected by the
Printing Scale (see later). You can then specify the actual
range of pages to print in the upper part of the Print 2D
Document dialog box.
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When printing the 3D Window, similar options are offered.

When printing a formatted Element, Component or Zone
List, you can either choose to fit the printed document to the
current paper width or define a custom scale. It is also
possible to start a new sheet for every zone or list page when
printing.

Non-Printing and Optional Items
Basically, what you see in the currently active window will be
printed, but there are some exceptions.

Items that cannot be printed include Hotspots, selection dots,
Section depth lines, Roof pivot lines, Cameras and their
paths.

The lines of the Construction Grid can be optionally printed
from the 2D windows by choosing the appropriate radio
button. Note that you can only print the grid if Grid Display is
ON.
Ghost Story elements can also be printed, from the Floor
Plan worksheet only.

Note: Elements that are located on remote stories but
individually set to display on the current story will always
appear on the output.

Scales
The Printing Scale is affected by:

- The page size and orientation chosen in Page Setup;
- Your choice of printing the entire drawing or the visible

detail only.

The value that allows you to fill up as much of the page as
possible is automatically calculated in the Print dialog box.

You can choose to fit the Printing Scale to the scale of the
drawing that you wish to print by choosing the same standard
scale from the pop-up menu below.
The Text and Markers radio buttons in the Print 2D
Document dialog box allow you to optimize text scaling.
These options also affect the output characteristics of other
elements such as arrowheads, scale-independent dashed line
types and fill patterns. These options include:

- Fix Size - Outputs text at its exact size in the current paper
units (inches or millimeters). To keep text at exactly the
same size even when the printed size of the project changes,
choose this option. This is acceptable for enlargements but
can produce unwanted effects with reductions. Text may
overprint other elements as they shrink.

- Resize to Printing Scale - Outputs text in proportion to
the size of other elements. This method is good for
enlargement of a Project for a presentation to be seen from
a distance.
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Note: The size, pattern and degree of details of some
elements (text, line types, vectorial fill patterns, Object
symbols) depends on the current scale. If you set a
different Printing Scale from the Drawing Scale and scale-
dependent elements are printed, the output can be
different from the current screen appearance of these
elements. See also Scale in Chapter 3: Project
Organization and Navigation.

Options for the Printed Output
With the Display Options command (Options menu), you
can specify the degree of detail of some element types to
display and print. These settings appear in the bottom section
of the Display Options dialog box.

See the relevant sections of Chapter 4: Element Creation for
the detail of the various choices.

Note: The choices made in the top section of the Display
Options dialog box only affect the screen appearance of
the elements and will not be taken into consideration when
printing. For example, Text will always be printed without
frames and as normal (even if it is greeked on the screen),
Wall and Beam intersections will be cleaned up, etc.

When printing Construction or Polygon Fills, their behavior is
consistent with the setting made in Display Options.
If you choose the Vectorial Hatching option, the result
depends on the spacing of the hatch lines. The calculation of
the actual spacing is based on the value entered in the

Spacing fields for the given fill pattern in the Edit Vectorial
Pattern panel of the Fill Types dialog box and its relationship
with the current scale.

- With dense spacing (≤ 0.1 mm), the pattern will be printed
as a solid Fill.

- If the spacing is larger than 0.1 mm, the pattern will be
printed normally.

If you choose the Bitmap pattern option, the result depends
on the type of the fill.

- The standard 100% fill will print as a solid fill.
- The standard 75, 50, 25 and 0 % fills will print as gray

patterns (On MacOS, this may be limited to 72 dpi on non-
Apple printers with non-Apple printer drivers).

- Other types will print as 72 dpi bitmap patterns (MacOS)
or at printer resolution (Windows).

Printing from PlotMaker
You can print only Layouts from PlotMaker. If a Master Layout
or Drawing window is active, the printing commands are
disabled.

When choosing Print from the File menu in PlotMaker, the
dialog box that appears contains some of the same options as
in ArchiCAD, but the arrangement of the options is different,
and some of them are accessed in a subdialog box.
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Print Range
The range of the pages that you will print depends on both
your choices in the Layouts to Print and Print Range areas of
the main Print dialog box and the scaling method defined in
the Print Options dialog subdialog box.
You first need to select the Layouts that you wish to print.

- The Selected in Navigator option will print all the
Layouts you have selected in the Navigator Palette. The
selected Layouts will be printed in the order of their ID
number.

- The Active Window option will only print the Layout that
is in the currently active Layout Window.

- The Entire Layout Book option will print all the Layouts
in the current Layout Book.

Click the Print Options button.

You can see here a preview of the selected Layout relative to
the current paper size. In the Page Sequence area below, you
can determine the order in which the pages will be printed.
In the top right section of this dialog box, you have several
options for scaling the layouts.
If you have selected All as the Print Range in the Print dialog
box, use the right-hand buttons in the Print Options dialog

box to reduce or enlarge the scale or shrink Layouts to fit the
page.

Rescaling the Layout means that the Layout size optimized for
a particular printer and paper size can differ from the actual
output produced by the printer. For example, a Layout Book
optimized for a plotter using A1 paper can also be printed,
properly scaled down, on an A3 printer.

If you have selected Pages as the Print Range in the Print
dialog box, look at the diagram in Print Options to determine
which part of the Layout you want to print, click OK, and then
enter the page range.

Note: If the pages are not sequential, you will have to
repeat the Print command for each page range.

If you change Overlap and Tiling in Print Options, they will
override the Master Layout Settings for this print job without
changing the values defined in Master Layout Settings.
Similarly, if you apply Master Layout Margins to your print
job, but these are smaller than the printer margins, the printer
settings will be applied.

See also Master Layout Settings in Chapter 12: Using PlotMaker.

Output Color
If you are using a printer that supports color or grayscale
output, you can set the color of the printed elements in three
locations:

- The output color of imported drawings and images can be
set by selecting them and choosing Drawing Settings in
the Edit menu.

- The output color of the drawing and text elements added
directly to the Layouts can be set by choosing Book
Settings from the Book menu. This has no effect on the
contents of the imported drawings.

- In the Print dialog box, the lesser color depth will
override the other choices. For example, if you have
chosen All Colors to Black in the Print dialog box, every
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element will be printed in black and white independently
of the Drawing or Book setting; if you have unchecked the
All Colors to Black box in the Print dialog box, but chosen
Grayscale in the Drawing or Book Settings dialog box, the
elements will be printed in grayscale even if your printer
supports color.

Printing OLE Objects
When printing OLE Objects with the PlotMaker Layout they
have been placed into, they will be printed as if from the
parent application, but taking the cropping information into
account.

Note: Printing of linked Excel data will force default on-
screen (grayed) grid lines to print even if they were turned
off in Excel's Page Setup dialog box (including Office 97
and Office 2000).

Plotter Setup
When outputting documents to a plotter, you first need to set
up the plotter for ArchiCAD or PlotMaker. The communication
with the plotter device is ensured by specific plotter drivers
stored in the PlotWare folder located by default in the same
directory as ArchiCAD or PlotMaker.

In either program, choosing the Plot Setup command from
the File menu opens a dialog box.

The two pop-up menus on top allow you to choose the
plotter driver. The first lists manufacturers and the second the
plotter driver for the given manufacturer. The contents of this
list depends on the contents of the PlotWare folder.

- If the manufacturer of your plotter is listed but that
particular model is missing, browse through the other
models and select one with a similar paper size (e.g., E
size). If there are several models with these criteria,
experiment with all of them.

- If the manufacturer is not listed with any model, check the
user manual of the plotter for compatibility and emulation
modes. If the plotter accepts HPGL-2 and/or RTL data,
there is a good chance of making it work. In this case,
choose the HP DesignJet 755C model.

See also the list of supported models in Plotting with
ArchiCAD and PlotMaker in the More Information section of
Chapter 13: Printing and Plotting in ArchiCAD Help. You
can also find there extensive information on issues related to
plotting such as recommendations on the choice of drivers
and cables, and network plotting.

Paper Size Settings
In the Paper area of the dialog box, you can choose a paper
size for your plotter. Invalid paper sizes are grayed in the
menu and are not selectable.

If you choose Custom in the Paper area, the second pop-up
contains by default two items: Current paper and Modify list.

Choosing Modify List opens a dialog box in which you can
define your own custom paper sizes.
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Click OK when you have finished defining sizes manually.
The new custom sizes will appear in the custom size pop-up.
Custom paper sizes are saved with plotter settings.

The controls below allow you to choose the orientation of the
output.

Connection Options
In the Connection area on the right-hand side of the Plot
Setup of the dialog box, you can specify the connection type
you intend to use with your plotter.

Windows:

To configure and use a plotter connected to one of your own
computer's ports or to a network plotter, use the Add Printer
tool of the Windows Printers Control Panel.
When first using a plotter with ArchiCAD or PlotMaker, you
need to connect to it by clicking the Setup button in the
Connection area. The Select Plotter dialog box appears.

You can choose one of the installed printer drivers from the
pop-up menu. This driver will serve as a gateway to the
plotter; ArchiCAD or PlotMaker will use the specific plotter
driver selected on top of the dialog box for actually plotting
data.

MacOS:

The Setup button in the Connection area of both ArchiCAD
and PlotMaker accesses a pop-up menu listing the connection
options available. These include connecting to a plotter
through the Modem or Printer port, AppleTalk or the TCP/IP
protocol.
On MacOS 9, when using a serial connection, you can access
the communication settings for the given port. These
parameters will determine the speed and other characteristics
of communication between your computer and the plotter. Set
these values to match the settings of your plotter. See your
plotter manual for more information.

If you are using an AppleTalk connection (MacOS 9), choose
the zone the plotter is in, and select the plotter.
If you want to plot through the TCP/IP connection, enter the
IP address of the plotter in the regular "xxx.xxx.xxx.xxx"
format, or, if a DNS (Domain Name Server) is available on
your network, simply the name of your plotter.



239

Chapter 13: Printing and Plotting

Graphisoft ArchiCAD User Guide

In the Port field below the IP address, enter the appropriate
port number. Please consult the manual of the plotter or the
network card.

Note: For the HP JetDirect cards, the port number is 9100
as shown in the Unix part of the manual.

Using a Spool Folder and PlotFlow
Below the Connection options, you can define a folder for
spooling files to be plotted either from your own computer or
anywhere on the network in the background.

Background plotting is handled by the PlotFlow utility that is
part of the ArchiCAD package.

To use PlotFlow:
1) Start the application and pick the plotter that you wish to

use.

2) Choose Settings in PlotFlow's Options menu (or click the
corresponding button < > in the toolbar). In the
appearing dialog box, specify the same folder that you
designated as the Spool Folder in ArchiCAD or PlotMaker

3) Whenever you send a file to the Spool Folder from ArchiCAD
or PlotMaker, it will automatically be plotted by PlotFlow.

Note: You can also use PlotFlow to manually pick plot files.
The Spool Folder does not necessarily have to be placed on
the same computer as the one on which PlotFlow is running.
Using a Spool Folder effectively solves the problem of
plotting from a mixed network including both PCs and Macs.
You can place the Spool Folder on a Windows NT server that
can be read from both Macs and Windows-based machines.

See also Using PlotFlow in the More Information section of
Chapter 13: Printing and Plotting in ArchiCAD Help.

Additional Options
Under the name of the selected plotter, the Font Plotting…
button gives you access to a dialog box where you can define
the way your text blocks will be plotted.
The dialog box contains the list of all the fonts placed in the
Fonts folder (MacOS) or of the system’s TrueType fonts
(Windows).

Note: On Windows, you can only use TrueType fonts.
Bitmap and PostScript fonts are not supported.

The fonts you currently use on your Project are shown
outlined (MacOS) or in italics (Windows) in the list.



240

Chapter 13: Printing and Plotting

Graphisoft ArchiCAD User Guide

You can either choose the optimal settings for the given
plotter, or manually override them.

To change the substitution, select one or more system fonts in
the list, click the Manual Setting button and choose a plot
mode from the first pop-up menu on the list.
There are three ways to plot a font type:

- Substitute it with the plotter's built-in font. This is the
fastest way to plot texts.

- Use the vector fonts contained in the Vector Fonts folder,
placed by default in the same folder as ArchiCAD and
PlotMaker. The vector fonts are a good compromise
between fast output and high quality plots.

- Use TrueType fonts to generate the highest quality plotted
output. You can set a limit for the font size to be filled on
the output. Font sizes below the limit will be plotted as
outlines only (to save plotting time and ink). On the
MacOS, you can also use bitmap and PostScript fonts. For
bitmap fonts, you can switch smoothing on and off.
Notes: TrueType, PostScript and Bitmap are alternatives:
only one of them is available for each font. PostScript fonts

can only be plotted if Adobe Type Manager is set up and
running on your Macintosh.

In PlotMaker, the Options button reveals special setting
options for the particular plotter chosen.

If available, the selectable plotter font and character set
options appear in this dialog box.

Note: Plotter fonts usually contain only ASCII characters
through 126. Characters 127 and above are converted to
their non-accented pairs or spaces.

Plotting from ArchiCAD
You can only plot graphic data from ArchiCAD. If a text
window is in front, both the Plot Setup and Plot commands
appear in gray in the File menu.

Choosing the Plot… command displays information on the
plotted output's layout and scale.
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In the upper part of the dialog box, you can choose to either
send directly the data to the selected plotter, to a plot (data)
file or into the Spool Folder specified in Plot Setup. In the
latter two cases, you can plot files manually or automatically
using PlotFlow (see above). Plot files can also be sent to a
plotter bureau on disk or through the Internet.
The scaling options are the same as for printing, see above.

The Sheet Layout area shows you how the drawing will look
on paper.
Some of the basic differences with printing:

- You cannot define a plot range; the entire contents of the
active window will be plotted.

- You can choose a color for the lines of the grid, if you
wish to plot it from a 2D window.

- Ghost Story elements cannot be plotted.

Plotting from PlotMaker
Although ArchiCAD directly supports high quality plotter output,
Graphisoft recommends the use of PlotMaker for final layouts.

If you choose the Plot command in PlotMaker's File menu,
you can first determine the plotted output by selecting one of
the three Plot range options.

- Choosing Selected in Navigator will plot all the Layouts
currently selected in the Navigator palette, in the order of
their ID number. (To see the IDs, choose the Layout List
option in the Navigator pop-up.)

- Choosing the Active Window option will plot only the
currently active window. Note that you can only plot
Layouts; if the active window is a drawing, the plotting
commands are grayed in the File menu.

- Choosing Entire Layout Book will plot all of the layouts
in the open book, in the order of their IDs.

As in ArchiCAD, you can choose the destination of the plotted
data: directly to the plotter, to a plot (data) file or in the Spool
Folder.
In PlotMaker only, you can preview the plot file by opening it
in a Drawing window. When you have finished plotting the
file, choose File/Open and select the HPGL File (*.plt) option
in the Files of type pop-up, and click the Open button.

When you save an entire Layout book as a plot file, each
Layout will be placed on a different layer. To view individual
Layouts, open each layer in a separate Drawing window.

The radio buttons at the bottom of the dialog box allow you
to control the plotting process.

- If using a plotter with roll paper, you can choose between
automatic or manual Paper Feeding.

- Depending on the options available for your plotter, you
can Plot with full color, grayscale or black & white.

Clicking the Plot Options button top right opens a further
dialog box. These options are identical to those available for
printing, see their description there.
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Options for the Plotted Output
Basically, the same options are available as for printing (see
above).

Fill plotting is also similar to printing, but when the Bitmap
pattern option is chosen, the nonstandard fill types will be
plotted as in vectorial mode.
In PlotMaker, bitmap plotting is supported for some models.
See Plotting with ArchiCAD and PlotMaker in the More
Information section of Chapter 13: Printing and Plotting in
ArchiCAD Help.

When plotting OLE Objects with the PlotMaker layout, they
will be converted by the server application and then

interpreted by PlotMaker. Plot quality is limited to the EMF/
WMF or PICT output capability of the OLE server application.

Batch Printing and Plotting with
Publisher
You can define batch print and plot jobs with the Publisher
function from either ArchiCAD or PlotMaker by choosing
Printing or Plotting as the Publishing method for a View Set.

See the Publisher section in Chapter 9: Collaboration and
Connectivity for details.

Creating PDF Output
You can output data from both ArchiCAD and PlotMaker to
the Acrobat PDF (Portable Document Format) using the Print
command.
If you are working with Windows and have a software
package that includes the Acrobat Distiller or the Acrobat PDF
Writer, choose it instead of your printer driver. If not, install
the Amyuni PDF Converter that has been provided with your
ArchiCAD package.
On the MacOS X, PDF creation is handled on the system level.

See also the installation instructions for the PDF Converter in
the Getting Started manual. Details and options for PDF
creation with PDF Converter are provided in the More
Information section of Chapter 13: Printing and Plotting in
ArchiCAD Help.
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